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CARPENTERS TRAINING COMMITTEE FOR NORTHERN CALIFORNIA (CTCNC) 

RULES OF CONDUCT FOR PARTICIPATION IN 

JOURNEYLEV EL ADVANCEMENT TRAINING CLASSES 

Discrimination or sexual harassment in any form or degree by an 

employee or participant in Journeylevel Training against another 

individual, regardless of their relationship or respective status, is 

strictly against the policy of the Carpenters Training Committee for 

Northern California (CTCNC) and will not be tolerated. Any such 

action or activity shall be reported immediately to the person in 

charge of the training facility and to the Director of Training Services 

for the matter to be promptly investigated and for appropriate 

action to be taken. 

While on the premises of a Carpenter s Training Facility, or in a 

location where training is being conducted on behalf of the 

Carpenters Training Committee for Northern California, participants 

in Journeylevel Training classes shall not use lewd or vulgar language 

or be under the influence of illegal substances, alcohol, or 

medications that could impair the ability to work safely. Any such 

action or activity shall be reported immediately to the person in 

charge of the training facility and to the Director of Training Services 

for the matter to be promptly investigated and for appropriate 

action to be taken. 

Any person violating the above policies shall be subject to 

disciplinary action, which may include removal from the training 

facility and/or prohibition on taking future classes. 
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LEADERSHIP TRAINING PROGRAM (LTP) 

Course Introduction 

This course was written to aid the advanced journeyman carpenter or foreman to make the 

transition from technician to leader. Just as an apprentice needs a training program to better his/ 

her skills as a carpenter, a potential supervisor should be aware of the responsibilities, 

requirements, and the tools available to meet the obligations of the job of coordinating a 

construction project from start to finish. 

Foremen, general foremen, supervisors, and superintendents have generally come out of the 

carpenter ranks. This class, and other classes to follow, is intended to pick-up this tradition and 

provide journey level carpenters with a solid foundation in the type of skills required to be 

successful in these demanding, supervisory positions. 

The entire Leadership Training Program (LTP) is designed to be delivered in a series of ten (10), 

two (2) hour modules. We will attempt to cover the major job tasks of the superintendent 

required by most contractors. There will be differences in procedures and paperwork, from one 

contractor to the next, but the basics will remain the same. 

If you are here in attendance you have already proven you have the years of experience in the 

field, the confidence required to lead and the desire to learn the methods used by the construction 

superintendent to bring a project to a successful completion. Each one of you will be bringing 

to this class a wealth of knowledge gathered on the job site. Sharing this knowledge with your 

peers will be an important part of the learning process for all of us. 

Upon the completion of all these courses, you should be prepared to take on superintendent 

responsibilities on your own, however the learning process of being a good superintendent will 

never end. 

Successful completion of all the course modules in this series (as listed in the Global Course 

Objectives & Module Content) will include a Leadership Training Program Completion 

Diploma. 
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GLOBAL COURSE OBJECTIVES & INDIVIDUAL MODULE CONTENTS 

IV 

At the completion of this entire series of modules the participant should have the ability to take 

a set of contract documents and turn them into a finished project. To do this, the successful 

superintendent will have to understand the documents, be able to build and administer a schedule, 

review submittals for compliance, discover and implement change orders, manage the General 

Contractors' and the sub-contractors' work force, communicate clearly with all parties involved, 

keep accurate and up to date records, have a working knowledge of other trades, and close the 

job out - along with posting a profit for the General Contractor. 

Following is a comprehensive overview of all the proposed Leadership Training Program 

Modules, along with a brief description of each module's content. 

1. Superintendent Responsibilities & Job Site Set-Up

• Course orientation and introduction to responsibilities you will be required to assume

2. Contract Documents

• Significance of all contract documents and their daily applications

3. Change Orders

• Generation, impact, and implementation

4. Submittals

• What they are and how to use them effectively

5. The Schedule

• Bar Charts, Time Line, CPM, time management, setting priorities, etc.

6. Supervising the General Contractors Workforce

• Leadership, motivational techniques, workforce feedback

7. The Daily Diary

• The importance of keeping an organized daily record of events, inspections, deliveries,
changes, accidents, weather days, etc.

8. Job Close-Out

• Successful completion of all contractual requirements

9. Review of Trades

• Nuts & bolts of all the trades

10. To Be Determined
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LEADERSHIP TRAINING PROGRAM (LTP) 

Module One: Superintendent Responsibilities and Job Site Set-Up 

SPECIFIC OBJECTIVES 

After completing this module, the participant should be able to: 

1. Define the meaning of the job title: Construction Superintendent

2. Outline the responsibilities of the Construction Superintendent.

3. List the obligations required, of the Superintendent, on a daily basis.

4. Know how to set up a job site so that construction may begin.

HAVE THIS STUFF: 

Pencil and paper. 

EVALUATION 

A class evaluation form will be filled out by the students at the end of the session. 
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LEADERSHIP TRAINING PROGRAM (LTP) 

Module One: Superintendent Responsibilities and Job Site Set-Up 

CLASS ACTIVITY GUIDE 

Time Allotted Instructor Activity Student Activity 

15 minutes Introductions, course materi- Registration, fill-out name cards 
al description, course objec-
tives 

15 minutes Lead discussion Discussion participation 
What is a construction super- Take notes 
intendent? 
Pros and cons of job 
Job title definition 

45 minutes Discuss superintendent re- Participate in creating 
sponsibilities list of superintendent responsi-
Record superintendent re- bilities 
sponsibilities on flip chart Take notes 
Compare chart with respon-
sibility list in Module one 

30 minutes Discuss job site set up Participate in creating list of job 
Record job site set up activi- site set up activities and discuss 
ties on flip chart past jobs with job site set up 
Compare chart with job site problems 
set up list in Module one Take notes 
Discuss past jobs with set up 
problems 

10 minutes Answer questions Open discussion of materials 
covered, ask questions, take 
notes 

5 min Conclusion, instructor dis- Students fill out evaluation 
tributes evaluation forms forms 
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MODULE l SUPERINTENDENT RESPONSIBILITIES & JOBSITE SET-UP 

THIS MODULE IS PLANNED TO PROVIDE ANSWERS TO THE FOLLOWING QUESTIONS: 

• What are the basic responsibilities of the Superintendent?

• What are the legal aspects of the position?

• How does a good Superintendent impact the construction process?

• What are the basic steps for an efficient jobsite set-up?

DESCRIPTION OF A TOP 

CONSTRUCTION SUPERINTENDENT 

As the liaison between the general contractor, 

owner, architect, government agencies, 

subcontractors, or other interested parties, the 

superintendent should keep in mind he/she is 

working for the general contractor. The 

superintendent is obligated to see a project 

completed on time and done in a manner that is 

acceptable to the standards of the industry. The 

ability of the superintendent to schedule 

subcontractors, assure job performance, head 

off potential problems, maximize profits, keep 

accurate records and maintain communications 

with all parties involved, are significant factors 

which affect the cost of the job to the general 

contractor. 

In short, a well managed job should produce a 

professionally finished project, a satisfied 

client and a profit for the general contractor. 

The successful superintendent must maintain a 

positive attitude. He or she must be able to lead 

labor and subcontractors alike. It is important 

to set the example for a cooperative effort 

between all involved in the project. He or she 

must be willing to listen to employees and 
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subcontractors and able to incorporate good 

ideas into the methods of construction. 

The best superintendents will have the years of 

experience in the field to recognize the 

differences between good construction 

practices and poor ones. They should have 

strong skills in blueprint reading and 

scheduling. Accurate record keeping, layout 

and communication expertise are other 

necessary attributes. Top superintendents will 

coordinate the efforts of the architect, owner, 

general contractor, the labor force, 

subcontractors and other interested parties, to 

produce a complete project. 

What exactly does the superintendent do when 

he/she arrives on site? 

On a typical site phone messages might be 

addressed first thing in the morning. Business 

carried out on the phone might as follows. 

Check that materials are on the way, see that 

subs are aware of their commitments, ensure 

that required inspections are scheduled, a 

clarify documents with the architect, and 

communicate with the home office. (Project 

manager) 

The busy super might next meet with the 

subcontractors working on site. While talking 
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Superintendent Responsibilities & Jobsite Set-Up Module l 

to the subs the super should ask about and note 

the subs' manpower on site for that day. Next 

the super might inspect the work being done. 

Invariably the super will get asked for 

clarifications about the contract documents. If 

the super is sure of the answer it will be readily 

given. If there is any question about the answer 

the super will get the information from those 

described in the contract documents as having 

the authority to make such a clarification. 

An important part of the day might be working 

with the foreperson of the general contractors 

own carpentry, or other direct labor, crew. 

Reviewing and updating the rolling schedule, 

examining the blueprints to resolve a 

construction question, discussing manpower 

requirements and problems, planning 

upcoming events, etc., these are all items that 

will need to be coordinated with the foreperson. 

Back at the trailer the superintendent will 

undoubtedly have some phone calls to answer 

and some calls to make. The superintendent 

may want to up date the overall schedule for the 

job site or write R.F.I.s to the architect. There 

will be correspondence to reply to, submittal 

reviews to examine and maybe change order 

information to relay to the project manager. 

Time cards for direct labor have to be filled out 

and of course a Diary of the days events will 

have to be created. 

On some days there will be meetings to attend, 

on the job site and sometimes after the job shuts 

down at the main office. Safety plans have to be 

tailored to the jobsite and plans for the next few 

weeks want to be finalized. 

The best superintendents will have the years of 

experience in the field necessary to recognize 

the difference between good construction 

practices and poor ones. 

l - 2

DEFINITION OF CONSTRUCTION 

SUPERINTENDENT 

Legal on site representative of the general 

contractor. 

• He/she can sign documents

• He/she can hire and fire personnel

• He/she can schedule contractors to begin
construction

• He/she can rent equipment

• He/she can review and accept, or review
and refuse quality of work for compliance
with contract documents

• He/she is the supervisor for all safety issues
on site

The supervisor for all of the general 

contractors labor force. 

• She/he is the overall labor planner and
manager

• She/he will verify time cards

• She/he will set quality control standards

• She/he will carry out the general
contractors labor policies

Coordinator of all the elements required 

to build a successful project. 

• He/she will create and administer the
schedule

• She/he will coordinate with all interested
parties involved in the contract

• He/she will estimate and order materials to
arrive at proper time
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Module l Superintendent Responsibilities & Jobsite Set-Up 

SUPERINTENDENT JOB RESPONSIBILITIES 

The superintendent normally has a list of duties 

that will have to be performed. Not all of these 

tasks will be done on a daily basis but the 

superintendent should be aware of each of these 

items and how to perform them. 

1. Review all contract documents at the start
of the project. This review process may
start weeks in advance of actual construc
tion. Incorporate all addenda and change
orders into working sets of drawings and
specs.

2. Build and maintain a working schedule. Af
ter schedule is approved per contract docu
ments, distribute copies to all involved in
the project.

3. Check on the performance of your subcon
tractors. This includes assuring that they
meet schedule, perform the obligations of
their contract in a professional manner and
do not illegitimately impede the progress of
the other contractors.

4. Maintain an accurate daily report. Carry a
pocket diary with you in the field and take
notes as required. This will help in writing
the daily report. Information should include
subcontractors on site, what they are work
ing on and number of men present. It should
include job progress or delays, important
phone conversations and any unusual oc
currences, an accident or an injury for ex
ample.

5. Be prepared to attend meetings with archi
tects, owners, government agencies, sub
contractors, project manager or other
persons involved with the project. Have
copies of agenda, minutes of last meeting,
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daily diaries, copies of correspondence per
tinent to topics to be discussed and an up to 
date working knowledge of the state of the 
project. 

6. Never make any changes to the plans with
out written approval from those indicated in
the contract with the authority to do so. All
changes should be reviewed by all subcon
tractors for possible impact to their cost or
schedule. These changes must be coordi
nated with your project manager.

7. Make arrangements with appropriate agen
cies for permits or fees. This may be with
building, health, water, fire or public works
departments. Subcontractors are possibly
liable to purchase their own building per
mits so check contracts with subs for de
tails.

8. Insure that all material to be delivered to the
job site is on schedule and is received and
inventoried. It must be installed or stored in
a protected area. You should sign receipt
"Subject to Inventory", if it is inconvenient
to count all materials at time of delivery.

9. Maintain a safe and healthy environment in
which to work. Schedule and conduct safe
ty meetings. Check that your personnel on
site are physically fit and able to perform
their jobs. Be prepared to document any in
jury or accident occurring on your job site.

10. If you suspect any person to be under the in
fluence of drugs or alcohol, enact your
company policy.

11. Your personal appearance should be pro
fessional and neat. Your trailer should be
organized and clean with no pinup calen
dars or other offensive materials.
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Superintendent Responsibilities & Jobsite Set-Up Module l 

JOB SITE SET UP 

1. Arrange for temporary trailer or work area.
Trailer may require site located on plans
and a permit may be necessary.

2. Portable toilet facilities. A temporary john
will usually serve 10 workmen one week
with regular servicing.

3. Telephone services. Contact local tele
phone company and arrange for field office
phone, fax line or inspectors phone line, as
needed.

4. All permits and complete approved plans
must be on site before construction starts.
You should have one set for as-builts.

5. Water must be provided, for drinking and
construction purposes.

6. Temporary power pole location must be
spotted by utility company. Temporary
power pole may require inspection before
the utility company will connect.

7. Arrange for temporary fencing if needed or
required. Check plans and specs for notes
or details.

8. Move your desk, file cabinets, office sup
plies, etc. on site as soon as possible. Plan
your space for meetings, plans table, stor
age, office equipment and desk and chairs.

9. Have should have a copy of sub contractor
contracts, correspondence, phone numbers,
and names of contact persons. Information
from architects, engineers, owners, home

l - 4

office, government agencies or other in
volved parties, should also be filed or 
stored as needed. 

10. Post job sign in approved location. Check
plans and specs for details and information
required to be displayed.

11. Contact underground service location com
pany for existing utility locations. Do this
before any excavation or digging starts.

12. Copies of code books, catalogues or other
necessary reference material should be on
site.

13. Have a camera to record job starts, differing
conditions than noted on plans, progress, or
the lack of, job site conditions due to weath
er or any picture that can clarify a written
statement.

14. Post emergency phone numbers. Note ad
dress of nearest medical assistance and
show clear map for easy location.

15. Provide a first aid kit large enough to serve
the crew size. Do not dispense aspirin, cold
pills, antacid or other remedies. Have visi
tor hard hats, fire extinguishers or other
safety equipment on site.

16. Post job rules. Hard Hats Required, No
Trespassing, No Smoking, etc.

17. Arrange for locking job box or lockable
storage shed.
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MODULE 2 CONTRACT DOCUMENTS 

THIS MODULE IS PLANNED TO PROVIDE ANSWERS TO THE FOLLOWING QUESTIONS: 

• What are the Contract Documents?

• What are the legal aspects of understanding and administering the Contract Documents?

• How does a good Superintendent manage these articles?

• How do the Contract Documents effect every aspect of the job?

INTRODUCTION TO CONTRACT 

DOCUMENTS 

Most projects, in today's construction industry, 

would not be started without a complete set of 

contract documents. These documents set forth 

the responsibilities of the owner, the architect, 

the general contractor, the inspector and or 

other interested parties. The documents show 

in pictorial form how the project will look 

when completed. These documents will give 

dimensions, they will list material types and 

grades, they will have door and hardware 

schedules and they can show substructure and 

underground systems. The documents might 

amend, change, add to or delete from earlier 

documents. Addenda are an example that can 

change documents during the bidding process. 

Documents can supply answers to questions 

about the project or they can clarify drawings. 

During the bidding process the different 

contracting companies will all have the same 

document package to bid on. After the contract 

is awarded the documents will change and be 

added to, as the work progresses. Addenda are 

an example of the former and Daily Diaries are 

an example of the latter. 

LTP/2 -Contract Documents 

NO SINGLE DOCUMENT MAKES UP THE 

CONTRACT, BUT RATHER ALL 

DOCUMENTS AS A WHOLE ARE THE 

LEGALLY ENFORCEABLE AGREEMENT. 

A complete set of documents is required for a 

comprehensive and accurate estimate of cost. 

A complete set is required for a plan check with 

the appropriate permit agencies. A complete 

set is required to determine if the proposed 

structure will meet the owners needs and 

expectations. Of course a complete set is 

required to provide instructions to build the 

project. In short, you cannot construct a project 

without the all the rules and all the directions. 

The contract documents are prepared by an 

architectural team. This team may consist of 

the: 

• Architect

• Structural Engineer

• Civil Engineer

• Electrical Engineer

• Mechanical Engineer

• Landscape Architect

• Specialty Consultants
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Contract Documents 

• Lawyer

This team will prepare the documents for 

review by the owner. The architect will design 

a structure to meet the owners needs. The 

structural engineer will add design elements 

that make the building strong enough to meet 

codes. The civil engineer locates the building 

on the site, assigns elevations and coordinates 

utility connections. Electrical and mechanical 

engineers design the electrical, plumbing, 

heating and cooling systems. The landscape 

architect of course designs the exterior planted 

areas. Specialty consultants and lawyers round 

out the team. All are coordinated by the 

architect and all inquiries go through the 

architect. 

When the completed documents are accepted 

by the owner and appropriate review agencies 

they are released for bid purposes. If it is a 

Public Works project there are strict bidding 

rules and qualifications to meet. If the project 

is for a private owner the bid may be 

negotiated. 

Should your company be awarded a contract, 

and the project given to you to oversee in the 

field, it will be your responsibility to read 

"every word on every page" of the contract 

documents. Take a look at the Bound Project 

Manual provided in the document package. 

Underline or highlight every statement, detail, 

drawing etc., that you do not understand or that 

may conflict with another section or detail. Go 

through the blueprints and do the same thing. 

THE ORIGINAL CONTRACT DOCUMENT 

PACKAGE 

• Bound Project Manual w/Specifications

• Working Drawings

• Alternates

2-2

Module 2 

• Addenda

BOUND PROJECT MANUAL 

FRONT END DOCUMENTS 

This section of the documents defines the 

agreement between the owner, general 

contractor, project management company, if 

one is used, and architect. It lists the parties to 

the contract and their responsibilities. The 

documents will describe the scope of work, list 

an agreed upon contract sum and will show a 

length of time to complete the work. It will 

define the method of payment, the amount of 

the payment and timing of the payment by the 

owner to the general contractor. It may describe 

testing methods and who administers the 

testing. The architect will often use a standard 

form as written by the American Institute of 

Architects (AIA). 

This document is usually broken down into the 

following administrative elements. 

A. STANDARD CONTRACT OF FORMS AND

DOCUMENTS

This would contain the signed agreement

between the owner and general contractor,

performance bond, proof of insurance and

escrow agreement.

B. GENERAL CONDITIONS

These are the rules that must be followed in

constructing the project. The owner and ar

chitect try to anticipate possible events and

the resolutions required if they should oc

cur. The conditions define the role of the

different parties to the contract and they de

fine what documentation is needed. The

General Conditions can consist of the fol

lowing sections.

1. General Provisions

2. Owner
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3. Contractor

4. Administration of the Contract

5. Subcontractor

6. Construction by Owner or by Sepa-
rate Contractor

7. Changes in the Work

8. Time

9. Payment and Completion

10. Protection of Persons and Property

11. Insurance and Bonds

12. Uncovering and Protection of
Work

13. Miscellaneous Provisions

14. Termination or Suspension of the
Contract

C. SUPLEMENTARY CONDITIONS

These are modifications to the General

Conditions. The General Conditions may

be a generic standard format. The "Supple-
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mentals" refine the documents to encom

pass the particular projects needs. 

D. SPECIAL CONDITIONS

These add to the General Conditions. Some

items might be liquidated damages or tem

porary fencing. The conditions might also

be to comply with Equal Employment Op

portunity or MBE/WBE ( Minority Busi

ness Enterprise or Women Business

Enterprise) requirements.

Specifications 

The specifications are a written description of 

what materials are acceptable and what quality 

of construction are required to successfully 

build the project. The specs detail the quality 

of the material and the workmanship. Often the 

specs refer to other sets of standards. The 

specifications may require that all framing 

lumber be stamped (Construction Grade). To 

those not used to reading specifications it can 

be confusing trying to understand what the 

architect is asking for. 
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Contract Documents Module 2 

• Example One

The specification concerning millwork may read as follows:

Division 6400

Factory finishing of interior architectural woodwork

A. General

The primary finishing of interior architectural woodwork required to be performed at factory

is work of this section.

B. Preparations for finishing

Comply with referenced quality standard for sanding, filling counter sunk fasteners, sealing

of concealed surfaces and similar preparations for finishing of architectural woodwork, as ap
plicable to each unit of work. Quality standard W.I.C. 25, System #6 (Synthetic Enamels

(opaque) Economy Grade)

• Example Two

The specs may also specify grades of lumber as follows:

A. General

Framing shall be Douglas Fir, Coast Region, conforming to West Coast Lumber Inspection

Bureau Standard Grading and Dressing, Rule #16.

2x, 3x, 4x, plates, joists, purlins, and beams, number 1 (1500 F-B), Para. 123-b, unless noted

otherwise on the drawings.

1 . What is the architect saying about the factory finish?

2. What is the referenced quality standard?

Be very careful when reading specifications. 

On many occasions you will find specs that do 

not relate to the task or the materials on hand. 

Do not try to interpret confusing or misleading 

information on your own. Ask for a 

clarification from the architect. Many times 

the plans and the specs will be at odds with 

each other. The Front End Documents will 

usually state which takes precedence, plans or 

specs. If two different grades of material are 

called out for in the plans and specs, be 

prepared, there is usually a statement in the 

General Conditions that the higher grade 

material is to be used. 

The specifications are probably going to appear 

intimidating the first time you look at them. 

2-4

They can be as large as a good size book. Take 

the time to read them and highlight anything 

that looks like you may need to apply at a later 

date. There are some architects who simply 

pull the data out of a manual and don't either 

really understand the data or know how it 

applies to the job. It will be to your benefit if 

you know how they apply. 

Keep in mind that you are going to be reading 

the specifications over the course of 

constructing the project. This might be for a 

period of one or more years. After a period of 

time you will find that you have become more 

familiar with these contract documents than the 

person who designed them. 
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Working Drawings 

We commonly refer to these as the plans or the 

blueprints. Their function is to show in pictures 

what is being built. The working drawings, in 

addition to showing dimensions, locations, 

details and elevations, contain written sections 

of notes and schedules. 

The plans are broken into different sections 
'

usually by major trades. These sections are 

usually prepared by a team, assembled by the 

architect, each a specialist in his own field. 

Most plans contain the following. 

A. CIVIL DRAWINGS

hese can show the boundary of the proper

ty, property elevations, building, sidewalk,

curb, driveways, parking, storm sewer and

utility locations. Basically these depict the

property and improvements to it, and how

these relate to the building.

B. ARCHITECTURAL DRAWINGS

These depict the building in its entirety.

They will show all dimensions required for

the finished product. They show in detail

how the building is going to look when the

building is completed. They will give exact

locations and elevations for built in items.

They will show details for finish carpen

ters. They will give room and building di

mensions. They will contain schedules of

doors and windows. They will stipulate

what color paint, what size, shape and color

tile, rug, etc. In short, they show the build

ing from inside and out.

C. PLUMBING DRAWINGS

These obviously show all the plumbing.

They give lists of what style, type, size,

color, manufacturer, etc. of fixtures. They

show location of hot and cold water lines 
'

details for attachment, sewer lines, gas pipe

locations and where they connect to exist

ing utilities.
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D. MECHANICAL DRAWINGS

These show the heating and cooling sys

tems. They show sizes of pipe, ductwork,

vents, fans, etc. They show locations and

detail all components and requirements of

the system.

E. ELECTRICAL DRAWINGS

These show the entire electrical system.

They give all details for wiring, conduit,

transformers, switch gear, lights, outlets,

etc. They also detail all components and re

quirements of the system.

F. STRUCTURAL DRAWINGS

These show how the building will be built

and with what type and size materials.

They will show locations for all structural

connections. They will give nailing, bolt,

hold down, rebar and concrete details.

They show what to use to build the building

so that it will not fall down.

G. LANDSCAPE DRAWINGS

These show the planted areas. They show

what size, type, color, species, etc. of plant

ing. They also show sprinkler systems.

They give depths of soils, amendments,

ground cover, etc. They depict the planted

exterior.

Reading the Blueprints 

One of the superintendent's jobs is to read and 

understand the plans. This means every word 

on every page. If you do not know what a 

particular symbol means ask the architect. You 

are going to be in charge of the construction 

and are going to have to insure the coordination 

of all the subcontractors. Study the plans and 

check for inconsistencies between sections. 

Does the Architectural section show the same 

number of rooftop H.V.A.C. units as the 

Mechanical section? 

You will notice that in the different sections 

there are notes that refer to other sections. The 
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plumbers rain water leader attachment details 

may appear in the Architectural section. The 

wood curb details your framers need may be in 

the Mechanical section. General contractors 

will ask their subcontractors to bid per plans 

and specs. Each subcontractor gets a complete 

set of plans and specs. If there is an electricians 

detail in the Landscaping section, the 

electrician is responsible to perform to the 

detail. 

Try to locate any problems with the plans and 

get them resolved before they become critical. 

There may be gaps in the plans. The 

mechanical engineer may have left out a cold 

water make up for the chiller unit. The 

architect may have left out a roof access. 

Finding these problems before they create a 

crisis situation will save the general contractor 

time and money. 

Always remember to compare the information 

from the blueprints with the information from 

the other parts of the Contract Documents. 

Does the spec book ask for Alaskan Yellow 

Cedar beams and the plans list the beams as 

Douglas Fir? These kind of discrepancies crop 

up in every job. 

Addenda 

These are any changes to the contract 

documents or the bid documents, issued by the 

architect, owner or engineer during the bidding 

period. These addenda can be additions, 

deletions, modifications or clarification's to the 

contract documents. When the general 

contractor submits a bid proposal there must be 

an acknowledged receipt of all addenda. 

The superintendent, when all contracts are 

signed and he/she is reviewing the documents, 

should take the addendum and paste them in 

their appropriate places in the plans and specs. 

Having these in place will be a good deal easier 
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than trying to locate a piece of paper months 

later in the course of building the project. 

Addenda can be generated by contractors 

asking questions of the architect or by the 

owner deciding to omit a portion of the work. 

During the review process a fire Marshall may 

require an additional fire hydrant. If these 

addenda are issued before the bid, they become 

part of the bid package and part of the Contract 

Documents. 

Alternates 

Alternates are items completely designed and 

specified in the contract documents, 

constituting additions or deletions from the 

base bid, or alternative materials or methods 

from those shown as base bid items for which 

the contractor submits separate prices. 

An example of this is as follows: 

The architect has put together a project to bid 

on involving building an office complex. The 

owners have asked that the bids separate the 

landscaping from the bid package. The 

landscaping is alternate number one. Alternate 

number two is for an additional parking 

structure. In this way the owner can compare 

costs from the different bidders and spend his 

money as is in his best interests. 

CONTRACTOR NO. l 'S BID PACKAGE 

Base Bid 

Alternate one 

Alternate two 

$1,000,000 

$85,000 

$175,000 

CONTRACTOR NO. 2'5 BID PACKAGE 

Base Bid 

Alternate one 

Alternate two 

$988,000 

$108,000 

$221,000 
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If the owner wants the complete project built 

now, contractor number one is the best choice. 

lf he wants to build the office complex now and 

hold off on the other work, number two is the 

logical choice. 

ADDITIONAL DOCUMENTS 

These are not part of the original document 

package but are necessary to carry out the 

provisions of the contract. Sometimes these 

documents are called out for in the contract 

documents. 

The original contract documents might require 

a Daily Diary or Log of each days activity 

while on site. The diary now becomes an 

additional or peripheral document. 

Subcontracts 

Few firms would perform all of the work on a 

construction project with their own manpower. 

Companies are specialized and will work on 

particular aspects of the project. An electrical 

or plumbing contractor will build the work 

specified by the general contractor in the 

subcontract agreement. This agreement should 

clarify exactly what work is to be performed, 

state all conditions of the contract and stipulate 

the price the subcontractor will get paid for the 

work. 

A standard form such as the AGC Standard 

Subcontract Agreement is often used. 

Change Orders 

These are modifications to the original contract 

documents, issued in writing by those 

authorized in the contract documents, after the 

agreement between the owner and the general 

contractor has been signed. Change orders can 

change the scope of work, the contract sum and 

or the length of the contract. 

LTP/2 -Contract Documents 
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As stated in other areas, no superintendent 

should proceed with work that is a change from 

the original scope of work, without a signed 

change order. No superintendent should 

implement solutions to problems in the contract 

documents no matter how logical they may 

seem, without a signed change order. No 

superintendent should sign an extra work order 

issued by a subcontractor, without having a 

signed change order from the owner that will 

cover the work in question. You may find the 

subcontractor has legitimate cause to ask for an 

extra work order to perform work that is in the 

contract documents but that is not in the 

subcontractors scope of work. The estimator 

may have missed putting this item in the 

subcontractors contract so the best course of 

action is to check with your project manager. 

There is an entire module based on change 

orders, so we can cover these in depth at 

another time. 

Submittals 

Submittals are information about particular 

items or methods of construction prepared by 

subcontractors or suppliers. The submittals 

must be accepted before installing materials or 

components on the construction project. They 

can be a set of shop drawings, actual samples of 

the product, technical information or a mock up 

showing quality of construction. 

There is a separate module on submittals so we 

will study their impact in detail in module four. 

Schedule 

The schedule is the projected plan for the 

construction project. It is usually broken down 

into separate tasks and trades, which show a 

logical progression and interdependency upon 

each other. It also depicts start and finish dates 

for the different elements of the project, in 
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addition it displays the project start and 

completion dates. 

In the Front End Documents there is usually a 

time of completion specified for the project. 

There may also be a requirement for a schedule 

to be produced by the general contractor within 

a certain period of time after the contract is 

signed. There may also be a requirement for a 

specific type of schedule, such as a C.P .M. 

type, or a specific computer generated schedule 

such as Primavera®. Producing this schedule 

may also be a part of the job of the 

superintendent. 

This schedule is important in many ways. It 

will allow the superintendent to plan on 

material deliveries, when to start different 

phases of the job, when to call in each 

particular sub contractor and to determine if the 

owner has allowed enough time to complete the 

project in a reasonable manner. 

When a schedule is submitted to the architect 

and it is reviewed and approved, it becomes 

part of the contract documents. The sub 

contractors are required to perform their 

portions of the work in the time allotted to them 

and in the sequence shown to them in the 

schedule. The general contractor is obligated 

to insure that this schedule is met. We will 

discuss scheduling in depth in module five so 

we won't pursue this further at this time. 

Standards 

Standards are detailed specifications and 

requirements for a material, test or process. 

They are written by the agency that regulates or 

provides standardized specifications or 

procedures for the product or process. 

Some of the standards that are often referenced 

by the architect might include requirements for 

concrete, steel doors and frames, framing 

lumber and finish hardware. The specification 
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on one project for "Finish Hardware Section 

08710" states: 

• Provide hardware for fire rated openings in
compliance with 1999 CBC, UBC Standard
43-5 and NFPA 80.

Codes 

Codes are regulations, ordinances and 

standards, written or adopted by government 

and enacted into law. These codes establish 

minimum requirements for the design and 

construction of buildings within the 

jurisdiction of the code, they provide for the 

safety, health and welfare of the public. 

Included in the code are provisions which 

allow for inspection of the construction 

process. 

Group Discussion Questions 

1. A question concerning safety on the jobsite
is brought up in a meeting with the archi
tect, owner, general contractor and sub con
tractors. It relates to; Who is responsible
for providing barriers and fencing for
project site? Where should we look in the
documents for the answers?

2. The bound project manual often references
other publications for details regarding in
stallation of building materials. Steel door
frames, section 08111 contains the follow
mg:

"Install door frames in accordance with

ANSI/SDI-100. For fire rated frames

NFPA 80."

What is your responsibility, as the general

contractors superintendent, for knowing or

providing the information in that docu

ment?

3. The plans show a particular red iron bucket
in three locations where glu-lams join at the
parapet wall. At the fourth location the ar
chitect has failed to draw in the detail for
the bucket. The glu-lams are the same and
the parapet wall details are the same. The
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framing sub contractor states she/he wants 
an extra for the fourth bucket, if it is re
quired. The architect says the intent of the 
plans clearly require the bucket as the con
tractor is responsible for a complete system 
of framing and structural members. How 
should you respond to the concerns of the 
architect? 

5. In what way have you seen contract docu
ments affect a job you were working on?
Please list examples of how the documents
benefited and how they hindered the
project.

6. Do contract documents change as the
project progresses? If yes, In what way? If
no, Why not?

4. What is the single most important docu
ment in a contract with a city building a
community hospital?

The general contractor I was working for had submitted the low bid for a new 
grammar school and was awarded the job. Because I was the superintendent I took 
the time to review the contract documents before construction started. I noticed a 
discrepancy in the contract documents. The structural and the architectural drawing 
details, showing the framing, specified using Douglas fir, #1 grade, for exposed 
breezeway beams and joists. In fact the blueprints showed using Douglas Fir in 16 
separate places. The specification section, in one location, describing the same beams 
noted using Alaska Yellow Cedar beams. Later that day I found a note in the front-end 
documents that said "if there are discrepancies in the contract documents specifications 
will take precedence over plans. I was confused and wrote an RF.I., {Request for 
Information}, directed to the architect and asked him how to proceed. He answered 
that after creating the contract documents, the O.S.A., { Office of the State Architect}, 
changed the requirements for exposed structural wood to be naturally weather resistant. 
The architect had added the new requirements to the specifications but had neglected to 
change the blueprint details. Our company had bid on supplying Douglas Fir lumber, 
not Alaska Yell ow Cedar. We submitted a Change Order Proposal to cover the added 
cost of the more expensive material. 

Questions? 

1. Do you think the architect and owner approved the Change Order Proposal request?
2. If your answer is yes, why do you think it was approved?
3. If you think the architect and owner said no, why do you think the request was denied?
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THE CONSTRUCTION SPECIFICATION INSTITUTES UNIFORM SYSTEM 

Division 1 :General Requirements 

01010 

01100 

01150 

01200 

01300 

01400 

01500 

01600 

01700 

Summary of Work 

Alternatives 

Measurement and Payment 

Project Meetings 

Submittals 

Quality Control 

Temporary Facilities and Controls 

Material and Equipment 

Project Closeout 

Division 2:Site Work 

02010 

02100 

02110 

02200 

02250 

02300 

02350 

02400 

02500 

02550 

02600 

02700 

02850 

02900 

02950 

Subsurface Exploration 

Clearing 

Demolition 

Earthwork 

Soil Treatment 

Pile Foundations 

Caissons 

Shoring 

Site Drainage 

Site Utilities 

Paving and Surfacing 

Site Improvements 

Railroad Work 

Marine Work 

Tunneling 

Division 3:Concrete 

03100 

03150 

03200 

03250 

03300 

03350 

03360 

03400 

03500 

03600 
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Concrete Formwork 

Forms 

Concrete Reinforcement 

Concrete Accessories 

Cast in Place Concrete 

Specially Finished Concrete 

Specially Placed Concrete 

Precast Concrete 

Cementitious Decks 

Grout 

Division 4:Masonry 

04100 

04150 

04200 

04400 

04500 

04550 

Mortar 

Masonry Accessories 

Unit Masonry 

Stone 

Masonry Restoration and Cleaning 

Refractories 

Division 5:Metals 

05100 

05200 

05300 

05400 

05500 

05700 

05800 

Structural Metal Framing 

Metal Joists 

Metal Decking 

Lightgauge Metal Framing 

Metal Fabrications 

Ornamental Metal 

Expansion Control 

Division 6:Wood and Plastics 

06100 

06130 

06150 

06170 

06200 

06300 

06400 

06500 

06600 

Rough Carpentry 

Heavy Timber Construction 

Trestles 

Prefabricated Structural Wood 

Finish Carpentry 

Wood Treatment 

Architectural Woodwork 

Prefabricated Structural Plastics 

Plastic Fabrications 

Division 7: Thermal and Moisture 

Protection 

07100 

07150 

07200 

07300 

07400 

07500 

07550 

07600 

07800 

07900 

Waterproofing 

Dampproofing 

Insulation 

Shingles and Roofing Tiles 

Preformed Roofing Siding 

Membrane Roofing 

Traffic Topping 

Flashing and Sheet Metal 

Roof Accessories 

Sealants 
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Division 8:Doors and Windows 10600 Partitions 

08100 Metal Doors and Frames 10650 Scales 

08200 Wood and Plastic Doors 10670 Storage Shelving 

08300 Special Doors 10700 Sun Control Devices (Exterior) 

08400 Entrances and Storefronts 10750 Telephone Enclosures 

08500 Metal Windows 10800 Toilet and Bath Accessories 

08600 Wood and Plastic Windows 10900 Wardrobe Specialties 

08650 Special Windows 

08700 Hardware and Specialties Division 11: Equipment 

08800 Glazing 11050 Built-In Maintenance Equipment 

08900 Window Walls/Curtain Walls 11100 Bank and Vault Equipment 

11150 Commercial Equipment 
Division 9:Finishes 11170 Checkroom Equipment 

09100 Lath and Plaster 11180 Darkroom Equipment 

09250 Gypsum Wall board 11200 Ecclesiastical Equipment 

09300 Tile 11300 Educational Equipment 

09400 Terrazzo 11400 Food Service Equipment 

09500 Acoustical Treatment 11480 Vending Equipment 

09540 Ceiling Suspension System 11500 Athletic Equipment 

09550 Wood Flooring 11550 Industrial Equipment 

09650 Resilient Flooring 11600 Laboratory Equipment 

09680 Carpeting 11630 Laundry Equipment 

09700 Special Flooring 11650 Library Equipment 

09800 Special Coatings 11700 Medical Equipment 

09900 Painting 11800 Mortuary Equipment 

09950 Wall Coverings 11830 Musical Equipment 

11850 Parking Equipment 

Division 1 O:Specialties 11860 Waste Handling Equipment 

10100 Chalkboards and Tackboards 
11870 Loading Dock Equipment 

10150 Compartments and Cubicles 
11880 Detention Equipment 

10200 Louvers and Vents 
11900 Residential Equipment 

10240 Grilles and Screens 
11970 Theater and Stage Equipment 

10260 Wall and Comer Guards 
11990 Registration Equipment 

10270 Access Flooring 

10280 Specialty Modules 
Division 12:Furnishings 

10290 Pest Control 12100 Artwork 

10300 Fireplaces 12300 Cabinets and Storage 

10350 Flagpoles 12500 Window Treatment 

10400 Identifying Devices 12550 Fabrics 

10450 Pedestrian Control Devices 12600 Furniture 

10500 Lockers 12670 Rugs and Mats 

10530 Protective Covers 12700 Seating 

10550 Postal Specialties 12800 Furnishing Accessories 
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Division 13:Special Construction 

13010 

13050 

13100 

13250 

13350 

13400 

13440 

13450 

13500 

13540 

13550 

13600 

13700 

13750 

13770 

13800 

13850 

Air Supported Structures 

Integrated Assemblies 

Audiometric Room 

Clean Room 

Hyperbaric Room 

Incinerators 

Instrumentation 

Insulated Room 

Integrated Ceiling 

Nuclear Reactors 

Observatory 

Prefabricated Structures 

Special Purpose Rooms &Structures 

Radiation Protection 

Sound and Vibration Control 

Vaults 

Swimming Pools 

Division 14:Conveying Systems 

14100 

14200 

14300 

14400 

14500 

14570 

14600 

14700 

14800 
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Dumbwaiters 

Elevators 

Hoists and Cranes 

Lifts 

Material Handling Systems 

Turntables 

Moving Stairs and Walks 

Tube Systems 

Powered Scaffolding 

Module 2 

Division 15:Mechanical 

15010 

15050 

15180 

15200 

15300 

15400 

15500 

15600 

15650 

15700 

15800 

15900 

General Provisions 

Basic Materials and Methods 

Insulation 

Water Supply and Treatment 

Waste Water Disposal and Treatment 

Plumbing 

Fire Protection 

Power or Heat Generation 

Refrigeration 

Liquid Heat Transfer 

Air Distribution 

Controls and Instrumentation 

Division 16:Electrical 

16010 

16100 

16200 

16300 

16400 

16500 

16600 

General Provision 

Basic Materials and Methods 

Power Generation 

Power Transmission 

Service and Distribution 

Lighting 

Special Systems 
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FINAL REVIEW 

During the time frame of the contract, the superintendent will undoubtedly refer to the contract 

documents on a daily basis. He/She may need to remind the subcontractor of the grade of lumber 

required for a window header. The superintendent may have cause to refer to the working 

drawings to clarify the installation of a seismic brace found in a structural detail. Found in the front 

end documents will be details on the billing procedure. The superintendent may wish to order 

materials so as to arrive right before the cut off date. 

The contract documents define responsibilities and settle disputes among subcontractors and the 

general contractor or among owner and the general contractor. If the sub contract for the electrical 

portion of the work includes section 16500 of the Bound Project Manual, there can be no doubt the 

electrician is responsible for providing the lighting. 

Before a project gets underway on site, the superintendent should familiarize himself with all 

documents. Any questions about these documents should be brought up at the pre-construction 

meeting. These questions might pertain to details that do not contain enough information or 

specifications that do not meet current codes. Perhaps the documents state that a phone and desk 

must be available for the engineer while that person is on site. Does this mean the engineer gets a 

separate desk and phone or can he share with the superintendent? Try to get all ambiguities 

resolved before starting construction. That will prove to be a good deal easier than "putting out 

fires" as they arise. 
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NOTES: 
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CONTRACT DOCUMENT QUESTIONNAIRE 

Instructions: This Module Exercise is to be completed by participants broken into groups of 4-5 

individuals. Participants are to survey and read the provided "Specifications" and answer the 

following questions: 

1. Who is responsible for supervising safety programs?

2. What type of lumber and what grade is required for 6x10 posts?

3. How often should the General Contractor hold coordination meetings?

4. Who is responsible for paying for the use of temporary power?

5. What temporary facilities is the General Contractor required to provide for the Inspector?

6. Which acceptable Glazed Tile manufacturers are allowed by the Architect?

7. Who is responsible for certifying Prefinished Casework?

8. How long of a time period should you schedule for the initial processing of each submittal?
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MODULE 3 CHANGE ORDERS 

THIS MODULE IS PLANNED TO PROVIDE ANSWERS TO THE FOLLOWING QUESTIONS: 

• What is an on site occurrence of a change order?

•

• 

How much paperwork is involved in processing a change order?

What is the impact of a change order?

• How do you know who is responsible for the cost of a change order?

LEADERSHIP TRAINING PROGRAM 

(LTP) 

Module Three: Change Orders 

If you are working in construction you have 

probably dealt with a change order. Typically, 

if you are a carpenter, you might have 

completed building a wall and the next thing 

you know the boss is telling you to tear it down 

and rebuild it another way. As far as you are 

concerned your previous work was a waste of 

your time. 

Why do so many change orders occur? 

• Is it because the architects and owners

can not make up their minds?

• Do these changes slow down your

production?

• Do the changes cause confusion among

the sub-contractors?

• How do these changes affect the

schedule?

Like many other types of work, the 

construction industry has been going through a 

period of rapid change. Computer assisted 

bidding programs, rapid mobile 

LTP/3 - Change Orders 

communication and e-mailing are all part of the 

bidding process. When a project comes up for 

bid several general contractors will acquire sets 

of bid documents and investigate whether or 

not they would like to build the project. If they 

decide they want to do the work they will seek 

sub-contractors to bid on various portions of 

the work. Whatever work the sub-contractors 

do not perform, the general contractor must 

hire workers to complete. Many different subs 

will bid on the same section of work. There 

may be five electrical contractors seeking the 

same work for example. These subs will also 

submit the same bids to the other general 

contractors. This means that each general 

contractor has essentially the same prices to do 

all the work, except for the work the general 

contractor must perform. The general 

contractors' work would include offsite project 

management, onsite job supervision and the 

direct labor costs of the general contractors 

own workforce. What this means is that when 

general contractors are putting together the 

costs for a ten million dollar project, the dollar 

value of the general contractors bid, minus the 

subs work, may be only 10% of the total 

contract value. Now the general contractor 

must bid the lowest price possible to get the 
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work. Large jobs are sometimes bid with only a 

one or two percent profit margin built in. 

This means the contractor must look for profits 

where ever they can be found. Contractors no 

longer have the luxury of adding contingency 

money to the bid to cover unexpected costs. 

The end result of this is that the estimators must 

bid per the contract documents and 

construction superintendents must carefully 

monitor the job and insure that both he and his 

subs are not performing work that is not 

specifically covered in the contract documents. 

In contracting for the public sector, the general 

contractor is required to bid on a project per the 

bid set of contract documents. The contractor 

cannot make any assumptions nor can the 

contractor just arbitrarily add a figure for 

expected changes. Any changes to the contract 

document must be paid for by the persons 

causing the change order. This may mean the 

contractor has to adjust the cost of the contract 

down, if the architect removes something. The 

contractor may propose a cost for additional 

work if requested. When a bid for a project is 

accepted, there is usually no more than 1 to 5 

percent mark up over cost, and in today's 

market 5% can be on the high side. 

The profit will be realized if there is nothing to 

slow the job down. 

3-2 

• All the subs must arrive on site with all

the right tools, equipment and manpower

to perform to the letter of the contract.

• All of the information provided in the

contract documents is clear, there are no

mistakes or omissions and all required

permits are in hand.

• All submittals are in, reviewed and

accepted, long lead items arrive in time,

funding is provided as promised and

everyone has their insurance and

bonding up to date.

• Also it must never rain!

Request For Information 

When a subcontractor or the general contractor 

discovers conditions other than what was 

described in the contract documents there are 

certain steps that should be followed. The 

superintendent must write an R.F.I. This 

Request for Information form must be filled out 

in the form of a question. 

For Example 

The framing foreperson is busy laying out the 

walls, doors, window openings, etc. She 

discovers there is a column right where the 

plans show a door. The architectural plans on 

page A3 show the door and on page S2, the 

structural drawings show the 4" steel column at 

the intersection of E and #3 lines. The framer 

wants to know what to do about the door 

placement. The superintendent needs to fill out 

an R.F .I. form and send it through company 

channels to the architect. 

The architect has replied to the question in the 

R.F .I. by stating he would like the door location

moved to the north side of column E3. If he

elected to delete the door the contractor might

have to create a negative change order giving

money back to the owner. Moving the door to

the north side of the column may not cause any

increase in the cost of the contract, but it is best

to distribute the R.F .I. and the answer to all

subs on the job. Moving the door to the north

side of the column might not affect your

company but it could affect the plumber for

example. If the plumbers drain pipe is to be

attached to the column it might interfere with

the relocated door. Another R.F.I. asking what

to do about the drain pipe would be written and

answer could generate an increase in the cost of

the contract.

L TP /3 - Change Orders 



Module 3 

If something is lacking in the plans the 

superintendent does not invent a solution, that 

is the job of the architect. The superintendent 

might make a suggestion to the architect, if it is 

in the best interest of the contractor. Always get 

missing information from those responsible for 

providing it. 

You must let the designer establish the 

complete and correct design, even under 

the most obvious of circumstances. 

Do not assume the responsibilities of your sub 

contractors. Sub-contractors must coordinate 

information concerning work they do that 

affects the work of other subs. For example: 

The HV AC contractor must give wiring 

information to the electrician to hook up the air 

conditioning equipment. 

This completed design must be 

documented in writing by the person 

responsible. 

Always bear in mind that anything that slows 

the project costs the contractor money. If your 

sub shows up for work and a discrepancy in the 

plans prevents him from proceeding, document 

this situation. Both your company and his may 

have a legitimate cause to charge for extended 

general conditions. 

• The contractor is not responsible for

pe,forming a complete search of plans

and specs, seeking out hidden flaws in the

contract, making subsu,face

explorations or undertaking any other

extreme, costly and time consuming

investigation. This kind of detailed

attention should have been given to the

contract documents by the owner and the

designer.

• A catchall phrase usually found in the

form of a stamped statement on the

blueprints, such as, "The contractor is

responsible for field verifying all
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dimensions and conditions shown on 

plans for accuracy and dimension.", 

does not relieve the owner and architect 

from paying for discrepancies between 

plans and actual conditions. The 

contractor did not create these 

discrepancies and should not pay for 

them. 

The contractors management team should get a 

hint as to how accurate and complete plans and 

specs are by going over them carefully. Are the 

details paste ups cut out from a book of 

standardized details? Do the plans say 

something like, "Refer to specs", rather than a 

specific detail or paragraph? Do the plans show 

different styles of writing and grammar usage? 

Are the details superfluous, "canned", or not 

really related to the specific incidence meant to 

be shown? All of these examples are indicators 

of a sloppily prepared project. This of itself can 

mean a great deal of changes ahead. 

Remember, as superintendents, your job is to 

document changed or unexpected situations not 

depicted in contract documents. Take pictures 

or make a drawing. Record important 

conversations; note the date, the time, who you 

spoke with, the gist of the conversation and 

where it took place. Keep your job diary 

accurate and up to date. See to it that your 

project manager is aware of these situations or 

potential problems so that he can start the 

process of a change order if need be. This may 

mean the difference between your company 

turning a profit, staying in business and you 

staying employed. 

Should you discover a situation that you feel 

will require a change order there are simple 

procedures that you should follow. Lets look at 

two different scenarios, one involving a 

remodel of an existing building, the other 

involving a new project. 
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In a remodel or tenant improvement the most 

common change orders are generated by 

finding concealed conditions unknown to the 

designer at the time of his preparing the 

contract documents. During the design phase 

the architect will probably not tear down or 

poke holes in every wall to determine that all 

conditions are alike. Over the course of many 

years there may have been several remodels 

done to the building. Not all of these will have 

been documented. Your plans may show 

placing a door in an existing brick wall. Upon 

opening up the wall an old sewer pipe, still in 

operation, is discovered running right through 

the proposed new door location. Your next 

steps should be as follows. 

1. Inform the architect of the situation. This
can be done informally with a phone call,
but you should fill out a Request For Infor
mation form and process it through your
company channels immediately.

2. Document the situation.

• Take pictures or make a line drawing

showing the pipe, its size, type of

material, placement in doorway, etc.

• Make an entry in your daily diary

outlining all aspects of the changed

conditions.

3. Evaluate the situation.

• Will this impact your schedule? Has the

discovery of this changed condition

already cost your company time and

money?

• Make an entry in your daily diary

outlining all aspects of the changed

conditions.

4. Wait for written instructions from the archi
tect on how he wishes to proceed. Even if
the solution appears to be quick and easy,
do not implement any changes without
written authorization.
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Module 3 

5. This new drawing should be distributed to
all sub contractors. This may be the plumb
er, the demolition contractor and possibly
the door supplier if the architect elects to al
ter the door size or placement. It may well
be a safe policy to inform all subs of all
changes. The subs might be affected in
ways that you do not figure and may well
ask you for a change order down the line.

6. Depending on your companies' policy, you
may not wish to proceed until a cost for the
change is established and approved by all
parties involved. On many occasions the
owner or architect may issue a F.W.A. or
Field Work Authorization., and ask that the
work continue while a price is being estab
lished.

Now, lets look at a situation where you are 

constructing a new building and a change 

occurs. The architect and the owner-user are 

inspecting the site. They are looking at the 

framed walls and decide that two separate four 

foot wide doors are not aesthetically pleasing, 

they would prefer one large eight foot wide 

opening with two four foot doors. The architect 

asks you to stop working on that area and 

provide a cost for installing the larger door. The 

following should guide you in proceeding. 

7. Evaluate the situation.

• If you are running your own framing

crew, figure how many man hours it will

take to dismantle then rebuild the wall.

• Will it take a special trip to the lumber

yard for more material?

• Document all potential costs, including

the time you spend figuring out the

changed conditions.

8. How will this change affect your schedule?

• Phone the door sub contractor or door

supplier and check on price, availability

and lead time required.

• If your schedule is critical and this will

cause a delay inform the architect

L TP /3 - Change Orders 
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immediately. 

9. After reviewing the change with your
project manager you should wait until you
are instructed on how to proceed. It may
take a few days for all affected subs to re
spond to price requests.

• Document in your daily diary the fact

that the architect asked you to stop work

on that door area. If a decision is made to

stay with the original drawings you may

already have been adversely affected by

his stop work request.

1 O. Again, proceed with the change only after 
all the proper paperwork has been pro
cessed or your company instructs you to go 
ahead. 

Changes Paid by General Contractor 

Until now only change orders between the 

general contractor and the owner have been 

discussed. What about changes requested by 

the sub contractor directed to the general? How 

and why do these changes occur and what can 

we as the superintendents do about them? 

A good deal of change order requests happen 

because of the preparation of the contracts 

between the general and the subs. The sub 

contractor may delete a certain portion of the 

work and the general contractors estimators do 

not cover that portion of it with another sub. 

Estimator Error Example 

An example may be that the plumber excludes 

all insulation from his contract obligations and 

the general contractors estimator agrees. The 

generals estimator assumes that the insulation 

sub contractor will pick it up or overlooks it. 

However, the plumbing specs show insulating 

all hot water pipes. The plumber says he 

excluded it and the insulator says it is not in his 

scope of work. Unfortunately they are both 

right and the general contractor may well end 

up paying for this mistake. Remember the 

LTP/3 - Change Orders 

phrase "Risk Management", this is what its all 

about. 

Superintendents Input 

The superintendents can be of help in this 

situation. The project has been awarded to the 

general contractor and the superintendent is 

reviewing the plans, specs and contracts of the 

subs. 

A. The superintendents may pick up on this

discrepancy before the job starts. It is usually

cheaper to ask for estimates from several subs,

ahead of time, than to wait until the task has

become critical. This will not save all the

money but it can save some and will certainly

save some confusion and time later in the

project.

B. Investigate the possibility of performing the

work with the general contractors own crew.

Compare these costs with those of the subs. The

general contractors project manager and

superintendents can now make an informed

decision.

Invalid Change Orders 

"But I didn't include that portion of the work in 

my estimate so it's not fair to ask me to do it. 

That is why I was cheaper than anyone else." 

As a superintendents you are going to hear a 

version of that story many times from your sub 

contractors. Because the sub contractors 

estimator left out a portion of the work in his 

estimate does not mean the general contractor 

is going to pay for that mistake. 

Another story is, "Framing contractors never 

provide red-iron buckets for glue-lams." 

Because the framer did not read his specs 

carefully does not mean the general contractor 

is going to pay for their error. Because the 

framing contractor does not normally provide 

red-iron buckets for the glue-lams doesn't 

mean it's not the framers responsibility on this 

project. In today's construction contracting 

there is no place for assumptions based on past 
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practices. Remember, carefully review all subs 

change order requests against the plans, specs 

and contracts. 

these changes and add a percentage of profit 

and possibly a request for additional time and 

increased money for general conditions. 

Change orders will not make a great deal of 

money for the general contractor neither should 

the contractor suffer because they occur. 

Fortunately all is not lost. Most change orders 

requested by subs will be legitimate and will be 

caused by circumstances that are chargeable to 

the owner. The general contractor will process 

3-6 

I was working in Oregon as a carpenter on a project remodeling a dental laboratory. 
We had removed the lab equipment and replaced a wall between two labs. There had 
been a water leak and over the years most of the studs had become rotten. The 
electricians installed a new control panel in the wall and the drywallers started to 
apply the drywall. When we got to the panel we saw it was six inches deep. It was 
designed for 2x6 walls and we put in 2x4s like the drawings showed. The panel 
stuck out two inches, so I asked the superintendent what I should do. The 
superintendent told me to fur out an area around the panel and that would take care 
of the problem. I did as the superintendent asked me, the sheetrock was completed 
and everything looked good. About two weeks later the lab equipment, full-length 
stone countertops, was to be reinstalled. However, we ran into a problem when we 
tried to fit the tops back in. The furring around the electrical panel prevented the top 
from fitting in the room. The superintendent submitted a Change Order Proposal to 
change the countertop so it would fit around the panel. The architect denied the 
request and the general contractor had to foot the bill for all alterations. 

Questions? 

1. Why did the architect reject the Change Order Proposal request?
2. What procedure did the superintendent fail to follow?

L TP /3 - Change Orders 
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CHANGE ORDER ESTIMATE 

Please list the following: 

1. Name of Job

2. Your name

3. Materials and cost

4. Labor and cost (list hours of labor)

5. Rental or equipment cost

6. Incl_ude time for picking up materials or
eqmpment

7. Subcontractors costs

8. Overhead and profit (12% of total)

GENERAL CONTRACTOR - MATERIALS & LABOR DESCRIPTION 

TOTAL 

SUBCONTRACTORS - COST & DESCRIPTION 

TOTAL 

PROFIT & OVERHEAD TOTAL 

GRAND TOTAL __ _ 

opeiu-3-afl-cio-211/11 
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QUESTIONS 

1. Who is responsible to pay for a change order?

2. What is a Field Work Authorization? What guarantee of payment does it carry?

3. Why are change orders the sorce for many disagreements in contracting?

Module 3 

4. How can an alert superintendent protect his company from doing work that is not in contract?
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MODULE 4 SUBMITTALS 

THIS MODULE IS PLANNED TO PROVIDE ANSWERS TO THE FOLLOWING QUESTIONS: 

• What is a Submittal?

• What are the Superintendents Responsibilities in the Submittal Process?

• How can the Superintendent use the Submittal as a Tool?

• What different types of Submittals are there?

LEADERSHIP TRAINING PROGRAM 

(LTP) 

The information can be as follows, but this is 

not a complete list of what submittals contain. 

Module Four: Submittals 

Submittals are information about or samples of, 

materials, supplies, equipment, schedules or 

procedures, requested by the owner or architect 

of the general contractor. They are provided by 

the contractor or sub contractor to show 

specific information. Using the information 

provided, the architect will determine if the 

product meets the design intent of the plans and 

specs. Submittals should be reviewed and 

accepted by the architect before the 

superintendent allows the installation of 

whatever the product or procedure is. 

Submittals can be one paragraph on a sheet of 

paper describing the physical properties of a 

drywall board. They can be elaborate shop 

drawings showing all the steel columns and 

beams in a high-rise. They can also be a sample 

of the product or a mock up showing the quality 

of work required to install the product. The 

contract documents may require an overall 

schedule of the project be submitted and 

updated monthly. The superintendent should 

review the submittal information and check it 

against the plans and specifcations. 

LTP/4 - Submittals 

1. 

2 

3. 

Physical Dimensions 

a. Pipe size and gauge

b. Column shape and height

C. H. V.A. C. unit, length x height

Weight 

a. Lbs per foot

b. Total shipping weight

C. Installed Weight

d. Weight empty or full

Color or Finish 

a. Painted, primed or bare

b. Plated, anodized, bronzed, etc.

C. Texture

d. Smooth, rough, glossy, matte, etc.

4. Type of Material

a. Steel, wood, plastic, concrete, etc.

5. Material Grade

a. Rebar-40 or 60 grade

b. Wood- #1, Select Structural,
Commercial, etc.
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C. Concrete- Mix design, P.S.l., aggregate b. Sound rating, volume
size

C. Flame spread
6. Product Features

d. Stain resistance
a. lugs, switches, controls

e. Wear ability
b. Drains, faucets

10. Construction Details
C. Screens, filters

a. Type of connections
d. Connections, tie downs, vibration

1. Bolt sizesdampers

e. Water proof or water resistant
2. Hanger type

7. Strength or Carrying Capacity 3. Weld type, size

a. Modulus of elasticity b. Layout information. templates

b. Rated resistance to breaking, ability to 11. Product Samples

support a. Paint brush-outs

C. Total gallons, yards, square feet, etc. b. Brick or tile sample

8. Requirements to Operate
C. Laminate or glass samples

a. Wattage, amperage, voltage d. Stucco mock up

b. Water, coolant, oil, fuel 12. Manufacturers Literature

C. Temperature ranges a. Installation instructions

d. Exposed or unexposed b. Maintenance requirements

9. Special Properties
C. Product guarantee

a. R-Factor

4-2 LTP/4 - Submittals 
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This Happened to Me 

We were building a school in Hollister California. The construction was about 

eighty percent done. The tile subcontractor has finished in the bathrooms and the 

plumber was installing fixtures. My schedule showed the partitions going in next, 

so I called the subcontractor who was to install them. I wanted to give him a warn

ing he was supposed to start the installation the following week. He said he would 

check his paperwork, as he had not heard from me for over a year. When he called 

back he asked me if I wanted the submittals sent to the main office or the job site. 

Immediately I knew I was in trouble. The submittal process takes two to three 

weeks. Next there is field measurement, manufacture time and then shipping and 

installation. The partitions were supposed to be installed in one week and I was 

looking at a process that would take at lest six or seven weeks. 

Questions? 

1. How could I have prevented this problem?

2. Whose fault was this?

The superintendent must read the contract 

documents and review what is required for each 

submittal asked for. The spec section that is 

applicable to the product will list the 

requirements necessary. Under a separate 

submittal spec section there may be a 

description of the process. The superintendent 

must keep an eye on his schedule and insure 

that enough time exists for the submittal 

process to be completed and reviewed before 

the schedule is impacted. 

He must also stay in touch with the sub 

contractors that have late starts in the project 

and see that they do not wait until the last 

moment to submit. 

Specs and plans may provide information of 

what the product must do or withstand, what 

type it is and even acceptable manufacturers. 

LTP/4 - Submittals 

For Example 

On the UBC Elementary School job the spec 

section O 1340 details the owners requirements 

for submittals. The owner has requirements for 

product data, product samples and 

miscellaneous submittals. These different 

elements are defined and examples of each are 

listed. Next the 01340 spec section outlines all 

procedures to follow when preparing and 

transmitting submittals to the owner through 

the architect. 

You are looking at the schedule for the job you 

recently started and see you had better insure 

submittals for the glue lams are submitted. 

Before you call the sub who is supplying them 

look at the glu lam section of the blue 

specifications book. Before you and the 

supplier will allow the glu lams to be built you 

will want to comply with the following 

requirements for submittals. 
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SECTION 06170 - GLUED LAMINATED STRUCTURAL UNITS 

7 SUBMITTALS: 

8 

9 Probuct Data: Submit manufacturers data, specifications and installation 

10 instructions covering lumber, adhesives, fabrication process, preservative 

11 treatment, accessories and protection. 

12 

13 Submit certification, signed by an officer of the manufacturing firm, indicating 

14 glued laminated timbers comply with requirements of PS 56. 

15 

16 Shop Drawings: Submit shop drawings showing full dimensions of each 

17 member and layout of entire structural system. Show large scale details of 

18 connections, connectors and other accessories. Indicate species and stress 

19 grade of lumber, type of glue and other variables in required work. 

20 

21 Submit certification by treating plant that required treatments comply, etc. 

22 

23 Shop drawings to be stamped by a structural engineer licenced to practice in 

24 the state where the units are fabricated 

Module 4 

Where the contract documents call out for a 

specific submittal the supplier will go to the 

manufacturer. The manufacturer will supply 

the product data sheets. These data sheets are 

reviewed by the architect and accepted or 

disapproved for general compliance with the 

plans. The architect may ask for more 

information than is provided by the data sheets. 

In this case the supplier may have to return to 

the manufacturer for more technical data. 

number called out for in the contract 

documents. When the architect accepts the 

brush-outs, he and the owner, the general 

contractor and the sub contractor all receive an 

accepted copy of them. After the paint is 

applied, if there is any question about the color, 

all concerned can take their accepted copy and 

compare it with the painted surface. 

Submittals can also be a sample of the product 

to be used. This can be a paint brush-out, a 

small section of brick wall, a Formica sample 

or a piece of tile. If the painter supplies paint 

brush-outs, he will provide the specified 

4-4

The superintendent should read or review the 

submittals and check for compliance with the 

plans and specs. Todays' plans may be prepared 

by several different persons, all specialists in 

their own particular fields. The electrical 

engineer may accept a distribution panel 

because it fits his design needs. He may be 
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unaware that his six inch thick panel must fit in 

a four inch wall. If the superintendent can find 

problems like this in advance, he or she can 

save time and trouble later during the course of 

construction. 

Submittals can also alert the superintendent to 

sequence of construction. If the H. V .A. C unit is 

too large to fit through standard door openings 

and it is to be installed in the basement, 

provisions must be made in the schedule to 

accommodate placing this unit. Coordination 

between all sub contractors involved with this 

is essential. 

After reading and or reviewing accepted 

submittals, the superintendent should file these 

away in the sub contractors file who submitted 

them. When the product is delivered check to 

see it is exactly as is represented in the 

submittal. This means the same brand name, 

model number, features, color, etc. 

Submittal reviews by the architect do not 

relieve the contractor of his obligation to insure 

the product performs to the requirements of the 

contract documents. Carefully read the stamp 

the architect places on the submittal. It usually 

says the architect has reviewed the document 

for general compliance with the plans. In the 

case of shop drawings the sub contractor may 

list a column as being ten feet, eleven inches 

and build it accordingly. When the column is 

ready to be installed it is discovered that its 

correct height is eleven feet, ten inches. A 

check of the plans show the column should in 

fact be eleven feet, ten inches tall. The sub 

contractor is likely to complain that the 

architect accepted the shop drawings so the 

architect is responsible for the mistake. This is 

not the case. The architect will review the shop 

drawings to check on the grade of steel, the 

LTP/4 - Submittals 

Submittals 

weld types, the column pipe dimension, but not 

the height. The column must be as described in 

the plans. 

In some Contract Documents other types of 

submittals are asked for. These can be a 

schedule of values for the purpose of billing for 

the work completed by the Contractor. A 

schedule of the contractors work or a request to 

deviate from the schedule provided with the 

contract documents may be requested as a 

submittal. On a large project, an architect may 

even ask for a schedule of the submittals to be 

submitted. 

Contractors Review Stamp 

This submittal has been reviewed for general 

compliance with Contract Documents. No 

acceptance of substitutions or deviations from 

the specifications is given or implied by this 

review unless substitutions or deviations are 

specifically highlighted in the submittal. Their 

review does not relieve the Contractor of any 

contractual obligations nor authorize any 

changes to the Scope of Work. 

Architects Review Stamp 

Architects review is for general conformance 

with the design concept and contract 

documents. Markings or comments shall not be 

construed as relieving the Contractor from 

compliance with the project plans and 

specifications nor departures therefrom. The 

Contractor remains responsible for details and 

accuracy, for confirming and correlating all 

quantities and dimensions for selecting 

fabrication processes, for techniques of 

assembly, and for performing his work in a safe 

manner. 

4-5



Submittals Module 4 

4-6

This Happened to Me 

I was the superintendent on a project in Morgan Hill building a retail shopping 
center. We had completed the framing and the window company arrived on site. 
They installed the frames and were preparing for the tempered glass delivery. The 
next day a semi pulled up with sixty thousand dollars worth of glass on it. The 
installers unloaded the rig and placed the first sheet of glass in a window frame 
when the building inspector for Morgan Hill stopped by for a routine plumbing 
inspection. He took one look at the installed glass and came over to me. "You have 
a problem here", he informed me. "The architectural review board in Morgan Hill 
has stipulated that all exterior glass in commercial structures is to be bronzed. The 
glass being installed is obviously clear." I talked to the glass sub contractor and told 
him of the problem. He said he would review his paperwork and get back to me in 
the morning. The next day we met at the job site with the inspector and the architect. 
The glass sub contractor brought in his set of submittals with the architectural 
review stamps on them. "Look at this, the architect approved these and they say 
right here that we are supplying clear glass. The architect approved them so he is 
responsible for the mistake." Next I checked with the inspector about the glass color 
and he showed me the cover page of our blueprints. Sure as heck there was a 
sentence written by the plan reviewers from the City of Morgan Hill. It said that all 
exterior glass was to be bronzed. 
It goes without saying that the architect refused to accept any responsibility and he 
blamed the glass supplier. The architect said, "I think you had better read the 
wording of the review stamp I put on that submittal. This is clearly the fault of the 
glass supplier and I want him to install the bronze glass at no extra cost. If there is 
any delay associated with this glass misorder the glass supplier will pay for it". 

Questions? 

1. What did the stamp say?

2. Who do you think paid to replace the clear glass with bronzed glass?

3. What could the superintendent do to prevent this type of problem in the future?
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MODULE 5 THE SCHEDULE 

THIS MODULE IS PLANNED TO PROVIDE ANSWERS TO THE FOLLOWING QUESTIONS 

• How to identify and interpret different types of schedules.

• How to Administer the schedule.

• How to understand the basic requirements of building a successful schedule.

• How to solve schedule conflicts and use the schedule as a tool.

INTRODUCTION TO THE SCHEDULE 

The Schedule, by pure definition, is an overall 

timetable for all the coordinated activities that 

occur in a particular order during the 

construction of a particular project. 

Perhaps one of your most important tasks as a 

superintendent is the building and maintaining 

of the schedule. In today's construction 

industry, the schedule has become a legal 

document that can cause change orders, back 

charges, liquidated damages, etc. It is the 

overall guide to the sequence for the 

construction of the project. It allows all 

involved to plan when materials, personnel, 

equipment, supplies, etc. should arrive at the 

job site. Companies are able to forecast when 

money will be paid to them and funding 

agencies are able to ascertain when money will 

be disbursed. 

A poorly designed or poorly maintained 

schedule can and will wreak havoc with 

owners, suppliers, general and subcontractors. 

Certain conditions must exist in each schedule 

for it to be successful. 

These conditions are as follows: 

.005 - The Schedule 

COMPONENTS OF THE SCHEDULE 

1. There must be a reasonable amount of time
allotted to complete the entire job.

2. Each sub-contractor must be given a rea
sonable amount of time to complete a par
ticular task:

• The sub-contractor should expect to be

able to maintain a steady manageable

crew.

• Subs must be given sufficient time to

order materials, tools, equipment, etc.

3. There must be a logical sequence of events
planned:

• Site survey first, layout, excavation,

re bar, etc. all follow one another.

• Certain tasks can be performed

concurrent with each other.

• Electricians may work alongside

carpenters and plumbers for example.

• One trade is working on north end of

building while another is working on

south end and vice versa.

4. Schedules should include the following:

• Start and completion dates for all tasks
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• Delivery dates of F.O.B. items

• Field measure dates for long lead items

• Allotted time for required inspections?

• Milestones:

• Framing complete

• Rough in plumbing complete etc.

5. Index of abbreviations

• Name and address of project?

• Owner of project?

• Start date and completion date?

• General contractors name

6. Dates schedule compiled and updated

7. Critical path should not exceed twenty five
percent of tasks.

TYPES OF SCHEDULES AND TIMETABLES 

IN CONSTRUCTION 

Bar Chart 

There are several different formats for 

schedules. The Bar Chart is perhaps the one 

most familiar to everyone. At a glance you 

should be able to tell when each particular task 

is going to take place. With the schedule 

graphed out on a calendar scale, start and 

completion dates are easily understandable. A 

Bar Chart can also display a time line. That is 

simply a line through the chart showing a 

particular date. Using information provided 

from daily diaries you should be able to 

determine if the project is on schedule, behind 

or ahead, as of that date. 

Refer to the Bar Chart provided to see how 

simple schedules can be displayed. Note what 

information can be displayed and what 

information cannot. 

5-2

Critical Path Chart (Critical Path Method 

CPM) 

A Critical Path Chart shows the logic involved 

in going from one task to another and how each 

task relates to others in the schedule. These 

Critical Path charts can carry a great deal of 

information. They may show earliest projected 

start and completion dates, latest possible start 

and completion dates, the resource (contractor) 

involved, slack time, task duration and actual 

finish dates. These schedules can also be cost 

loaded for ease of billing purposes or 

projecting income. Today most Critical Path 

charts are prepared with the aid of a computer. 

This allows the operator to quickly amend or 

update the schedule as conditions warrant. The 

schedule can also be changed from the Critical 

Path to the Bar Chart at the flick of a switch. 

All the same information will be displayed, 

only it will be in a different format. 

The Critical Path Method or CPM schedule is 

so named because it shows the path of task 

completion critical to the completion of the 

project in the allotted time. If you look at the 

simple Critical Path chart provided, you will 

see a dark line running from task to task. This 

dark line represents the Critical Path. Tasks on 

this line must be completed within the task 

duration displayed or they will push the 

completion date back by the amount of time 

they are delayed. Tasks not on this dark line 

can be delayed by the amount of time shown as 

slack before they impact the completion date. 

If you do not have more than twenty-five 

percent of your tasks on the Critical Path you 

may have the ability to shift resources to 

another area while waiting for the delayed task 

to catch up. 

Rolling Schedule 

A two or three week Rolling Schedule is a 

handy tool for the superintendent to use for the 

LTP/1 - Superintendent Responsibilities 
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short term management of his job. It allows the 

superintendent to break down the main 

schedule into more specific tasks. The main 

schedule might show two weeks to lay masonry 

block. The rolling schedule may show four 

days on the south wall, three days on the east 

wall, etc. Being able to determine that the 

south wall will be ready six days earlier than 

the task as a whole can allow the 

superintendent to assign men to a job on the 

south wall earlier than the main schedule 

indicates the overall task will be complete. It 

also allows the superintendent to closely 

monitor manpower, equipment and material 

needs on a two week basis. 

The superintendent can take this one step 

further if he feels the masons are not staffing 

the job with enough men. The superintendent 

can simply ask the foreman how many masons 

will be on site during those days indicated on 

the Rolling Schedule. The foreman says there 

will be eight block masons. The superintendent 

knows a mason should be able to lay two 

hundred blocks a day. Simple math reveals that 

the masonry crew will lay sixteen hundred 

blocks a day. The south wall requires eight 

thousand blocks. That will leave them sixteen 

hundred blocks short at the end of four days. At 

this point the superintendent can ask the 

masonry foreman to increase his crew size to 

ten men so that the schedule can be met. 

BUILDING THE SCHEDULE 

If you are going to build the schedule there are 

several ways to approach it. You can start at 

the first day on the job and assign time to each 

sub-contractor. Add up the time and hope it 

does not exceed the limit. You can try the 

reverse by starting at the end of the job and 

work the other way. 

.005 - The Schedule 

1. Re�iew time allotted to complete entire
proJect.

2. Pr_oduce a schedule based on what you
thmk are reasonable amounts of time for 
each subcontractor task. 

3. Have a pre-construction meeting with the
sub-contractors and review the schedule.
Ask for input concerning task length, man
power needs, coordination and experience
from similar jobs.

4. Adjust the schedule as required but do not
exceed the time allotted for entire project

5. When the schedule is completed see that
each sub-contractor receives a copy of it

6. Have each sub-contractor sign a form that
they agree with the task completion length
of their trade

An important part of preparing the schedule 

will be the pre-construction meeting. Maintain 

a positive and upbeat attitude. Have an agenda 

prepared and any forms necessary on hand. Try 

to get the sub-contractors to buy into making a 

profit by maintaining the schedule. The sub

contractors will have a chance to coordinate 

with each other how they will work together. 

They will also have valuable input to offer to 

the general contractor. They will be trying to 

plan their tasks so as to be the most efficient 

and profitable. Ask each sub-contractor to 

show how he will man the job. Take notes and 

be prepared to use these notes in the 

administration of the schedule. A good 

superintendent will take this information and 

incorporate it into a realistic and equitable 

schedule. 

A schedule is formed for the purpose of 

planning ahead. The superintendent should be 

in touch with each sub-contractor or supplier 

two weeks before he is scheduled to arrive on 

site. Remind them of start dates and task 

lengths. Inquire if all of their materials, 

supplies, manpower and equipment are ready. 

Call your sub-contractors suppliers and check 
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with them if you have any doubts. Call again 

two days before the sub-contractor is due. 

Remember; Use the schedule to plan ahead. 

During construction stay aware of job progress 

on a daily basis. Keep your daily diary current. 

Try to make sub-contractors aware of slips in 

the schedule before it is too late to catch up. 

Work with your sub-contractors for a 

successful project. Try to go over with each 

subcontractor his own two week schedule. For 

complicated projects plan weekly sub

contractor coordination meetings. 

Schedules are projected outlines for what you 

plan will occur. They are not cast in stone. 

There will always be some delays, some 

changes and there will be some sub-contractors 

that finish early. As the general contractor you 

have the right to amend the schedule. Let your 

sub-contractors know as far in advance as 

possible of any changes in the schedule. Allow 

them the same task length but alter the arrival 

date as need be. 

Delays that are caused by architects, owners, 

sub-contractors or unforeseen conditions must 

be documented. Costs incurred by such delays 

must be paid by those who cause them. If your 

schedule shows the concrete sub-contractor 

pouring the slab on Monday, everything is 

ready for him and he does not show up, the 

general contractor has lost that days overhead. 

You will be forced to reschedule work that was 

to follow pouring the slab. If this delay forces 

the block mason to arrive later than he had 

planned, he may have to reschedule his 

manpower to work on a small project that will 

take three days to complete. Now the general 

contractor has lost a total of three days due to 
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the failure of the concrete contractor to perform 

as required. In addition to lost overhead, there 

may be liquidated damages incurred. It is 

possible the concrete contractor can be held 

liable for these damages. That is why it is so 

important to document all delays. 

Occasionally your sub-contractors will finish 

tasks ahead of schedule. The superintendent is 

now faced with a delicate situation. The 

schedule may show the next contractor to 

follow the early completing sub-contractor not 

due to arrive until the following week. The 

general contractor does not want his job to sit 

idle for a week nor does he want the sub

contractor to charge for accelerating the 

schedule. The superintendent who has been 

tracking the daily progress of his job and 

comparing this information with that displayed 

on the overall schedule, will know in advance 

that there will be an early completion of a task. 

This may give the superintendent enough 

advance notice to let the next sub-contractor 

change his schedule without it becoming a 

hardship. 

The sub-contractor may well be within his 

rights to arrive on site as originally required by 

the original schedule, so a good superintendent 

will word his request for an early arrival 

carefully. The superintendent might say he is 

giving the next sub-contractor an opportunity 

to arrive early and get a jump on his work so 

that he might complete his task before a billing 

cycle ends. If the sub-contractor arrives and 

starts early he will still be required to complete 

his task in the length of time originally allotted. 
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Good work, but I think we need a little more detail right here . 

. 005 - The Schedule 

The Schedule 

5 



The Schedule Module 5 

NOTES: 

6 .005 - The Schedule 



Module 5 

PARTICIPANT ACTIVITY 

In groups of four to five, build working 

schedules of a fictional job involving the 

remodel of a school administration building. 

The job is supposed to be completed in six 

months. It consists of the demolition of six 

existing offices, adding a glassed in 

lunchroom-meeting area for the faculty and 

two new restrooms. I will create a delay in each 

workgroups schedule, use your imagination 

and experience to solve these schedule 

problems. Select a spokesperson from each 

group to review your results with the other 

participants . 

. 005 - The Schedule 

The Schedule 

Incorporate the following in your schedule 

1. List start and finish dates for project and in
dividual tasks

2. Show a logical progression from start to
finish

3. Show milestones

4. Note which tasks must be complete before
other trades can follow

5. Work must take place 8 hours a day, 5 days
a week
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MODULE 6 MANAGING THE CONTRACTORS LABOR FORCE 

THIS MODULE IS PLANNED TO PROVIDE ANSWERS TO THE FOLLOWING QUESTIONS: 

•

• 

Understand where the contractor can increase the profit margin on control of direct labor

Discuss different methods of motivation 

• Recognize communication breakdowns

• Prevent problems in manpower resulting in construction mistakes

MANAGING THE CONTRACTOR'S 

LABOR FORCE 

The superintendent is charged with one of the 

most important duties on the jobsite. That duty 

is managing the companys' workforce. These 

tradesmen and women are the ones that 

produce the installed work the company has bid 

on. An estimator has reviewed a set of contract 

documents and figured that a certain amount of 

work can be done for a particular price. The 

estimator has added a figure to the cost to cover 

overhead and profit. That profit can only be met 

if the labor costs do not exceed the estimate. 

THE SUPERINTENDENTS CONTROL OF 

DIRECT LABOR BY CORRECT 

MANAGEMENT WILL RESULT IN THE 

HIGHEST POSSIBLE PROFIT FOR THE 

GENERAL CONTRACTOR. 

The general contractor you work for has 

submitted the low bid for the New School 

Project. Now picture yourself running that job. 

Your company is going to form and pour the 

concrete footings, foundations and columns. 

The company is also going to frame the 

buildings and provide carpenters for the finish 

LTP/6 - Managing The Contractor's Labor Force 

work. You are going to have to plan how that 

work is going to proceed. 

What work has to start first? 

1. Who will perform it?

2. How many people are necessary?

3. What materials do they need?

4. When do they need the materials?

5. What tools do they need?

6. What equipment do they need?

7. Are there other trades work that must be co-
ordinated with this work?

The largest general contractors cost that is not 

fixed is the cost of direct labor. Direct labor is 

the crew that is employed by your own 

company, not the sub-contractors labor force. 

Remember, the projected cost for the direct 

labor is an estimate. The actual cost will be 

what you can accomplish by planning the use 

of the contractors labor force. If the concrete 

delivery is late, or a broken skilsaw stops 

production, the labor costs will increase. If a 

door was installed incorrectly and a carpenter 

has to go back, tear it out and reinstall it 

correctly, the cost of labor will increase. It is 

now is your responsibility to plan how to use 
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the crew to perform the work at the least cost to 

the general contractor. 

The general contractors costs for 

subcontractors, materials and overhead are 

largely fixed. These are costs that the 

contractor cannot control. Keep in mind 

however, that effects of the actions of the subs 

can cause peripheral costs to the contractor. If a 

glu-lam delivery is late and your crew winds up 

standing around, your labor costs are going to 

increase. 

Prime Time 

Statistically, one third of your labor cost is 

spent installing work correctly the first time. 

Lets refer to this as Prime Time. 

Secondary Time 

One third of your labor cost is spent in 

Secondary Time. This is time spent in 

preparing to work. Some examples of this are 

laying out tools and equipment, moving 

materials to point of installation, reviewing 

plans, preparing job assignments, framing 

layout, building sawhorses, etc. 

Lost Time 

Finally we come to Lost Time. Poor quality 

work or wrongly installed work, time wasted 

on the wrong or broken tools, material delays, 

or extended punch lists are some of the items 

involved. Our greatest savings will be realized 

if we can cut back on Lost Time. 

Job Profits 

To increase job profits, the superintendent 

wants to move as much time as possible into 

Prime Time. 

Our greatest potential for profit will lay in 

moving time from Lost Time to Prime Time. 

6-2

This means we must learn to prevent mistakes. 

Insuring good communications is the most 

important single item that will prevent 

mistakes. All carpenters will make an 

occasional error. But mistakes by a single 

workman will not have the same impact as an 

entire crew following confused directions. Poor 

communications between management and the 

labor force can result in entire walls or forms 

being built incorrectly. Those walls that are 

built incorrectly must be torn down and rebuilt 

correctly. That could cost four or five times 

what it should have cost. 

Smart planning can cut Secondary Time and 

keep it to a minimum. One such saving might 

be to use an apprentice to lay out saws and 

cords before the journeymen arrive on site. 

Smart planning means off-loading materials in 

the area they are needed when they are 

delivered. When you order material from a 

lumber yard do you request that the lumber 

order is loaded on the truck in a logical 

manner? For example, the materials that are 

needed first should be loaded on the top of the 

truck. Most materials are moved an average of 

six times before they are installed. Proper 

scheduling to insure materials arrive when they 

are needed or logically placed staging areas 

will save time here. Most of Secondary Time is 

fixed though, so you will not garner a large 

savings here. 

The superintendent must break down the 

overall job schedule into weekly segments. 

Use the Rolling Schedule form for this task. 

The foreman should have this weekly schedule 

broken into daily assignments. He must be 

certain the proper tools will be at hand. He 

must assign the proper man for the job. The 

size of the crew must be considered. This kind 

of planning must be utilized for a truly 

successful project. 
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The following will help to understand just how 

much money can be saved by direct control of 

labor and how those costs affect the profit 

margin. The figures represent the cost to build 

a large wood framed building. Labor costs play 

MANAGING THE CONTRACTORS LABOR FORCE 

a big factor so moving time from Secondary 

and Lost Time into Prime Time will increase 

potential profits tremendously. Remember that 

the total profit on a large job is rarely bid at 

more than five percent of the total contract. 

JOB COST BREAKDOWN 

Total Contract $2,000,000 

Subcontracts $1,050,000 

Materials $ 150,000 

Labor Costs $ 600,000 

Profit 5% $ l 00,000 

Overhead 5% $ l 00,000 

As you see, the labor cost is $600,000.00. If we divide this into three equal parts 
each phase of labor is worth $200,000. 

If you can save l 0% of Secondary Time 

If you can save 25% of Lost Time 

$ 20,000 

$50,000 

$ 70,000 

$100,000 

$170,000 

Total Savings 

Add Total Savings to Profit 

New Total Profit 

If you look at these figures you will see we 

increased profit by 70% more than the original 

amount. Remember we cannot save much on 

fixed costs, but we can certainly learn to 

manage our direct labor profitably. 

Most workmen want to do a good job. They 

take pride in their work. How many times have 

you driven around town showing off projects 

you worked on to members of your family or 

friends? Members don't like to see their time 

being wasted. Standing around on the job site 

without having a specific task to perform 

makes the day drag on. Try asking your crew 

members how they think a certain task might be 

more efficiently performed. Listen to their 

input and try to incorporate some of their ideas. 

LTP/6 - Managing The Contractor's Labor Force 

Involving workmen in management decisions 

means they contribute more than just their 

labor. When workers feel they are an important 

part of the project their interest in it increases. 

It is no longer just a job to them. Their ideas 

might mean higher profits. Higher profits can 

mean continued work and increased wages. 

A good superintendent will create an 

atmosphere of good will and teamwork. An 

occasional pat on the back will go a long way. 

Try addressing your workmen by their last 

name to show that you have respect for them. 

Set realistic goals for your crews to achieve. 

When they do achieve the goals reward them. 

A twenty dollar pizza on Friday is certainly 
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worth the increased output of a team of 

motivated carpenters. 

PREVENTING MISTAKES 

Perhaps the easiest method for preventing 

mistakes is to insure that good communications 

exist between yourself and your workmen. 

This may involve a morning job site meeting 

with the crew. At this time you might review 

the days objectives, assign tasks to individual 

carpenters and laborers and discuss what is 

expected of each person. 

It is easy to say that you want Tim, Lou and 

Phil to frame the walls shown in the plans on 

page A2.3. The hard part is insuring that each 

carpenter is familiar with all the construction 

details. There may be a note in the Structural 

section that states headers for openings over 72 

inches will be 6 xlOs. Are you sure all the 

carpenters are aware of this? There may be a 

detail on yet another page that shows how 

framing clips are to be used at different 

openings. Does each carpenter have a copy of 

the Simpson catalogue that shows how each 

piece of hardware is used and how the 

manufacturer specifies it is to be attached? 

Your different carpenters are not going to be as 

familiar with the plans as you are. There is a 

method that can be used to insure that framing 

details are available to those that will be 

incorporating them. 

A good superintendent or foreman will clip out 

all necessary details and compile them on a 

clipboard for those that will need them. For 

example, the carpenters building the wall on 

A2.3 should receive a clipboard containing all 

the details from structural showing framing 
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clips, lumber dimensions, hold downs, nail 

spacing, bolts etc. Architectural details should 

show length and height of walls, blocking 

locations, openings etc. The point is that the 

carpenters should not have to search through 

the plans and specs to find all the references to 

the walls, that is your job. 

Compile this information, enlarge the details if 

necessary, and present it in a easy to read 

format. You have probably spent a great deal 

of time becoming familiar with the plans. 

Share this knowledge with those that need it. 

You will find that there will be less rework if 

this method is followed. 

In the coming years the labor pool the 

contractor will draw from is going to change 

dramatically. Look for more women and more 

minorities on the job site. This can mean 

changing the way you are used to working. 

Language difficulties may arise or a Port-o

John for the women on the job may be required. 

Improved products and methods of application 

may mean more technologically advanced 

tools and workers with experience or training 

using those tools are needed. 

All of the previous goes to show that Lost Time 

is usually a management caused problem, not 

something to blame on poor labor. Ask 

yourself what you could have done differently 

to prevent a mistake that caused extra work. If 

there is something you could have done to 

prevent the problem, write down instructions 

instead of yelling them up to someone on the 

second floor, then you are responsible for the 

mistake .. 
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This Happened to Me 

There I was, my first day on the job, working on a ten foot folding ladder in the 
hallway of the new school. The hallway was busy with other carpenters and 
subcontractors all doing their respective jobs. I was nailing up hangers for the 
ceiling joists, for about an hour, with TECO nails when I reached into my pouch and 
found I had run out of nails. Damn, I had to walk down the hall, down the stairs, 
across the field and into the tool shed. I filled up my pouch with the nails, took some 
extras in a sack and headed back to my previous activity. I walked back across the 
field, up the stairs and down the hall to the ladder. 

WAIT A MINUTE! WHERE THE HELL IS MY LADDER? 

While I was gone someone came by and took my ladder, my extension cord and my 
saw. How was I supposed to get my work done? I spent the next half-hour 
searching the different buildings for my missing equipment. Of course the 
carpenter foreman found me wandering the site and immediately jumped on my 
case. "Why aren't you done nailing off the hangers? I gave you a simple little task 
and you can't get it done. If this is the way you work I don't know if we can use 
you around here". My explanation fell on deaf ears and as a result I did not make a 
good impression with that outfit. 

Questions? 

1. Whose fault was it that the equipment was taken elsewhere?

2. What could have been done to prevent this from happening?
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GROUP ACTIVITY PROBLEMS 

1. Your company is building a large wood frame building with many different details at varying
wall locations. For blocking, these include locations, heights, material sizes and methods of
attachment. List three ways you can prevent trades persons from making costly errors

2. Discuss among your work group 2 or 3 jobs you were on that had one problem after another
with the superintendent communicating with the work force. If you were running that job what
would you do different from that superintendent?

3. As superintendent on a ground up project away from home, involving 6 different buildings with
a large amount of concrete forming you are ready to hire your carpentry crew. With your group,
discuss and decide what the five most important attributes you would look for in your fore per
son, carpenters and apprentices.

4. After working as a carpenter and carpenter fore person for 7 years your company has promoted
you to superintendent. On your first job your crew consists of trades persons you have worked
with for those seven years. Is this an advantage or a drawback? Discuss why and list several
reasons for both sides of the question.
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Module 7 The Daily Diary 

THIS MODULE IS PLANNED TO PROVIDE ANSWERS TO THE FOLLOWING QUESTIONS 

• Understand the importance of keeping a Daily Diary

• Know what should be entered into the Daily Diary

• Remember methods for making record keeping easy

• Recognize the different components of the Daily Diary

IMPORTANCE OF THE DAILY DIARY 

The superintendent normally has the responsi

bility of maintaining a daily account of all 

construction activities occurring on the job site. 

Since the General Contractor can potentially be 

held liable for all activities, accidents, delays, 

warranty service and completed project, the su

perintendent must keep accurate, complete and 

up to date records. 

These chronicles might be useful in responding 

to questions from the architect, necessary in a 

formal reply to an owners concern and essential 

in proving the General Contractors integrity in 

a court of law or in arbitration. The superinten

dent must keep in mind that he is working for 

the General Contractor and the records are tak

en from that point of view. 

Who are you writing the Daily Diary for? 

Your company requires you to write an account 

of the days' activities on the job site. The archi

tect normally gets a copy of this information 

along with the project manager, yourself and 

possibly the owner of the project. They all have 

a vested interest in what occurs on your jobsite. 

They all want to check on job progress and 

delays. 

LTP/07 - The Daily Diary 

How this information is presented will impact 

different people in various ways. Suppose an 

architect or owner of a project is reading your 

Daily Diary. If you have grammatical errors or 

spelling mistakes the owner or architects opin

ion of you and your company will be lessened. 

The owner of a $30,000,000 project is not go

ing to be impressed with your intelligence if 

you spell plumber as "plummer". If you are 

hand writing your diaries your penmanship will 

have an impact on the reader. Computer gener

ated diaries with spell and grammar check are 

becoming more common. This can help but 

again your attention to detail will be paramount 

in making a good impression. 

The company you work for and the contract 

documents usually require that you write the 

Daily Diary. When you write the diary, think of 

who will be reading it and how it will be used. 

If you write the diary for the lawyer you will 

meet in court two years after the fact, you will 

probably have all your bases covered. If the ar

chitect asks you a question about something 

you wrote, it will probably be something that 

you can answer using your memory. The law

yer who asks you a question may want facts 

from two years previous. Your memory will be 

of no use in the courtroom. In the courtroom all 

7-1 



The Daily Diary Module 7 
■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ ■ 

will focused on what is recorded in writing. 

You must write the diaries in such a way that all 

pertinent information is concise, complete and 

correct. 

The Daily Diary may be applied in several 

ways. It can be taken as a single page describ

ing a single episode or utilized as a daily record 

of events from day one to job completion. 

Most companies provide a form for the super

intendent to fill out the pertinent data. Filling in 

the blanks on a daily basis will result in the 

most accurate records of events. Most forms 

have blank spaces for the following 

information: 

• Name of job

• Company job number

• Date

• Day of week

• Days remaining to complete contract

• Weather conditions

• Job Delays

• Employees present and their trades

• Sub contractors employees present and

their trades

• Accident report

• Safety report

There will be an area to describe the activities 

of the day performed by both the General Con

tractor and the sub contractors. There may also 

be an area to describe important conversations. 

One of the easiest ways to maintain an accurate 

diary is to write it or keep notes on a daily basis. 

Trying to remember what happened last week 

and writing 5 or 6 diaries in one sitting will re

sult in mistakes that can come back to haunt 

you. 
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Some of the information asked for in the form 

is quite simple and self explanatory. Nonethe

less, the information is important and should 

always be provided. Forgetting to write down 

the date, the name of the job or even the day of 

the week, could cause serious implications if 

the document was called on to settle a dispute 

in an arbitration case. 

Filling in the weather conditions and job delays 

sections may provide backup when asking for 

additional time to be added to the contract. Six 

months later the chances of your remembering 

what the weather conditions were like on a par

ticular day are slim to none. 

1. Just how much detail should you provide

describing the activities of the day?

2. Should you transcribe every phone call

to every sub contractor, architect, owner,

supplier, etc.?

3. Should you name every workman and

describe what he or she did during the

day?

A daily log of the day should describe the activ

ities in such a way as to show what portion of a 

task has been completed. If you are framing a 

building and have, in addition to your own car

penter and laborer crew, plumbers and 

electricians, you should simply describe what 

your employees did, and what the sub-trades 

employees did. 

"Framing on Acme Tools building today," does 

not carry much detail. "Two carpenters shear

ing north exterior wall, 80% complete, six 

carpenters framing interior walls, 25% com

plete, two carpenters installing Glu Lams, 90% 

complete, and one laborer cleaned the slab and 

provided materials for carpenters," will give 

enough information to accurately track the 

tasks described. 

The more detailed log of the days activities will 

allow the project manager to accurately assess 
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the progress of the job. Accurate information 

provided in the Daily Diaries will aid the esti

mator in calculating costs realistically when 

bidding on the next project. 

If your company breaks down the tasks into 

sections such as: 

• 1001 Supervision

• 1002 Layout

• 1003 Wall Framing

• 1004 Blocking

• 1005 Shearing

• 1006 Joisting

you should try to report the activities as they are 

coded in your Job Cost updates. 

SUB CONTRACTORS 

Keeping track of your sub contractors should 

be accomplished in much the same way as 

tracking your own employees. How much of 

each particular task did each sub contractor 

complete? How detailed should the report be? 

Listing the number of employees and their 

trades allows the project management team to 

track manpower and may be used to substanti

ate certified payroll along with time cards. It 

may also be used to settle disputes months or 

even years later as to whether or not the job was 

adequately manned. 

Keeping track of the sub contractors employees 

on site can be used in much the same way as 

tracking the general contractors employees. If 

the sub contractor is not keeping up with the 

schedule and maintains he is doing what he can 

to complete his contract in a timely manner, a 

review of his staffing the project may be in or

der. Remember to mark down the manpower 
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for any sub contractors that are sub contractors 

to your main sub contractors. 

"Plumbers installing pipe in Acme Soda Works 

building." This statement, while true, certainly 

could be expanded to greater detail. "Four 

plumbers installing 2" water line on second 

floor, 10% complete. Existing valves on sec

ond floor were not as depicted in drawings. I 

spoke to Ron, the plumbing foreman, he told 

me that he informed John Doe, his Project 

Manager and an R.F .I. form asking how to pro

ceed was being prepared and would be faxed to 

our office before 10 A.M. tomorrow." This last 

statement will allow you to track what is being 

done, how much is completed and any prob

lems that occurred. 

Recording an important conversation with a 

sub contractor can be very valuable. If you 

have a phone conversation with your Glu Lam 

supplier and he tells you a date they will deliver 

the beams, note the discussion in your Diary. 

See that the supplier gets a copy of the section 

of the Diary that pertains to him. If he dis

agrees with the information you recorded he 

can respond to it. If you rent a forklift to unload 

the beams on the day they were promised and 

they do not show up, the supplier may be held 

liable for damages incurred. 

Remember to document any accidents that a 

sub contractors employee might suffer. Take 

pictures, interview witnesses and note the cir

cumstances that led to the injury. Note this 

information because this information can pos

sibly save the general contractor an expensive 

lawsuit. 
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This Happened to me 

I was working in my yard on Sunday when a man got out of his car, walked up to me 
and asked "Are you Dennis Rose?" When I answered yes he handed me a subpoena 
and informed me I had been served. I was required to appear in court to testify about 
a job that I had run two years previous. A painter was suing the company I had worked 
for, claiming he had become injured when he slipped on some drywall debris in an 
exterior planter area. I was called to the stand by the painters' attorney to answer 
questions about the incident. I had no record of any injuries occurring on that site, so 
I was confused to say the least. I was told the incident happened on a Saturday when 
I wasn't there. I looked up in my Daily Diaries and I did not have anything written for 
that Saturday. I did read something very important though. I had written on the 
Thursday before this incident that the drywall company had completed all installation 
and that the scrappers had cleaned up all debris inside and out 100%. When the lawyer: 
and the judge read this statement they decided the case had no merit and the suit was 
thrown out. This resulted in a saving of $50,000 that the painter was asking for. 

Questions? 

1. What was the important statement that resulted in the case being thrown out?
2. How did I know what to write in the diary that would save the contractor money?
3. Who are Daily Diaries written for?
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TIME SHEET 

JOB NO. ____ JOB NAME PERIOD FROM to 

EMP. # NAME CODE M T w T F s s TOTAL 0/T D/T 

COMMENTS: 

opeiu-3-afl-cio-211 /llr-9/26/96 
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JOB COST - TO - DATE REPORT 

PHASE 
COST 

NUMBER DESCRIPTION TYPE EST COST WEEK MONTH YEAR JOB EST ACT 
REMAINING 

CAT NUMBER 00010 CAT NAME GENERAL CONDITIONS JOB NUMBER 009605 JOB NAME UBC OFFICE SPACES 

001252 SUPERVISION-LABOR L 33600.00 67.50 607.50 769.50 769.50 .00 2.29 32830.50** 

001352 JOB CLEAN-UP- L 2520.00 .00 .00 .00 .00 .00 .00 2520.00 

LABOR 

008002 DOORS & HARD- L 3675.00 .00 .00 .00 .00 .00 .00 3675.00 

WARE 

CAT TOTAL 39795.00 67.50 607.50 769.50 769.50 .00 1.93 39025.50 

CAT NUMBER S 00065 CAT NAME SITE CONCRETE 

002002 DEMOLITION-LABOR L 1207.00 .00 .00 .00 .00 .00 .00 1207.00 

003002 CONCRETE-LABOR L 130.00 .00 .00 .00 .00 .00 .00 130.00 

CAT TOTAL 1337.00 .00 .00 .00 .00 .00 .00 1337.00 

CAT NUMBER 00065 CAT NAME CARPENTRY 

006002 FRAMING - LABOR L 1624.00 .00 104.12 432.23 432.23 .00 26.62 1191.77** 

006003 BLOCKING L 389.00 .00 .00 .00 .00 .00 .00 389.00 

006004 PLYWOOD SHEAR L 3236.00 .00 .00 .00 .00 .00 .00 3236.00 

006005 JOISTS & GLU LAMS L 12285.00 .00 43.02 43.02 43.02 .00 .35 12241.98** 

006006 PLYWOOD ROOF L 1158.00 .00 .00 .00 .00 .00 .00 1158.00 

006007 FORMING L 1140.00 .00 .00 .00 .00 .00 .00 1140.00 

CAT TOTAL 19832.00 .00 147.14 475.25 475.25 .00 2.40 19356.75 

CAT NUMBER 00170 CAT NAME ALLOWANCES 

050005 BURDEN F 45020.00 33.07 524.71 764.86 764.86 .00 1.70 44255.14** 

opeiu-3-afl-cio-211 /llr-9/26/96 
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DAILY DIARY 

JOB NAME: NO: 

DATE: I DAY: REMAINING DA VS: 

WEATHER: I JOB DELAY:

Employees No. Trades Start No. Trades Start No. Rentals/Other Subs Start No. 

Foreman Grading Roofing 

Carpenters 
Storm Glass & 
Drain Glaze 

Laborers Str. Steel Painting 

Cement 
Masonry Plumbing 

Mason 

Opr. 
Drywall Mechanical 

Engineer 

Lath & 
Electrical 

Plaster 

Roof-
Accident Report 

Frame 

Insulation Safety Report 

Office Use 

*START= DATE SUB STARTED ON THIS JOB.
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MODULE 8 JOB CLOSE OUT 

THIS MODULE IS PLANNED TO PROVIDE ANSWERS TO THE FOLLOWING QUESTIONS: 

• Understand what is meant by Job Close Out

• Know when to start the close out process

• Remember methods for making the job go smoothly

• Recognize potential problems and head them off

JOB CLOSE OUT 

Preparing to close out a job is a process that 

starts at the beginning of the project. 

Familiarize yourself with the close out 

procedures, as outlined in the contract 

documents, before the pre-construction 

meeting. Most Bound Project Manuals have a 

section devoted to this subject. Any questions 

that arise may be answered at that time. The 

company you work for may have its' own 

policy, paperwork and procedures. A Quality 

Assurance Plan can be a helpful tool for 

reviewing with all trades what is expected of 

them. Insure that you are familiar with all that 

this entails. "The last ten percent of the work on 

a job takes fifty percent of the total time for the 

job." Unfortunately this statement holds too 

much truth to be lightly discarded. Final 

finishes, carpet, painting, light and plumbing 

fixtures, ceilings, alarms, speciality items etc., 

all have to be coordinated so that each 

individual trade can install without causing 

unexpected delay to the other trades. Each trade 

must also take care not to damage the finish of 

other trades. Have you ever seen a workman 

standing on top of a newly installed cabinet, or 

heard another tradesperson say he or she did 

LTP 8 - Job Close Out 

not care about the painted walls because they 

had their own work to do? 

A common problem is that electrical fixtures, 

although on site, have never been taken out of 

their boxes. The electrician attempts to install 

the fixtures and finds the wrong lenses have 

been shipped or perhaps some of the lenses are 

damaged. With only two weeks left to 

complete the project this can be a real problem. 

A six week lead time for speciality electrical 

items is normal. Items that are shipped to the 

site in boxes should be opened upon arrival and 

checked for damage to contents and 

conformance to specifications. 

Getting your sub contractors to transfer their as 

builts to sepias, turn in guarantees, manuals, 

keys to equipment and extra materials as 

required, should be treated the same way as any 

other task. Have the requirements for close 

outs on the schedule and treat any delay of 

delivery of same as a delay of completion. 

These closeouts are by their nature a item on 

the critical path of completion. 

As your project enters into the completion 

stage, create a list detailing work to be 

completed. Include items that are not correct or 

not to the standard of workmanship required. 

A void calling the list of items to complete a 
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punch list. Tell your sub contractors that these 

items you listed must be completed before the 

architect will inspect for a punch list. Many 

subs will try to tell you they will pick up any 

incomplete items on the architectural punch 

list. Do not accept this as a valid excuse for not 

completing. If all your sub contractors try to 

hand you this excuse you will never get done. 

Do not let the sub contractors reduce the size of 

their man power to a point where each item is 

taking so long to complete that other sub 

contractors are being delayed. Inform your sub 

contractors that incomplete items mean that 

they have not completed their task and cannot 

be paid for it until all items are done. Impress 

upon your sub contractors that if they complete 

correctly they will have no punch list and no 

reason to return to the job site. 

One month before the scheduled completion 

date draw up a completion schedule up and 

have a meeting with all sub contractors still 

having work to complete. Review material and 

equipment delivery dates. Insure that work left 

to be done has adequate manpower allotted. 

Leave time for clean up, owner instruction and 

the dreaded architectural punch list. 

Prepare your sub contractors and the owner for 

the job completion by removing your trailer 

and temporary facilities as soon as possible. 

Move your office into an unused room or work 

out of your truck if possible. Act like the job is 

almost done. Clean the job site and the 

interior. Issue letters to the sub contractors 

making them responsible for keeping the site 

and the interior clean. Do not allow any food 

or drink in the buildings. Lock rooms, if 

possible, and only allow access to the sub 

contractor working in that area at that time. 

Inform the owners of your intent to turn the 

building over to them. Give the owners 

beneficial occupancy only if they are willing to 

accept responsibility for any damage caused by 

8 -2 

Module 8 

moving in or occupying the premises. Put all 

utilities in the owners name as soon as possible. 

See that they know how HV AC, alarm, 

plumbing, electrical, and sprinkler systems 

work. Usually there are specific requirements 

for certain trades to have a training session for 

the owners and their representatives to 

familiarize themselves with the operations and 

maintenance of each system. 

The time has arrived. You think you are 

basically complete and inform the architect and 

owner. A date is set for the final walk through. 

Prepare for this event by having a punch list 

equipment package. This usually will consist 

of some paint and brushes, (Have the painter 

accompany you if possible), WD 40, caulk, 

polish, cleaner, spot remover, rags, assorted 

screwdrivers, wood putty, or other items that 

can be an aid in fixing last minute items that 

come up. 

While accompanying the architect on the walk 

through do not argue over items he or she may 

want to place on the list. You can respond in 

writing at a more appropriate time. A spot on 

the wall, a pencil mark, etc. can be taken care 

of immediately. Note each punch list item and 

who is responsible for removing it from the list. 

Issue your list as soon as possible and give the 

sub contractors warning as to when it must be 

completed. 

If the punch list is prepared and issued one 

week before the completion date that is all the 

time left to finish any items on the list. If the 

sub contractor tells you he needs more time 

inform him that any additional time taken to 

complete the job will be considered a delay and 

he will be responsible for any damages that 

may occur. This should provide added impetus 

to complete quickly. The punch list should 

never be considered as additional time after the 

tasks are complete. The tasks are not complete 
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until there are no punch list items left on the 

list. 

If you have to return to the site to check on your 

sub contractors, or make special trips to give 

the sub contractors access or any other 

unexpected returns to the site, give your sub 

contractors warning they may be held 

responsible for paying for your time and or 

overhead. 

contractor may require a telegram threatening 

to have another contractor complete his work at 

the original sub contractors cost. Another sub 

contractor may only require a phone call 

informing him he has to finish three minor 

items and you'll meet him for lunch. 

Do what it takes, get the job done and go to the 

next successful project feeling like a winner. 

Provide whatever incentive is necessary for 

each sub contractor to complete. One sub 

This Happened to me 

I was running a large remodel of the District Attorneys' and Public Defenders 
offices in San Jose. This project consisted of seven floors, each about 25,000 sq. 
feet. We had to replace the existing acoustical ceiling and install new lighting, 
H.V.A.C. drops and grilles, reposition sprinkler heads and run overhead
communications. During this remodel process many different workmen had to
access the space above the ceiling. This meant extending ladders through the
ceiling grid and climbing into the interstitial space. As you might imagine there
were a good many ceiling tees and main runners that were damaged. Before the
architectural walk through for the first floor I identified the damaged ceiling
members. When I asked the different trades who had damaged the ceiling the
overwhelming response was, "Not me." The general contractor paid for the damage
to the first floor.

Questions? 

1. Why did the general contractor pay for the first floor?
2. How did the general contractor avoid paying for the other floors?
3. Is there a way to prevent the damage from occuring?
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QUALITY ASSURANCE PLAN 

JOBSITE QUALITY ASSURANCE PERSON DENNIS E. ROSE 

Phase 2 Onsite Procedures 

• Maintain Quality Assurance Log

• Have submittals on hand to compare with delivered items

• Coordinate with other contractors affected by our materials or equipment

• Insure materials and equipment are as specified in contract documents

• Check that materials and equipment delivered to jobsite are new, undamaged and are of proper
quantity. Provide copy of invoice for Construction Manager if requested

• See that materials and equipment are stored in a safe and protected area

• As materials or equipment is installed, insure installation is in accordance with contract
documents and in a manner complying with standards of the industry

• Upon completion of installation notify Construction Manager with inspection request form

• If necessary, correct deficiencies noted by Construction Manager

• After approval by Construction Manager, items may be inspected by 1.0.R.

• After receipt of inspection approval by 1.0.R. { if necessary} work may be covered

• Maintain any temporary construction facilities as described in Contract Documents, { fences,
signs, guardrails, etc.}, as necessary

• Verify that cleanup procedures are met per Contract Documents for both daily and final
cleanup
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QUESTIONS 

1. When does the Close Out procedure start and by whom?

Module 8 

2. List several ways you have seen workmen and women cause damage to other trades. What can
you do about this problem?

3. How can you keep an architectural punch list to a minimum?

4. Does your company have a Quality Assurance Plan?
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Module 9 Review Of Trades 

THIS MODULE IS PLANNED TO PROVIDE ANSWERS TO THE FOLLOWING QUESTIONS: 

• Understand problems of each trade

• Know how to head off potential mistakes with other professions

• Remember methods for making the job go smoothly

REVIEW OF TRADES 

In todays contracting environment the General 

Contractors' superintendent must be aware of 

all trades that are a part of the project he or she 

is going to administer. For a successful project 

the sub contractors are going to depend on the 

general contractors superintendent to schedule 

and help find answers to problems that arise on 

site. Many of the problems that come up are 

typical of almost all job sites. Knowing what 

some of these problems are going to be and 

knowing how to resolve them before they ad

versely affect the project, will be beneficial to 

the successful completion of the project. 

The following lists were compiled by discuss

ing with the sub contractors problems they 

have seen during the course of their contracting 

experiences. Input for these lists was also de

rived from talking with architects, owners and 

other general contractors superintendents. This 

is certainly not meant to be a complete list of all 

possible problems. I expect to see the lists ex

panded as they are discussed in class. Each 

carpenter, with experience on job sites, has 

seen how he or she could save time on the 

project if only something was done differently. 

Your input will help these lists to grow. 

LTP/09 - Review Of Trades 

DIVISION ONE: SUPERVISION 

1. Take the time to review plans and docu
ments with all involved in the project.

2. There is no such thing as a dumb question.
Treat all persons on site fairly, both direct
labor and subcontractors' employees.

3. Make sure that all subs have enough exten
sion cords and pigtails to perform their
work. Also see that this equipment is
marked with the owners logo.

4. Insure that all temporary facilities are in
stalled and operational.

5. Stress safety as first requirement of any job.
Review general contractors safety policies
and job site safety plans with new employ
ees and sub contractors.

6. See that as builts are recorded on a weekly
basis and before covering.

7. Check that new employees have proper and
sufficient personal hand tools before start
ing work.

DIVISION TWO: SITE WORK 

Demolition 

1. Review plans and specs with demolition
foreperson before work proceeds.
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2. Review safety procedures for all personnel
that will be on site including civilians who
may be on adjacent sidewalks.

3. Mark structures or specific items to be
demoed. Mark items or areas that are going
to be saved.

4. Check for possibility of recycling metals,
concrete, paving. Check for reuse of doors,
windows, mirrors, carpet, etc.

5. Layout path for egress and exit of trucks,
heavy equipment, cranes and the likes.

6. Mark safety zone for falling debris with
barricades or other marking system.

7. Erect dust barriers when working in occu
pied areas.

8. Insure that areas to demo are safed off from
electric, water, etc.

9. Maintain trash cleanup on a daily basis.

10. Check that no hazardous materials are on
site, asbestos, lead, chemicals, etc.

11. Protect finishes of items to remain.

12. Inform workers in nearby occupied areas
about noise or other conditions that may af
fect them.

Underground Services 

1. Contact U.S.A. for location of existing util
ities and have the locations marked.

2. Check with city or appropriate agency for
location of water main or sewer in street.

3. See that barricades, flagmen, caution tape,
lights and the like are in place.

4. For trenching situations see if trench plates
are required and who supplies them.

5. Insure proper materials are used for backfill
and check in advance for compaction re
quirements.

6. Check that lift heights are not exceeded
during backfill.
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7. Patches in the street must be completed in a
professional manner.

8. Sidewalk and curb patches normally should
go back to nearest existing joint. Check for
proper concrete mix and color of concrete.

9. Check for any vault elevations. Will con
crete or paving blend in smoothly at these
elevations?

10. Make sure as builts reflect actual locations
and elevations.

11. Use a probe when digging in tight loca
tions.

12. Maintain all required shoring.

Paving and Surfacing 

1. Review plans and specs with foreperson be
fore work commences.

2. Before paving check elevations for proper
drainage.

3. Trenches, depressions etc. must be back
filled with proper materials and compacted
to required amounts before baserock and
asphalt is applied.

4. Surrounding areas should be protected
from asphalt. This includes curbs, side
walks, walls, buildings etc.

5. See that barriers are provided to protect
new paving. All traffic should be diverted
for 24 hours. Do not allow foot traffic from
fresh asphalt onto sidewalks or into build
ings.

6. Transitions from old asphalt to new should
be smooth and well sealed. Finished prod
uct should be free from bony or gravelly ar
eas.

7. There may be advantages to installing the
parking lot before building erection. This
creates a smooth level area for material
storage and staging. This also allows equip
ment to arrive and exit easily. During rains
the project can continue free of mud.

8. During dusty site conditions, make sure ar
eas are watered down.
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DIVISION THREE: CONCRETE 

Concrete Formwork 

1. Review plans and specs with foreperson. At
pre-construction meeting review other
trades impact on forms.

2. Forms must be straight or curved to correct
degree of arc.

3. Forms must be properly secured with cor
rect and sufficient bracing. Concrete
weighs about 135 pounds per cubic foot or
3645 pounds per cubic yard.

4. Wall and column forms must be erected
straight and plumb. Check for downspout
leads, conduit, pipes etc. before pouring.

5. Check for allowable lifts in pouring con
crete. See specs, code and architect or engi
neer.

6. Release agents and curing compounds
should be on site in sufficient quantities be
fore pouring. Check for compliance with
E.P.A.

7. Exposed columns should line up and have
finish quality appearance. Sack and patch
as necessary, within 24 hours if possible.

8. Double check ADA requirements before
pouring ramps, sidewalks etc.

9. Make sure concrete tag from truck driver
matches mix design before pouring.

10. See that all trades have access before clos
ing forms.

11. Check weather conditions a day before any
pours.

12. Always have a backup vibrator for any
pour.

Concrete Reinforcement 

1. Review plans and specs with foreperson.

2. Check for steel size, number of bars, spac
ing, hooks, cages etc.
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3. Coordinate with concrete sub for placement
of rebar and concrete pour.

4. Rebar should hang securely supported,
mats should have dobies beneath, usually
one and one half inches of clearance to
edge of form.

5. Steel should be straight and level with bars
evenly spaced.

6. Insure that shop drawings match structural
plans.

7. Inspect laps for code compliance.

8. Do not allow rebar to be heated to facilitate
bending.

9. Review plans and specs for requirements
on mechanical connectors or welded splic
es.

10. Make sure rebar is clean and ground under
neath rebar is free of debris.

11. Protruding rebar must have O.S.H.A. ap
proved protective covers.

12. Ask electricians if UFER ground is re
quired.

Concrete 

1. Review plans and specs with foreperson.

2. Insure mix design has been submitted and
reviewed by architect.

3. Check that concrete pump or placing equip
ment is scheduled for day of pour.

4. Insure that gravel, sand and vapor barriers
are correct.

5. Verify weather conditions are suitable for
concrete placement.

6. Confirm all imbeds are in place before
pour.

7. Check on finishes for flatwork, exposed ag
gregate, broom finish, etc.

8. Saw cut expansion joints should be done
within 24 hours of concrete pour.

9. Sub contractor should protect all flatwork
from damage until it is fully cured.
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10. Make sure all inspections of items installed
by other trades has been inspected and ap
proved.

11. Before pour, insure you have sufficient
manpower for task ahead.

12. Use 30d or 50d nails in lieu of 16d nails to
secure bottom of form placed on concrete
slab. This makes nails easier to locate and
simplifies stripping.

13. Wash out area for trucks and equipment
should be located before pour starts. Watch
that wash areas do not drain into catch ba
sins, storm drains or sewers.

14. Protect walls and flatwork from graffiti and
vandalism.

15. Check that you have enough cement ma
sons on hand for the flat work finish.

DIVISION FOUR: MASONRY 

1. Review plans and specs with foreperson.

2. Check for light, medium or heavy weight
blocks.

3. Look for size, style and pattern of place-
ment.

4. Insure rebar is installed as required, also ex-
pansion joints.

5. Have all imbeds on site at start of masonry
work. Verify who does layout and place-
ment.

6. Watch for correct placement of imbed
hooks. Usually they are installed behind
vertical or horizontal rebar.

7. Check for allowable grout lifts. Usually six
feet at a time.

8. Check specs and submittal for grout mix.
Check batch time, delivery time and place-
ment time.

9. Confirm if block is going to be exposed,
stuccoed, wrapped etc. for correct joint
tooling.

10. Exposed block walls must be cleaned of ex-
cess mortar. Joints must be neatly tooled.
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11. Block must be clean and dry at time of use.
Review specs for allowable temperatures at
time of installation.

12. All concrete pads and surrounding areas
must be cleaned of mortar droppings, all
broken and leftover block hauled off, mix
ing area cleaned, scaffolding removed and
extra rebar picked up before job is com
plete.

13. Grout joints may require special mixes for
waterproofing.

14. Stress scaffold safety before start of work.
Insure qualified erectors are assembling
scaffolding per new OSHA requirements.

DIVISION FIVE: METALS 

Structural Steel 

1. Review plans and specs with foreperson.

2. Check engineers details and compare with
shop drawings.

3. Look for columns too wide for walls, check
bucket elevations and their orientation to
building.

4. Confirm architectural elevations for col-
umn heights. Allow for beams, pony walls,
plates, roofing, etc.

5. Templates and column bolts should be on
site before concrete pour. Check column
plate details for placement of bolts and tern-
plates.

6. Column bolt placement should be accurate
to+ plus or - minus one eight inch on build-
ing layout plans. This applies to elevation
and east, west, north and south planes.

7. Columns are normally placed after slab is
poured. Diamond or circular blackouts are
normally employed.

8. After elevations are checked column plates
are grouted and blackouts are poured.

9. Brace columns while placing beams to pre-
vent any shifting. Insure columns are in line
and perfectly plumb.
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10. Bolts and connectors are usually supplied
by structural steel sub contractor. Check for
correct size by pre installing bolts in buck
ets. This will also prevent loss or mix up
during course of job.

11. Retighten nuts and bolts prior to covering.

12. Stress crane and rigging safety. Hand sig
nals should be reviewed before start of
pick.

13. When burning or welding galvanized steel
make sure breathing apparatus is used and
fresh air is available.

DIVISION SIX: WOOD AND PLASTICS 

Carpentry 

1. Review plans and specs with foreperson.

2. Watch for discrepancies between architec
tural and engineered drawings.

3. Confirm correct number of platforms for
H.V.A.C. or other equipment is represented
in all sections of plans.

4. Verify framing dimensions for doors, win
dows, etc. Look at submittals for this type
of information. Allow for drywall, stucco,
wood surrounds or other conditions affect
ing framed openings.

5. Insure that openings are plumb and level.
Check after walls are plumb and lined.

6. Look for lumber grade stamps. Review
specs for compliance with pressure treated,
structural, standard or better, construction
or architectural grades. Watch for moisture
content requirements in specs. Lumber
should be straight and free from imperfec
tions affecting framing.

7. Lumber should be stored in such a way as
to protect it from vandalism, theft and the
elements.

8. Kiln dried lumber should be covered to pre
vent moisture increase in wood.

9. Make sure that framing elevations match
architectural elevations.
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10. Check that framer has installed all block
ing. This includes bath accessories, cabinet
blocking, ledger blocking and roof access,
etc.

11. All walls must line up as shown in plans,
bent or twisted studs must be straightened
or removed.

12. Confirm that all required strapping is in
stalled, special hardware, hangers, or con
cealed structural connections are all as per
details. See that all fasteners are installed
per manufacturers requirements or structur
al details.

13. Watch for nailing pattern on structural
walls. Nailheads should not be set below
top layer of veneer in plywood. Use binoc
ulars to inspect areas out of easy access.

14. Plywood over joists, trusses or rafters
should run across grain at 90 degrees to
square exterior walls and framing mem
bers. If not, something is out of square and
must be corrected.

15. All framing cuts should fit tightly. This is
especially important at rafters, hips, val
leys, stairs, etc.

16. Check on nail sizes for use in different ap
plications, plate to stud, toe nailing, etc.

17. Gap exterior plywood per manufacturers
recommendations.

18. Check that layout person does not use in
delible paint for layout on exposed surfac
es.

19. Take photos or videotape walls prior to
closing up. This will show locations of
blocking, conduit etc. for future reference.

20. Make sure that layout takes into consider
ation needs of plumbers, electricians, etc.

21. Review safety precautions, handrails,
stairs, life lines, scaffolding, guard rails,
etc.

22. Limit waste by ordering and cutting lumber
in correct lengths.

23. Watch that nails are not placed in plates
where plumbers and electricians have to
drill.
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24. Use beeswax when drilling or nailing into
hardwoods.

Finish Carpentry 

1. Review with foreperson plans and specs.

2. All exposed work must look good. All
joints tight, nails and screws set.

3. Wood may be sanded and finished before
installation.

4. All work must be straight, plumb, level or
curved gracefully to desired arc.

5. Hardwoods must be pre-drilled or proper
setting equipment must be used.

6. Proper fasteners must be used. Galvanized
normally for exterior use. This includes fin
ish nails, screws, hardware etc.

7. All tools must be sharp, adjusted correctly
and of high quality. A sixty tooth carbide
blade on a ten inch table saw is usually
needed for on site ripping of finish grade
materials.

8. Use the longest lengths of lumber possible.
This is especially important for crown
moulding, siding, trims etc.

9. Only journey carpenters with finish experi
ence should work with or install finish
quality lumber.

10. Remove all pencil marks etc. before paint
ers apply finish.

11. Clean your hands before working with fin
ishes, wear latex gloves if necessary.

12. Give painters a chance to prime or pre-stain
material when possible.

DIVISION SEVEN: THERMAL AND 

MOISTURE PROTECTION 

Roofing 

BUILT UP ASPHALT 

1. Review plans and specs with foreperson.
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2. Insure that nails have been set flush with
plywood.

3. Plywood joints that exceed 1/4 inch must
be filled or covered.

4. See that all crickets or slopes in roof, drain
to roof drains.

5. Make sure there are no low spots in roof.

6. Check that all roof jacks are in place.

7. Any platform or obstruction over 4 feet in
length must have a cricket.

8. Verify that tar pot is in good working order
and is used safely. Watch that hot tar is
dripped on finished products or persons be
low.

9. Insure that all openings are properly
marked and fall protection is in place.

10. Insure that fall protection standards are
met.

11. See that all flashing is installed.

Other Roofs 

1. Review plans and specs with foreperson.

2. For roofs with tiles, shakes or shingles in
sure that eaves, edges, shake mould, gut
ters, fascia, etc. are complete.

3. If fire resistant shakes are used, save bundle
tags for proof of chemical treatment.

4. Watch for step shingles and details showing
sealing against walls, parapets, chimneys,
etc.

5. Check for required flashing.

6. Tile roofs should be loaded one week prior
to installation.

7. See that all roofing nails are picked up off
the ground each day. These nails are the
most common cause for flats on job sites.

8. Insure that fall protection standards are
met.

9. Check pneumatic nailers for depth of nail
set and approved fasteners. Look for shin
ers before inspection.
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10. See that all subs are complete before apply
ing roofing materials

11. If subs need to walk on tile roofs, inform
them that they will be responsible for any
damage they may cause.

Insulation 

1. See that all surfaces are protected from fire
proofing overspray.

DIVISION EIGHT: DOORS & WINDOWS 

Doors and Frames 

1. Review plans and specs with foreperson.

2. Set frames with door template if possible.

3. Check submittals for framing dimensions
for doors and windows.

4. If wood frames are used in metal stud walls,
line metal studs with wood framing. If
doors are heavy or oversized, install blocks
in floor channel to accept door frame bot
tom screws.

5. Inventory and parcel hardware to door and
frame locations in advance of installation to
insure missing hardware can be located.

6. Look for floor or wall bumpers, N.R.P.
hinges, push plates, spy holes, panic or oth
er special hardware.

7. Watch for handicap requirements. Latces
versus knobs, handle elevations, pressure
required to open, etc.

8. Adjust closures twice, once at installation,
secondly after three weeks or after air bal
ancmg.

9. Inspect doors and frames for fire rating tags
and compare with requirements of code.

10. Get help, when required, for lifting heavy
doors and equipment.

11. See that all one piece frames are on site pri
or to framing start up.
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Division Nine: Finishes 

Division Ten: Specialties 

Division Eleven: Equipment 

1. All trucks with cranes or reaching equip
ment must stay well away form electrical
lines.

2. All equipment must be operated by a quali
fied person.

Division Twelve: Furnishings 

Division Thirteen: Special Construction 

Division Fourteen: Conveying Systems 

1. Systems must be marked for direction of
travel, shut off switch and other safety con
cerns.

Division Fifteen: Mechanical 

1. Insure the same number of curbs are shown
on architectural and mechanical details.

2. Make sure plate protectors are installed to
protect pipes and conduit.

3. Check submittals ! Check lead times for
roof units or other large equipment.

Division Sixteen: Electrical 

1. Review all specs and plans with electrical
foreperson.

2. Watch that electrician does not cut king
studs when installing switches near doors
and windows.

3. Have an electrician make repairs to electri
cal wire, equipment, etc. in buildings. Do
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your own light-duty repairs to saws, drills 
etc. if you are capable. 

4. Coordinate shut down, lead times and pow
er requirements for job site.

5. Check contract documents to see who sup
plies temporary power and lighting.

6. Look for possible conflicts of switch or out
let elevations with other trades.

7. See that all circuits, outlets, switches, etc.
are labeled as required.
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Module 10 Computer Scheduling for Superintendents 

THIS CHAPTER IS PLANNED TO PROVIDE ANSWERS TO THE FOLLOWING QUESTIONS: 

• Why is a schedule important to a construction project?

• What types of schedules are used in construction?

• How does the superintendent use the schedule?

• What makes up the different components of the schedule?

SCHEDULE REVIEW 

In this module we will learn to use the 

computer to assist us in the initial design of a 

schedule for a construction project. We will 

also learn how to maintain and update the 

schedule on an as needed basis. 

As you know, the schedule is used for the 

purpose of planning ahead. Being able to 

anticipate what will occur in the future allows 

us to perform our tasks efficiently and on time. 

Without a schedule we would have chaos on 

the job site. Sub contractors might arrive 

whenever they felt like it and tasks would not 

be done in a logical sequence. Concrete might 

be poured before installing rebar, for example. 

Construction companies would not be able to 

project completion dates and owners would 
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have no idea when they could use the new 

premises. 

Besides planning for construction sequence, 

today's computer scheduling programs allow 

us to incorporate other functions to the 

schedule. Scheduling software has the 

capability to cost load and forecast expected 

expenditures, estimate manpower requirements 

through resource loading and provide a full 

compliment of schedule and cost reports and 

time scale graph presentation including both 

critical path logic diagrams and bar chart 

formats. 

Is this starting to sound a little complicated? 

It's really not that bad. In this module we will 

learn how to load all that information into a 

schedule. We will take it step by step and you 

will see that it is not all that difficult. We must 

remember one thing though, using the schedule 
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productively is more important than creating 
the schedule.Construction superintendents 
have to keep in mind the purpose of the 
schedule. The purpose is planning ahead. Many 
superintendents use the schedule to see what 
they have to do for that day's activities or they 
record what they accomplished that day. If you 
ask yourself, "What will I be doing two weeks 
from today?" you are using the schedule for the 
purpose it was designed.Another question 
frequently asked is, "Why do I need a computer 
schedule?" The answer to that is, it makes it 
easier to update or change information in the 
schedule. It also allows the user to add much 
more information than can normally be 
displayed with a handwritten schedule. 

Can you imagine trying to keep track of 100 
different sub contractors and 10,000 different 
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tasks over a two-year time span by hand? Now 
add in cost loading, graphic presentation, load 
leveling, resource allocations, etc. Without the 
use of a computer we would spend as much 
time creating and maintaining the schedule as 
we would building the project. 

Later in this module we will be using a 
scheduling program called FastTrack. The 
program is made by AEC Software. AEC 
Software is used by many companies 
throughout the United States. 
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GETTING STARTED 

The first thing we would need to create a 

schedule is a set of contract documents for a 

particular project. This would include a set of 

blueprints and a Bound Project Manual. We 

will also need a length of time stipulated as to 

how long we have to complete the construction 

project. 

In construction, unlike other fields, we are task 

driven in forming a schedule. We are given a 

length of time to complete a project and must 

Earliest Start 

Task 

Resource 

For this first exercise we 

are going to create a 

simple PERT chart that 

shows Tasks, 

Relationships, 

Resources and 

Durations. 

Duration 

9/18/97 

UBC Const 

The first task we started was Mobilize. This 

involves moving our trailer on site and erecting 

a job site sign. We assigned a length of time, 

two days. We also assigned a Resource, the 

Computer Scheduling for Superintendents 

provide the resources to do the work. Other 

projects are resource driven. For example, in 

creating software only a limited number of 

programmers and engineers are available. They 

may not all be available at the same times 

either. In this case we must extend the length of 

the project to whatever is necessary, using the 

available resources, in order to complete the 

project. Try telling the owner of a building 

project you will be six months late because you 

can find only 20 carpenters instead of the 

required 40, necessary to do the work. 

The index will show where the 

information is displayed. 

Mobilize 

2 9/22/97 2 

Temp Power, 
Fencing, Water and 

..... __ ""' Sanitary Facilities 

UBC Const 

person or company doing the work, which is 

UBC Const. The Relationship that was 

established is Mobilize first, then we put in our 

Temporary facilities. This means that: 

• Mobilize is the Predecessor to Temporary Power

• Temporary power is the Successor to Mobilize
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We also assigned a length of two days to 

complete the work. The Duration is shown as 

the number to the right and above the box. 

The Resource is the name of the company 

doing the work. In this instance, Mobilize, the 

company is UBC Const. The Resource is 

displayed as the name to the lower left, below 

the box. 

The Start Date is displayed to the upper left 

above the box. The computer program 

automatically displays this date as you fill in 

the Duration and establish the Relationship of 

the two Tasks. The program will automatically 
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account for weekends and holidays and not 

schedule work on those days. 

As we add more Tasks to the schedule we must 

always keep in mind that there is a logical 

sequence of events involved. For example, we 

must install rebar before we pour concrete. You 

can imagine the problem if we tried the reverse. 

Ask yourself, "After I complete this task, what 

can I do next? "So, after we install the 

temporary facilities, what can we do next? On 

this project we can start the Site Survey and 

start the Submittal Process at the same time. 

Look at how this is displayed in the next 

diagram. 

9/2 4/9 7 

Survey and Stake 

Site 

si7 Services

4 

Mobilize Temp Power, 

Fencing, Water and 

Sanitary Facilities 

UBC Const UBC Const 
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9/2 4/9 7 

Start Submittal 

Process 

UBC Const 

1 0 
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Look at the diagram. You will see that two 

tasks are now starting at the same time. We can 

start the site survey and start the submittal 

process concurrently. However, the two task 

lengths are different. 

How will that affect the start of the Tasks that 

are the Successors to these two Tasks?

In the next diagram you can see that Survey, 

Site Grading and Pad Preparation are occurring 

during the time that the submittal process is 

Computer Scheduling for Superintendents 

ongoing. The Pad preparation Task needs to 

have submittals reviewed by the architect 

before it can start. It also needs to have the Site 

Grading completed before it can start. In this 

instance the Pad Preparation has two 

Predecessors. The Submittal Process took less 

time than the total of Survey and Site Grading. 

Therefore we did not have any down time 

before we started the Pad preparation. 

9/24/97 4 9/30/97 7 10/9/97 
�---� ----� 

Survey and Slake 

Site 

Site Grading Pad Preparation 

9/18/97 2 9/22/97 

UBC Const 

_____ _,,. 

Mobilize Temp Power, 

Fencing, Water and 

Sanitary Facilities 

UBC Const Start Submittal 

Process 

UBCConst 

On this project we have several different Tasks

that can be started once the pad is completed. 

We have underground for the plumber, the 

electrician and the site utilities contractor. 

These sub contractors can all start at the same 

time. We will have to be careful the sub 

contractors do not interfere with each other so 

we may have one start at the south end of the 

LTP/10 Section 1- Schedule Review 

Earthworks Comp 

project while the other works the north end and 

vice versa. You will notice that the Submittal 

Process is a Predecessor to each of these 

Tasks as the architect must review the material 

data sheets before any materials are installed. 

The Pad Preparation must also be completed 

before each of these Tasks. As you can see, 

each Task has the same two Predecessors.
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Looking at this schedule, we can see that is 

becoming more intricate. As we add more 

Tasks the Relationships will become more 

9/24/97 

Start Submittal 
Process 

UBC Const 

10/9/97 

Pad Preparation 

The simple diagrams we have been looking at 

could display a great deal more information. 

We can add Slack Time, Percentage 

Complete, Cost, Completion Dates, Earliest 

Start, Latest Start, Earliest Finish and 

Latest Finish to name a few items. As we add 

each task we simply input the information the 

computer program asks us for. 

We also have the capability to display other 

Task information we would like. The architect 

may require more information displayed than 

the owner of the project. The architect may 
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complicated. Trying to keep track of these 

Relationships and Durations without the use 

of a computer would be very difficult. 

10/15/97 

Storm Drains 

Rough In Under Pad 

10/15/97 

Plumbing 

Underground 
Rough In 

Electrical 
Underground 

Rough In 

Sparky Elect Co 

7 

10 

8 

want to see all the Relationships while the 

owner may simply want to see when each phase 

of the project will be complete. 

When we put together a schedule that has a 

large number of Tasks and Relationships we 

will find that there are multiple Tasks that have 

the same Successor. However these multiple 

Tasks will not necessarily have the same 

Duration. When two or more tasks have the 

same Successor, start at the same time and 

have different Durations we have a situation 

that creates what is referred to as Slack. 
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Look at the next diagram. You will see that the 

Storm Drain Rough In Under Pad, Plumbing 

Underground Rough In and Electrical 

Computer Scheduling for Superintendents 

Underground Rough In all start at the same 

time. 

1 0/15/97 7 

1 0/9/97 

Pad Preparation 

9/24/97 

Start Submittal 
Process 

UBC Const Sparky 

In this diagram there is a number displayed to 

the lower right, below the box, that represents 

the Slack time. Storm Drains take seven days to 

complete, Electrical Underground takes eight 

Earliest Start Duration 

Task 

Resource Slack 

• How much more time can the Electrical
Underground Rough In take without
affecting the schedule?

• Can you think of any circumstances

when you would not want to display
Slack time on your schedule?
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Storm Drains 
Rough In 

Plumbing 
Underqround 

Rough In 

Electrical 
Underground 

Rough In 

Electric 

3, 
1 0 10/29/97 8 

Form Footings 

0 UBC Const 0 

8/ 

2 

days to complete and Plumbing takes ten days. 

Therefore Storm Drains can take three days 

longer to complete and not affect the 

Successor. 

Look for Slack displayed to the 

lower right of the box. 

• If the Storm drain contractor took
eleven days to complete what would
happen to the Slack time and the
schedule?

• Who has the right to use this Slack
time?
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Look carefully at the Diagram below. You will 

notice that Tasks that have zero Slack time 

have a darker line around the box and have a 

darker line running to the box. This means that 

the Task is on the Critical Path. The Critical

Path is so named because it shows the path of 

completion critical to the completion of the 

project in the time allotted. Tasks on this path 

must be completed within the Duration

displayed or they will push the completion date 

10/15/97 7 Storm Drains Rough In Under Pad 
Eart'n;ers 

3
"' 

Module 10 

of the project back by the amount of time 

exceeding the Duration. Tasks not on the 

Critical Path can be delayed by the amount of 

time displayed as Slack before they impact the 

completion date. If you add up the Durations

of all the Tasks on the Critical Path the sum 

will be the total length of the project. Unlike 

most bar charts, the Critical Path chart also 

shows the logic involved in proceeding from 

one Task to the next. 

11/10/97 
3 Install Red Iron Posts 

-

�
3
, 

Red Metal Inc 
10/9/97 4 10/15/97 10 10/29/97 8/,';10/97 5 11/18/97 

3 Pad Preparation Plumbing Form Footings Electric Rough In Prepare Slab Underground Under Slab Sand, WWM, lmbeds Rough In 
Earthworks Comp 0 UBCConst O�ElectCo UBCConst 0 

8/ 9/24/97 10/15/97 11/10/97 6 Start Submittal Electrical Plumbing Rough In Process Underground Under Slab Rough In 
UBCConst Sparky Elect Co 2 Water Works Inc 0 
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Activity Date 

Early Start 

Early Finish 

Late Start 

Late Finish 

Target Start 

Target Finish 

Start Constraint 

Finish Constraint 

Actual Start 

Actual Finish 

Suspend Date 

Resume Date 

Computer Scheduling for Superintendents 

DEFINITION OF SCHEDULING DATES 

Description 

Earliest date activity can begin 

Earliest date activity can finish 

Latest date activity can start without delaying projects finish or an 

established deadline 

Latest date activity can finish without delaying projects finish or an 

established deadline 

Target date activity should start;entered by user 

Target date activity should finish; entered by user 

Restriction placed on activity's start date that specifies when it can 

or must start; entered by user 

Restriction placed on activity's finish date that specifies when it can 

or must finish; entered by user 

Date activity actually started; entered by user, or calculated by 

SureTrak if estimating progress 

Date activity actually finished; entered by user, or calculated by 

SureTrak if estimating progress 

Date work on an activity is suspended; requires an actual start date; 

entered by user 

Date work on an activity will or did resume; requires a suspend date; 

entered by user 

Unleveled Start Date activity was scheduled to start before user leveled resources; 

calculated by SureTrak 

Unleveled Finish Date activity was scheduled to finish before user leveled resources; 

calculated by SureTrak 
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CPM Exercise 

FORWARD AND BACKWARD PASS 

In this exercise we will look at how the computer assigns Early Start and Late Start dates to the 

tasks we put in the computer. We will input the Predecessor and Successor information and the 

Task Length. What we do not do is assign dates, the computer does that. 

The computer first will make a forward pass and figure what is the Earliest Start date possible for 

each Task to begin. It does this by adding the Task Length of each Task to its Successor. It takes 

that total and adds it to each successive Task. Look at the illustration below. Note the index. It 

shows where the Early Start, Early Finish, Late Start, Late Finish, Symbol I.D. and Duration 

appear in the illustration. 

(Task 1 Duration) + (Task 2 Duration) = Early Finish Task 2 

Early Start Early Finish 
0 7 7 13 

Late Start Late Finish 
I___.. 

Task ID# Duration 

Index 

Task# 1 7 
Task# 2 

(Duration) (Duration) 

When the computer displays the Early Start and Early Finish or the Late Start and Late Finish 

it is working on a calendar scale. It will take into consideration the days you have specified as non 

working days, Saturdays and Sundays for instance. It will then compute the Dates these events take 

place. For the purpose of this exercise we will use an arithmetic scale, that is to say we will simply 

add the number or subtract the numbers from each other. 
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Look at the next illustration. It shows a simple Critical Path chart. Add up the Task Length and 

the Early Start and you get the Early Finish. When a Task has multiple Predecessors use the 

highest Early Finish number from all of the Predecessors. This is done because the Task cannot 

start until all Predecessors are complete. 

(Task 1 Duration) + (Task 2 Duration) = Early Finish Task 2 

Early Start Task 2 + Duration Task 2 = Early Finish Task 2 

7 + 6 = 13 

0 7 

1 2 

13 19 

Early Start Early Finish 

4 6 

Late Start Late Finish 

Task ID# Duration 

Index 

19 24 

5 5 

The computer has been adding the Task Duration to the Early Start for each Task so as to come 

up with an Early Finish for that Task. It will do this based on the Logic you input by assigning 

Predeccessors and Successors to each Task. The computer must complete this process for the 

entire project before it can determine the Late Start and Late Finish. 
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Until now we have been working with a forward pass. Now we will use a backwards pass. To 

determine the Late Finish and the Late Start we work in reverse. In the last Successor Task take 

the Early Finish and use it as the Late Finish for the Predecessor Task. When there are multiple 

Successors use the lowest Early Start number. Look at the next illustration. When we subtract the 

Task Length from the Late Finish we get the Late Start. 

13 

15 

3 

0 7 7 19 24 

0 7 7 19 24 

1 7 2 5 5 

13 

13 

4 

The computer follows the path of Logic you created by looking at the Successors and 

Predecessors. In this way the computer is also able to display the Critical Path, or the length of 

time required to complete the project. The computer can now also show which Tasks have Float. 

It does this by subtracting the Early Finish from the Late Finish date. The difference between the 

Early Finish and the Late Finish is the Float. 

Take a look at the C.P.M. Exercise and fill out the Early Start totals and the Early Finish totals 

for each Task. Follow the Logic as shown on the diagram. Remember when you get to a Task with 

multiple Dependencies, the Predecessor with the highest number ( or Early Finish date) will be 

the one to use as the Earliest Start for the Successor Task. When you have completed that, work 

your way backwards and find the Late Start and the Late Finish numbers. 
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Module 11 Resume for the Construction Superintendent 

As a union carpenter you have become used to the system of being dispatched to a new job site. At 

the site you probably filled in some questionnaires that inquired about your address, phone number, 

emergency phone contact person, etc. The resume that you provided was your union dispatch. 

There has been no need to provide a personally written resume to a contractor until now. There is 

an ad in the paper, from a local union contractor, looking for a superintendent to run a concrete 

forming project. This is the same kind of work you have been doing for the last three years. 

WANTED: 

Construction Superintendent 

Union Contractors of 

San Francisco 

Is looking for a super to run concrete form

ing work at Big City Water Works Project. 

Must have experience, be computer literate, 

know scheduling, contract documents, 

HazMat Certs. Excellent Salary and Bene

fits. 

Send Resume to: Fax# 415 555 1212 

Union Contractors of San Francisco 

111 Market Street 

San Francisco 

SEND RESUME TO: 

• Have you seen that phrase before?

Now this is a job right up your alley. You just 

completed three years of concrete formwork at 

a water plant in Vallejo. You started out there as 

a carpenter and ended up as the foreman 

running the entire carpenter and laborer crew. 

You got used to doing paperwork for the 

contractor at the water plant and you have your 

HazMat Certs from Health and Safety Training 

through the Carpenters Union. The Leadership 

Training Classes provided a place to get 

computer skills. This job has your name written 

all over it. However, to get the job it looks like 

you are going to have to provide a resume. 

• Have you ever sent out a resume to apply for a job before?

•Have you ever gotten a job from a resume that you sent out?

• Have you ever thought you couldn't get the job, because they asked for a resume?

Well now its time to write a resume. There are a lot of questions you will have to ask yourself 

before you start this project. There is going to be some research of your personal history and 

records, which you will have to do. When you have completed the preliminary work you can then 

start writing the resume. You will have a set of plans to follow to provide direction so as to produce 

a resume that will allow you to proceed to a job interview. 
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Module l l Resume for the Construction Superintendent 

Resume Plans 

1. Collect and organize job and skills history

2. Match your experience and skills with
contractors needs

3. Emphasize your particular skills

4. Organize information for an effective
resume

5. Choose words carefully

6. Resume review

7. Create a masterpiece

8. Review the final product



Module l l Resume for the Construction Superintendent 

1. Collect and organize job and skills history

EDUCATION 

List your education: 

• Include your High School

• Include special seminars

• Journeylevel Training

• Health and Safety Training

• Night School

• College

Include a brief summary of important training classes you've taken. Note when training and 

regulations require a certification. 

For Example: 

I have been certified by the State of California to work in Lead Abatement after completing a 32-

hour Health and Safety training class. 
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Resume for the Construction Superintendent Module l l 

EXPERIENCE 

Be sure to include: 

• Full-time paid jobs

• Part-time jobs

• Volunteer work.

List the month/years you worked, position, name and location of employer or place, and 

responsibilities you had. Make this list in chronological order, starting with the last job you worked 

at. Each major job you held should show an increase in skills and responsibilities. As you describe 

your skills and work activities, ask yourself questions like these: 

• Do I meet construction schedules consistently?

• Am I a good communicator?

• Do I enjoy teamwork?

• Have I run work or been a crew leader?

For Example: 

4/95 - 3/98 Carpenter Foreman Brero Construction, Santa Clara, CA 

My duties included assigning tasks and performance evaluation, keeping time cards, scheduling 

manpower, equipment and materials. I also maintained communications with sub contractors, the 

architect, inspector and the owner. 
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Module l l Resume for the Construction Superintendent 

SKILLS 

What are you good at? 

• Concrete Formwork

• Commercial Framing

• Computer Literacy

• Communication

• Leadership

Describe your skills so as to target the position you are applying for. If the position is construction 

superintendent you might describe your skills as follows. 

For Example: 

While working as the carpenter foreman at the water plant, my leadership and communication skills 

played a large part in delivering the concrete formwork on time and under budget. My experience 

with modem forming systems allowed our company to achieve manpower budget targets. 
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Resume for the Construction Superintendent Module l l 

AWARDS and HONORS 

List your important awards, such as: 

• Apprentice of the Year 1989

• Medal of Valor

• Scholarship

When you have completed getting this information together and written down, check it for 

accuracy. You'll need correct names, addresses, correct and consistent dates, and correct spelling. 
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Module l l Resume for the Construction Superintendent 

2. Match your experience and skills with the

contractor's job requirements

Job Title or Position 

• What is the ideal job you are searching for?

• Now get realistic and list what positions you would accept

• Ask yourself; do I have the skills to perform the job?

Now look for the positions you listed. Check newspaper want ads, tell your employer and former 

employers what positions you are looking for. Inform your local hall you would like to be 

dispatched as a foreman or as a superintendent. The Internet has several job search sites and can 

also help find positions. 

The Contractor 

As a superintendent or foreman, what aspects of your education, experience, or skills will be most 

attractive to that employer? List specific job experience, areas of specialty, specific skills, or 

knowledge that you think would interest the employer. 
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Resume for the Construction Superintendent Module l l 

3. Highlight Details That Demonstrate Your
Capabilities

Review what you've written and try to select details of your education, experience, honors, skills, 

and activities that match the contractors needs in a few important areas. 

For Example: 

When applying for superintendent position at a company that specializes in wood frame 

construction, highlight all the framing positions that you held. Also highlight any supervisory 

positions. 
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Module l l Resume for the Construction Superintendent 

4. Organize the Resume Effectively

PERSONAL INFORMATION: 

Your Name { top center, first page} 

Address 

Phone number 

E-mail and/or Fax #

EDUCATION: 

List your education, include seminars, special training, certificated courses 

EXPERIENCE: 

In the construction trades we use a chronological format to list our work experiences To emphasize 

work experience, list jobs beginning with the most recent. Some hints: 

• Write all job descriptions in parallel phrases, using ACTION verbs

• List the most important responsibilities or successes first

• List similar experiences and skills together

• Emphasize collaborative or group-related tasks

NOTE: A potential employer has no legal right to request information about age, sex, race, religion, 

marital status, health, physical appearance, or personal habits. Don't include such information on 

your resume. 

AWARDS/HONORS: 

Use reverse chronological order; include titles, places, dates. 

ACTIVITIES: 

Generally, list hobbies, travel, or languages only if they relate to your job interests. In some cases, 

you may wish to emphasize your willingness to travel or relocate. 

REFERENCES: 

You need not put these on your resume. Instead, you can prepare a separate list of references, with 

complete name, title, company name, address, and telephone numbers for each individual. Usually, 

you give this list to prospective employers after your interview. 
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Resume for the Construction Superintendent 

5. Consider Word Choice Carefully

Module l l 

In a resume, you need to sound positive and confident: neither too aggressive, nor overly modest. 

The following words and phrases are intended as suggestions for thinking about your experience 

and abilities. 

Whatever your final word choices are, they should accurately describe you--your skills, talents, and 

experience. 

Choose ACTIVE VERBS that describe your skills, abilities, and accomplishments. Examples: I 

can contribute, enjoy creating, and have experience in coordinating. While at XYZ Construction 

Company, I administered, coordinated, directed, participated in .... Below is a list of such verbs: 

• Accomplish; achieve; analyze; adapt; balance; collaborate; coordinate;

communicate; compile; conduct; contribute;

• Complete; create; delegate direct; establish; expand; improve; implement; invent;

increase; initiate; instruct; lead;

• Organize; participate; perform; present; propose; reorganize; research; set up;

supervise; support; train; travel;

• Work (effectively, with others)

For Example: 

You can change the forms of any of these verbs to stress different aspects of your abilities and 

experience: coordinate 

Coordinated, coordinating, coordination. 

Choose ADJECTIVES and NOUNS that describe you positively and accurately: 

• Able to; administrative; analytical; (fluently) bilingual; broad scope; capable;

communication skills; collaboration;

• Collaborative; consistent; competent; complete; creative; dedicated; diversified;

effective; experienced; efficient;

• Extensive; exceptional; flexible; global; handle stress; imaginative; intensive; in

depth; innovative; integrated; able to

• Listen; motivated; multilingual; multi-disciplinary; a negotiator; other cultures;

reliable; responsible; a supervisor;

• Teamwork; well traveled; work well with .... 
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Module l l Resume for the Construction Superintendent 

6. Ask Other People to Comment on Your

Resume

Before you print up your resume, ask someone to critique the document. An advisor, potential 

employer, or someone in your field is a good choice. 

Try calling some local contractors and ask which resumes have impressed them in the past. Ask for 

specific details. Try to incorporate some of these ideas in your own resume. 
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Resume for the Construction Superintendent 

7. Make the Final Product Presentable

Module l l 

Use a computer and high quality (preferably laser) printer. If you don't have a computer or laser 

printer, you should either have your resume professionally produced, at your local print shop, or 

inquire as to where one is available. 

• Use a high quality paper.

• Use a laser printer* Use a simple and clear font
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Module l l Resume for the Construction Superintendent 

8. Evaluate Your Resume

Place your resume on the table, step back and see how it looks. Is the page too busy with different 

type styles, sizes, lines, or boxes? Is the information spaced well, not crowded on the page? Is there 

too much "white space"? Is important information quick and easily found? 

CONTENT 

• Name is at the top of the page: highlighted by slightly larger type size, balding, and/
or underlining

• Address and phone number(s) are complete and correct, with zip and area codes,
and are well-placed in relation to name

• All entries highlight a capability or accomplishment

• Descriptions use active verbs, and verb tense is consistent; current job is in present
tense; past jobs are in past tense

• Repetition of words or phrases is kept to a minimum

• Capitalization, punctuation, and date formats are consistent

• There are NO typos or spelling errors

ORGANIZATION 

• Your best assets, whether education, experience, or skills, are listed first

• The page can be easily reviewed: categories are clear and the text is indented

• The dates of employment are easy to find and consistently formatted

• Your name is printed at the top of each page

FORMAT/DESIGN 

• No more than two typestyles appear; typestyles are conservative

• Holding, italics, and capitalization are used minimally and consistently

• Margins and line spacing keep the page from looking too crowded

• Printing is on one side of the sheet only, on high-quality bond--white or off-white

• The reproduction is good, with no blurring, stray marks, or faint letters

• The right side of the page is in "ragged" format, not right-justified.

• Right justification creates awkward white spaces

Now you're done! Just one more suggestion: If you are sending your resume to a prospective 

contractor, you'll probably also have to include a separate cover letter. This is usually one page 

long. The letter indicates your interest in a particular company or position, summarizes the most 

important aspects of your education and experience, and lets the employer know where and when 

you can be contacted for an interview. 
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Resume for the Construction Superintendent Module l l 

Resumes Do's and Don•ts 

Never 

• Give a reason for leaving a job. In almost all cases the contractor will find negative
connotations to good explanations

• Include hobbies, sports and social activities

• List in your experience technologies for which you have no work experience

• State "References Available on Request." It is assumed, and only clutters up the
resume. Other things to omit are your Social Security number, your spouses'
occupation and your personal philosophies

• Use exact dates. Months and years are sufficient

• Include the date your resume was prepared. If your job search takes longer than a
few months, the resume will appear outdated

• Reveal your company-phone number unless your supervisor is aware of your
departure

• Include your height, weight or remarks about your physical appearance or health

• Use professional jargon unless you are sure it will be read by someone who
understands the buzz words

• Provide salary information on the resume. Save it for the interview. If you are
required to give that information, reveal it in the cover letter

• LIE
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Module l l Resume for the Construction Superintendent 

Resumes Do's and Don•ts 

Always 

• Update your resume as you approach completion of each temporary assignment

• Use "bullet" format where appropriate

• Use conventional English. Stay away from multi-syllable words when a one or two
syllable word will do

• Use short paragraphs, no more than five lines

• Make sure the resume and cover letter are error free. Proofread and have others
proof it for you

• Rewrite a resume for a specific position with a specific company. It is extra work but
it may pay off

• Include your significant contributions at each one of your jobs

• Allow the most space for the positions that are most relevant to the position you are
applying for

• List your activity with professional, trade and civic associations----only if they are
related to the position

• Keep a permanent file of your achievements, no matter how inconsequential they
may appear to be. This is the basis for a good resume

• Give each of your references a copy of your resume

• Re-read your resume before each interview

• Send your resume in the timeliest manner possible. Fax or E-mail your resume when
possible

• 
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FOUNDATIONAL MATERIAL 

Foundations for Safety Leadership 
--------------------

Goal 

Introduce you to 5 critical safety leadership 

skills you can use to improve safety climate 
and safety outcomes on the job site. 

Foundations for Safety Leadership 
--------------------

Learning Objectives 

By the end of this module students will be able to: 

1. Explain why safety leadership is important

2. Describe 5 skills of safety leaders

3. Olscu&S how to apply safety leade, ship sknl� on

the Job site

SLIDES 4 AND 5 INTENTIONALLY LEFT OUT 

4 



Foundations for Safety Leadership 
------------------

Who are Safety Leaders? 

Foundations for Safety leadership 
------------------

Safety 

Leaders 

Safety 
Programs & 

Policies 

Safety 
Climate 

Safety 
Incidents 

Foundations for Safety Leadership 
------------------

Safety Leaders Strengthen 

Jobsite Safety Climate 

How well a company's policies, procedures, and 

practices are actually implemented on the job site. 
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Foundations for Safety Leadership 
----------------

Direct Costs 

-< L::=l�I �II 

Foundations for Safety Leadership 
----------------

10 

Indirect Costs 

,( 

Foundations for Safety Leadership 
----------------

Benefits of Effective Safety Leadership 

6 



Safety Leadership Skills 

Foundations for Safety Leadership 
- ---- -- - ---- - --- - - - -- - - --

Safety leader is defined as ... 

A person who has the courage to demonstrate that 
s/he values safety by working and communicating 
with team members to identify and limit hazardous 
situations even in the presence of other job 
pressures such as scheduling and costs . 

I.I 

• 

Foundations for Safety Leadership 
--- -- - - - -- --- - - - - -

5 LEADERship Skills 

Leads by example 

Engages and empowers team members 

Actively listens and practices three-way communication 

DEvelops team members through teaching, coaching, & 
feedback 

Recognizes team members for a job well done 
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LEADER 

Leads by Example 

Foundations for Safety Leadership 
---------_-_-_-_-_-_-_----------

How to 

Lead by Example 

• Have a positive attitude about safety

• Establish safety as a core value

• Set high expectations for safety

• Share safety vision with the team

• "Walk the talk"

• Reinforce the idea that everyone owns safety

• Lead up!

14 
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LEADER 

Engages and Empowers Team Members 

I 
1 

Foundations for Safety Leadership 

How to 

Engage and Empower Team Members 
• Explain why safety is critical to getting the job done

• Engage team members in safety decision-making

• Conduct daily morning safety huddles and joint worker

management walk-,arounds throughout the workday

• Empower team members to

- Report safety concerns, injuries and near misses

- Report or fix hazarc s or unsafe situations

15 
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LEADER 

Actively Listens and Practices 3-Way Communication 

Foundations for Safety Leadership 
----------------------

Howto 

Actively listen and 

Practice 3-way Communication 
• Treat team members with respect when they

are speaking

• Pay attention to non-verbal cues such as body

language and eye contact

• Listen to hear what is being said vs. to come up

with a response.

• Ask clarifying questions

16 
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Foundations for Safety Leadership 
. 

How to 

Actively Listen and 

Practice 3-wav Communication 

• Make sure you have listener's attention

• Be direct and concise

• Ask team member to repeat message
• Clarify any misunderstandings

17 
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LEADER 

DEvelops Team Members through Teaching, Coaching, and Feedback 

Foundations for Safety Leadership 
-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_----------

HowTo 

Develop Team 

Members 

through 

Teaching, 

Coaching, and 

Feedback 

Observe 

worker action 

/ \ 
____ Teach & coach 

Practice Address 

action \Dal� the issue 

Problem 

solve 

/ 

lB 
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Foundations for Safety Leadership 
·�-� - --- -

HowTo 

Develop Team 

Members 

through 

Teaching, 

Coaching, and 

Feedback 

Use the FIST Principle: 

Describe the .EACTS 

Explain the IMPACT 

Provide SUGGESTIONS 

Be TIMELY 

19 
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LEADER 

Recognizes Team Members for a Job Well Done 

Foundations for Safety Leadership 
---

-
-_ -_-_-_-_-_-_-_-_-_---------------

How to 

Recognize Team Members 

for a Job Well Done 

• Give recognition separately from other types of

feedback

• Regularly give praise in private

• Be specific about why you are praising the person

• Give praise publically if the person is comfortable

with it

20 
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Applying Leadership Skills in Real World Scenarios 

Foundations for Safety Leadership 
,-�--------------·--- --------- ~ -- --

Scenario Activities 

• Analyze whether characters used

the safety leadership skills

• Discuss what could have been

done better

2Z 

15 



Foundations for Safety Leadership 
----------------_-_-_-_-_-_-_-_-_- _- _--

Scenario Structure 

• Situation

• Outcome A

• Outcome B

• First letter of character's name based on job

position:

• Stan is a �uperintendent

• Frank is a foreman

• Emilio is an �xperienced worker

• Tia is a Irainee/apprentice

23 

Construction site where all the scenarios take place 

Foundations for Safety Leadership 
--_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-_-----_- _- _--_-_-_-_- _- _- _-_-----

Job site 

• Six-story mixed use

building {1st floor

commercial)
• North Carolina
• 12-14 month project

• Began inJanuar¼

scenarios start in July

25 

General Contractor 

• American Master Builders

{AMB) Inc.

• 50% AMB employees

• 50% specialty subs

• 30-50 workers on site at any

one time

• Union and non-union
-
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Leadership Skills and Action Checklist 

Skills Actions 

• Establishes safety expectations as a core value
• Shares safety vision with team members

Leads by Example • Demonstrates a positive attitude about safety
• Walks the Talk
• Leads up

Engages, encourages, and empowers team members to 
identify and act upon unsafe situations by ... 

Engages and • Reporting hazards and safety concerns
Empowers Team 

• Providing solutions
Members 

• Reporting near misses
• Stopping work if necessary

Actively Listens and • Actively listens to hear what team members are saying

Practices 3-way • Practices 3-way communication by having person repeat

Communication the message they heard

• Respectfully teaches and coaches workers
• Watches the learner fix the hazardous situation or perform

DEvelops Team the task to make sure it's done correctly
Members Through 

• Focuses on potential consequences rather than on the
Teaching, Coaching, team member
and Feedback 

• Uses the FIST principle: Facts, Impact, Suggestions,
Timely

Recognizes Team 
• Privately and/or publicly acknowledges team members for

Members for a Job 
Well Done 

going above and beyond when it comes to safety
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1. COVER UP!

Situation 

Stan - Volt Electric Superintendent 
Frank - Volt Electric Lead Foreman 

Tia - Volt Electric Trainee/apprentice 

To perform her tasks, Tia, a trainee with Volt Electric, has to walk by a large hole in 
the floor where some damaged plywood needs to be replaced. Stan, Volt's 
superintendent, knows it's a serious fall hazard that needs to be addressed 
immediately. The GC has been slow to respond to safety requests, so he asks his lead 
foreman, Frank, to take care of it. 

Outcome A 

Frank tells Tia she needs to cover the hole in the floor. Tia nods and decides she'll 
take care of it in 15 minutes when she's done securing the electrical wire to the stud. 
She knows Frank hates it when one person holds up someone else's work. 

Meanwhile, two drywall installers don't see the hole until the last minute when a 
nearby worker yells, "Stop!" which gives them just enough time to avoid it. 

Frank gets word of this, goes back over to Tia, and yells at her for not covering the 
hole immediately. He adds that if the worker had stepped into the hole, she would have 
been seriously injured, or maybe worse, and points out that this isn't the first time she's 
ignored his instructions. Tia, feeling humiliated, apologizes and explains that she didn't 
realize he wanted her to drop everything. 

Outcome B 

Frank tells Tia she needs to cover the hole in the floor immediately because it's a 
serious fall hazard. He tells her to stop what she's doing, get a piece of plywood, 
secure it over the hole, and spray paint the word "hole" on it. He reminds her to tie off so 
she won't become a victim while fixing the problem. 

When he's finished, he asks her to repeat his instructions to make sure they're on 
the same page. Tia repeats Frank's instructions word for word and Frank gives her the 
thumbs-up. 

When she's done covering the hole, Tia thinks how glad she is Frank asked her to 
confirm what he wanted her to do and by when he wanted it done because there have 
been times when she hasn't understood exactly what other foremen she's worked with 
were asking her to do. 

A few minutes later, when Frank comes by to thank Tia for removing the fall hazard, 
two drywall installers walk across the piece of plywood she just put down. 
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2. IT'S TOO HOT, TOO HOT, TOO HOT BABY ...

Situation 

Franco - AMB, Inc. Foreman 
Emilio - AMB, Inc. Experienced worker 

Late one afternoon, Franco, a foreman for AMB, notices Emilio, an experienced 
carpenter, pouring a jug of water over his head. Franco suspects heat exhaustion. 

He shouts to Emilio that he'll be right down to walk him to the trailer where it's cool, 
so he can rest, get something to eat and drink, and stay inside, out of the sun, until 
quitting time. 

Emilio responds that he's fine, except for a slight head and stomach ache. But 
agrees to go to the trailer. 

Outcome A 

After guzzling a sports drink and eating some peanuts, Emilio notices it's 2:00 and 
thinks if he gets back to work soon, he can finish what he was doing before the day 
ends. So, he leaves the trailer to go back to work. 

The sweltering heat hits him as he leaves and soon he is overcome with nausea. He 
gets a leg cramp, his knee buckles, and he drops to the ground. Franco sees this and 
runs over to see if he's ok. 

Emilio's wave of nausea subsides and he tells Franco not to worry, it was "just a little 
cramp." Franco tells Emilio his instructions were very clear to sit out the rest of the day 
and that he should have listened to him. 

Outcome B 

Franco asks Emilio to tell him exactly what he's going to do once he gets into the 
trailer. Emilio repeats Franco's instructions, but leaves out the part about stopping work 
for the day. 

Franco corrects him and emphasizes that he expects him to stay and rest in the 
trailer until quitting time. Emilio frowns, saying it will only take him a few minutes to 
finish what he was doing. 

Franco tells Emilio that the only job he has left to do today is to get better for 
tomorrow and that another crew member will be able to finish up for him. Emilio knows 
that Franco is doing this because he's concerned, so he explains what's left to do, and 
heads to the trailer. 
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3. TO CHECK OR NOT TO CHECK ...

Finn - AMB Inc. General Foreman 
Enzo - AMB Inc. Experienced glazier 
Erika - AMB Inc. Experienced glazier 

Scott- TJ's Roofing Site superintendent 
Situation 

It's 7 a.m. in early August. Five AMB Inc. glaziers and the foreman, Finn, are in 
their daily safety huddle. Finn goes over the day's tasks of installing windows from a 
suspended scaffold and talks about possible safety issues. When he finishes, he asks if 
anyone has anything else to discuss before starting work. 

The workers look at each other, and Erika speaks up, saying she's concerned 
about tiebacks for the suspended scaffold. She'd heard T J's Roofing is undoing them 
and the lifelines because they think they'll get their work done faster. 

Outcome A 

Finn thanks Erika for letting him know and says Ok, if there's nothing else, let's 
get to work. On the job, Erika inspects the suspended scaffold tiebacks and notices that 
one isn't secure. So she fixes it before starting work. 

Outcome B 

Finn is surprised and asks if anyone else heard this - or seen it happen. The 
workers nod and Enzo says yesterday he saw someone on a suspended scaffold that 
didn't have the tiebacks secured. 

Finn gets angry and says to the crew that if the tiebacks aren't attached, and 
something compromises the scaffold, the rigging devices can move which will put us all 
out of work while ambulances take care of the mess. 

He thanks both Erica and Enzo for paying attention to hazards and for speaking 
up, and says he's going to talk to the sub's supervisor immediately before any of them 
go on the site. 

Finn, Erika, and Enzo leave and run into Scott, T J's site supervisor. As Finn tells 
Scott about his crew's concerns, Scott gets defensive, exclaiming that he and his crew 
always put safety first! Although he also admits he's getting pressure from the owner 
because there's another job starting next week. 

In a raised voice, Finn says to Scott that he's putting workers' lives at risk, and that 
he won't stand for it. He tells Scott that until he calls his crew together and tells them 
directly that they should never disconnect any suspended scaffold tieback or lifeline, he 
won't allow his workers to go on site which will not only delay T J's work on this project, 
but also the one starting next week. 

Scott glares at Finn but then gathers his workers and to say tells them never to 
untie any suspended scaffold tiebacks and or lifelines. He goes on to say that if they 
find any unsecured connections they must let him know so he can make sure the 
problem is immediately fixed. 
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4. GIMME SOME SPACE ...

Simon -Burnett Superintendent 
Freddy - Burnett Insulation Foreman 

Eli - Burnett Insulation Experienced worker 
Ted - Burnett Insulation Trainee/apprentice 

Situation 

Simon, the superintendent for Burnett Insulation, checks on his crew, asks them 
how it's going and if they need anything to complete their work. No one comments at 
first, until the trainee/apprentice, Ted, says that everything is fine. Simon notices the 
other workers aren't looking at him. 

Outcome A 

Simon disregards the lack of eye contact and turns to leave, saying ok, and asks 
them to let him know if they need anything. 

Outcome B 

Rather than taking Ted's word for it, Simon asks the crew to walk him through 
their plans for the day, including any safety issues that might come up. 

Fred, Burnett's foreman, says they're supposed to insulate the copper pipes in 
the ceiling. But, because the pipes are in a tight space close to electrical wires, they 
can't set-up their ladder correctly and will have work in awkward positions. 

Simon thanks the crew for identifying the problems ahead of time, rather than 
starting work and getting in a bind. He agrees that the last thing they want do is damage 
the wiring and delay the project. And he's sure no one wants any more back strains. 

Simon's positive response encourages Eli to chime in, saying that they found a 
few places they could get in opposite the pipes, but they can't figure out how to reach 
most of the other spots. 

Simon asks them to think about other types of equipment that might work better 
than a ladder. The crew suggests a scissor lift, an articulating boom, or a one-man 
vertical lift. Simon comments they are all great ideas but the best one is a one-man lift 
because it will fit the space, they can take all their materials with them and they won't 
have to bend and twist to get the work done. 

He tells them that there's one on the first floor and asks Ted to get it. He then 
turns to Fred and asks him to write up a short paragraph on their plan and put it in the 
JHA binder in case they're in the same situation again. 
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5. THE RIGHT TOOL FOR THE RIGHT JOB

Felicia - AMB Foreman & Co-Owner 
Eric - AMB Experienced worker 
Tyler - AMB Trainee/apprentice 

Situation 

Felicia, foreman and co-owner of AMB Inc. sees Eric, an experienced carpenter, 
using an open-ended wrench to tighten bolts on a ledger board above the delivery door 
opening where they will install an awning. As company owner, she knows she plays a 
key role in reducing jobsite risks. So, she decides to ask Eric why he's not using a tool 
that would be less likely to slip, like a ratchet or box wrench. 

Eric agrees with Felicia that either one of those tools would be safer, but says the 
wrench was close by and he just wants to finish up and move on. Felicia raises her 
voice slightly, saying that at AMB safety is our number one value and that Eric needs to 
find and use the right tool to finish the job. 

Eric goes to the gang box, doesn't see a ratchet or box wrench, and decides to 
continue using the open-ended wrench. 

Outcome A 

Tyler, a trainee at AMB, overhears Felicia speaking with Eric and mutters to 
himself that Eric always talks about working safely, but it looks like he doesn't really 
mean it. 

Outcome B 

Tyler sees that Eric is still using the wrench but he isn't comfortable challenging 
him. He then remembers seeing a ratchet on the ground. So he goes to get it. 

He hands the ratchet to Eric and asks if it's what he was looking for. Eric thanks 
him. Tyler grins, says it was no problem and that he'd hate to see Eric bust up his pretty 
face with that open-ended wrench. Felicia happens to see their interaction. 

Later, Felicia thanks Tyler for his extra effort and asks if it would be ok if she 
mentions it at the next safety huddle. Tyler says he'd prefer to not be singled out, but is 
glad to know that she appreciates what he did and thinks Eric does too, although he 
might not say so! 

Felicia agrees she won't mention it, but says that she will speak with Eric and tell 
him that now on she expects him to take his role as a safety leader seriously which 
includes leading by example. 

22 



6. DO WE HA VE TO??

Situation 

Floyd - Painting Perfection Foreman 
Ed - Painting Perfection Experienced worker 
Tom - Painting Perfection Trainee/apprentice 
Tina - Painting Perfection Trainee/apprentice 

Floyd, foreman for Painting Perfection, sees Ed, an experienced painter, along 
with trainees Tom and Tina, starting to load their materials onto the suspended scaffold. 
Floyd asks Ed if they've inspected the rigging on the roof to make sure the scaffold is 
secure. 

Ed snaps back, saying they'd checked it this morning and were only gone 45 
minutes. Tom chimes in, saying he's sure the rigging is fine, adding that it's probably 
120 degrees on the roof! 

Outcome A 

Floyd shrugs, saying one check in the morning is probably okay. Ed tells Tom 
and Tina to hurry and finish loading the materials so maybe they can knock off a little 
early. 

They finish loading the scaffold with enough supplies so they won't have to come 
down and get more. But at four feet off the ground, one of the riggings on the roof gives 
way causing the scaffold to tip - taking them and their materials with it. Fortunately, no 
one is hurt, but it will cost the company both time and money, making Floyd and the 
CEO very unhappy. 

Outcome B 

Tom and Ed's reaction makes Floyd wonder if they actually know how to inspect 
rigging and make needed corrections. Or worse, maybe they think it's okay to cut 
corners. He tells them that even though it's hot on the roof, the scaffold rigging is 
what's keeping them from falling and it must be checked! Ed groans when Floyd tells 
him to get Tom and Tina so all of them can go up to the roof They all groan when he 
asks them to come with him to the roof. 

On the roof, Floyd asks them to check the rigging. After a minute or so, Ed 
admits that they're not 100% sure what to look for because they've always trusted 
others to check. 

Rather than being mad, Floyd thanks him for being honest. He then carefully 
goes over all the OSHA rules and manufacturer's recommendations for for securing a 
suspended scaffold. When he's done, he asks them to take turns repeating the rules 
and demonstrating how to inspect the rigging. 

As they leave the roof, Floyd tells them again how much he appreciates them for 
not pretending to know how to do something, particularly when it could have such 
serious safety consequences. Then, Floyd is surprised when Tina thanks him for 
recognizing their value as team members and for letting them know. 
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7. FRITZ TAKES A SHORTCUT

Fritz - Mighty Mechanical Foreman 
Elliot - Mighty Mechanical Experienced worker 

Situation 

The crane operator gave Fritz, Mighty Mechanical's foreman the wire rope slings 
and shackles they will need to lift 2 HVAC units to the roof and Fritz gave them to Elliot 
an experienced worker. 

While inspecting the equipment, Elliot notices that one sling is severely kinked 
and a shackle is damaged. So he tells Fritz they should ask the crane operator for 
replacements. 

Fritz knows that getting replacements would take hours and earlier he caught hell 
from the GC about the tight timeline. So he tells Elliot to go with what they have. 

Elliot tells Fritz that he is not comfortable with the decision to proceed with the 
current rigging equipment because it will create a really unsafe situation. Fritz reminds 
him that as his foreman Elliot just needs to do what he says. 

As one of the units is lifted, the kinked sling abruptly stretches, one end of the 
unit drops 6 inches, and the damaged shackle breaks open causing the unit to fall to the 
ground severely damaging it and nearly crushing a worker. 

Outcome A 

Later, Fritz tells Elliot not to mention the damaged rigging equipment to anyone. 
Elliot is angry about Fritz's request, but he wants to keep his job. 

Outcome B 

Later, Fritz tells Elliot he was right to question his decision and says he did it 
because the GC has been pressuring him. But if that worker had been crushed 
because of his bad decision he couldn't have lived with himself. 

Fritz calls for a safety stand-down. He repeats to the crew what he told Elliot 
adding that from now on he's going to hold a daily safety huddle to discuss the day's 
tasks and how to eliminate hazards that may come-up. 

He says he has learned the hard way to listen to his crew's safety concerns and 
expects everyone to report unsafe situations. Fritz ends by saying that he doesn't want 
to lose any of them due to poor decisions, pride or ego ... some of the bad behaviors he 
displayed today. 
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TAKEAWAYS 

Foundations for Safety Leadership 

Takeaways 

• It takes COURAGE to be a leader
• It takes COURAGE to speak up
• These skills can easily be inserted into the daily workflow and

productivity will not be effected.
• Leaders ...

• Lead by example
• Engage and empower team member
• Actively listen and Practice 3-way communication
• Develop team members by teaching, coaching, and

knowing how to give constructive feedback
• Recognize team members

• Leaders improve SAFETY CLIMATE AND SAFETY OUTCOMES

134 
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HANDOUT - Checklist of Critical Leadership Skills Shown in FSL Role-Playing Scenarios 

Five Critical Leadership Skills and Actions - A Scenarios 1 2 3 4 5 6 7 
Leads by example 
Engages and empowers team members to identify and act on unsafe situations 
Actively listens and practices 3-way communication 
DEvelops team members through teaching, coaching, and feedback 
Recognizes team members for a job well done 

As you watch the role-playing scenarios, check off which (if any) critical skills and actions are demonstrated by the actors. 

Compare the results between the first and second versions of each scenario (A and B). 

Five Critical Leadership Skills and Actions - B Scenarios 1 2 3 4 5 6 7 
Leads by example 
Engages and empowers team members to identify and act on unsafe situations 
Actively listens and practices 3-way communication 
DEvelops team members through teaching, coaching, and feedback 
Recognizes team members for a job well done 



SHORT QUIZ 

Read each statement and choose the safety leadership skill that best fits each 
situation. Enter the letter in the blank. Use each skill only once. 

A) Leading by Example
B) Engaging and Empowering Team Members
C) Actively Listening and Practicing 3-Way Communication
D) DEveloping Team Members Through Teaching, Coaching, and Feedback
E) Recognizing Team Members for a Job Well Done

1. After explaining how to address a safety hazard, a superintendent asks his foreman to
repeat the steps back to him to make sure he understands his instructions. This is an
example of: ______.

2. Being safe in everything you do on the job site, also called ‘Walking the Talk’, is an
example of: ______.

3. If an apprentice identifies a job hazard and helps to come up with a solution, her
foreman should use ______ to reward her.

4. An experienced worker respectfully tells a team member why what he is doing is unsafe
and explains how he could do it more safely. This is an example of: ______.

5. At a daily safety huddle, a foreman asks for input from her team on what hazards they
may face during the day, and how they plan to avoid them. This is an example of:
______.
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lntroducti n to FastT c h dule 



Course Outline 

Essentials of FastTrack Schedule 

Module 1: Introducing FastTrack Schedule 

This module introduces you to FastTrack Schedule and explains the fundamental concepts 

behind the application. You will learn the three views of the application and what you should do 

to get started. 

a. Application Overview

b. Three Views

C. Schedule View

d. Datelines

e. Two Windows Interfaces

f. Action Columns

Module 2: Top Down Planning 

This module details how to develop a structured planning stage for your project. 

a. Project Information

b. Introduction to Work Calendars

c. Entering Data - Outline

d. Entering Bars - Durations

Module 3: Linking Dependencies 

In this module, you will learn about constraint dates, constraint types, and how to create 

dependencies between tasks through linking. 

a. Creating Dependencies

b. Constraint Columns

c. Link Tab within Information Form

d. Link Types

Module 4: Customizing Columns 

In this module, you will learn how to detail your schedule by customizing FastTrack Schedule's 

many available columns. 

a. Text Columns

b. Number Columns

c. Column Summaries and Summary Bar Values

d. Hyperlink Columns

e. Image Columns

f. Column Descriptions





Course Outline 

Module 5: Reporting (Layouts & Filters) 

This module will teach you features that will aid you in reporting data from your schedule. You 

will learn how to easily access groups of columns with the use of layouts. You will also learn how 

to search for and show specific rows of data in your schedule based on criteria you set. 

a. Understanding Layouts

b. Creating Customized Layouts

c. Understanding Filters

d. Creating Column/Value Criteria Filters

e. Creating Date/Time Criteria Filters

f. Multi-criteria Filters

g. Resource View Filters

Module 6: Baselines & Progress Tracking 

After completing this module you will know how to track the progress of your schedule using 

baseline, revised date, and actual date columns. You will also learn how to interpret the% Used 

and Status columns. 

a. Understanding Baselines

b. Progress Tracking

c. Tracking with Dependencies

d. Revised Dates

e. Percent Complete and Actual Dates

f. % Used and Status Columns

Module 7: Styles (Outlines, Rows, Bars) 

This module will show you how to define and apply formatting styles, which will help enhance 

the presentation quality of your schedules. 

a. Outline Level Styles

b. Modifying Bar Styles

c. New Bar Styles

d. Dynamic Labels

e. Timeline Graph

Module 8: Printing & Visual Enhancing 

In this module, you will learn how to visually enhance your schedule, print out your schedule, 

and export your schedules in other formats. 

a. Timeline Range Toolbar

· b. Print Preview

c. Page Options

d. Print Setup

e. Headers and Footers

f. Inserting Legends, Text Boxes, and Pictures

g. Exporting as Picture, iCal and .ics, 3
rd 

party applications

h. Additional Save Options

i. Formatting Calendar View





Course Outline 

Advanced Features of FastTrack Schedule 

Module 9: Advanced Features Introduction 

This module reviews the Essentials of FastTrack Scheduie and introduces advanced ways of 

beginning a new schedule, 

a, Recap of FastTrack Schedule 

b, Schedule View Information Form 

Module 10: Resources 

This module will teach you how to create, assign, and manage resources using the Resource and 

Schedule Views. 

a. Understanding the Resource View

b, Creating Resources 

c. Resource Information Form

d. Effort Driven and Fixed Duration

e, Assigning Resources 

f. Managing Resources

g. Resource Allocation

h. Resource Work Usage Graph

i. Resource View Filters

j. Tracking Resource Costs

Module 11: Work Calendars 

This module will teach you how to create the different types of work calendars and their use. 

a. Defining Calendars

b. Using Calendars

Module 12: Calculations 

This module will teach you how to create and use customizable calculation columns. 

a. Calculation Columns

b. Calculation Elements

c Defining a Calculation 

Module 13: Summary Graphs 

Summary graphs summarize the values currently displayed in columns over a particular period 

of time. In this module, vou will learn how to create and edit summary graphs and set them to 

display in pa�ticuiar layouts. 

a. Unde�standing and Inserting Summary Graphs

b. Formatting Summary Graphs

c. Summary Graphs in Layouts





Course Outline 

Module 14: 

FastSteps are macros with saved repetitive steps. In this module, you will learn how to create 

FastSteps and save time when building client reports, setting up status meeting printouts, and 

updated graphics. 

a. Review of Ranges, & Filters 

b. FastSteps Overview

c. Creating FastSteps

d. Working with FastSteps

Module 15: Templates 

This module will teach you how to save your schedule as a template to quickly create future, 

similar schedules. 

a. Using Templates

b. Template Options

Module 16: Consolidating Schedules 

In this module, you will learn how to easily consolidate your FastTrack Schedule files into one 

master file to analyze a big picture view of ail your data. 

a. What is Consolidation?

b. How to Consolidate

c. Schedule View

d. Resource View





Module 1: Introducing FastTrack Schedufe 

Module 1 

Introducing FastTrack Schedule 

Overview: This module introduces you to FastTrack Schedule and explains the 

fundamental concepts behind the application. You will learn about the three 

views of the application and what you should do to get started. 

a. 

b. 

C. 

d. 

e. 

f. 

Application Overview 

Three Views 

Schedule View 

Datelines 

Two Windows Interfaces 

Action Columns 
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• 
Application Overview 

FastTrack Schedule is a project management application for tracking all your projects, activities, tasks, 

resources, to-do lists, and deadlines. 

FastTrack Schedule helps you organize, track, and manage your projects by graphically representing start 

and finish dates as bars along a timeline graph. Within project management, this type of schedule is 

known as a Gantt chart, named after its creator, Henry Gantt. 

FastTrack Schedule automates the Gantt chart, making it a dynamic timeline. In addition to extensive 

graphic capabilities and customizable features, it is also a powerful database. As you draw, resize, and 

move bars along the timeline graph, it automatically updates start and finish dates, durations, 

dependencies, percent complete values, and costs. 

To enter an activity you can draw a bar directly on the timeline graph and have FastTrack Schedule enter 

the duration and dates for you, or you can enter the duration or the dates in columns and have 

FastTrack Schedule draw the bar for you. 

In fact, everything you can do to an activity bar can be done with your mouse and the tools in FastTrack 

Schedule's Toolbars, or by editing values in columns. This flexibility allows you to concentrate on the 

activities you are scheduling, instead of the act of scheduling those activities. 

Notes: 

Throughout this training guide you will see a notes box just like this one. 
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Module 1: Introducing FastTrackScheduJe 

Three Views 

FastTrack Schedule has three views. Each view is designed to complement different aspects of your 

overall project. 

Schedule View 

This is the primary View of FastTrack Schedule; all 

other Views support the Schedule View. It is in this 

View that you enter activities; draw activity bars 

along a timeline; link bars; view critical paths; track 

the Scheduled, Revised, and Actual dates and times 

of tasks in your schedule; insert pictures, text boxes, 

and legends; and create and view summary graphs. 

Calendar View 

The Calendar View displays information from the 

Schedule View in the traditional look of a wall 

calendar. This allows you to view time vertically 

rather than horizontally, as you do in the Schedule 

and Resource Views. You can view and print 

completely customizable calendars that can be 

filtered to display only those activities you want to 

see. You can also create a calendar of any number 

of contiguous weeks. 

Resource View 

In this View you track and manage the use of 

resources in your project. You can see exactly to 

what tasks your resources are assigned, what 

percentage of their total available time is being 

used, and how many hours they are working in a 

given unit of time. 

In this View, you can create resources, move bars in 

the timeline, and change the Scheduled, Revised 

and Actual dates of tasks. 
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• Module 

Schedule View 

This is the primary View of FastTrack Schedule and should be understood first. Breaking this view into 
its different components makes it easier to understand. 

Columns 

FastTrack Schedule stores columns in three distinct ways. Columns for the Schedule View are stored 
either per row or per bar. Since multiple bars per row is supported, data in the rows either belong to the 

row or belong to the bar. Columns for the Resource View are stored per resource row. 

Every column in the Schedule View and Resource View is application-defined. Columns are hidden until 
you choose to insert them into a layout. No column can truly be deleted and the Column Map can help 

you keep track of which of the hundreds of available columns you have inserted and, possibly, renamed. 

You change the look of your schedule by showing, hiding, and arranging columns. Groups of selected 

columns are called Layouts. 

Rows 

Rows, which are found in the Schedule View, contain all of the information pertaining to a particular 
activity. Summary Rows are rows that have sub rows. To view summary bars in summary rows, select 

Summary Bars from the View Menu. 

Timeline Graph 

In the Schedule View, the timeline graph is the grid of horizontal and vertical lines on which activity bars 

sit. In the Resource View, the timeline is the grid of horizontal and vertical lines on which assigned 
activity bars and resource graphs sit. The timeline can represent any range of time you determine, in 

units of hours, days, weeks, months, quarters, and years . 

. 6eiilline 
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Module 1: Introducing FastTrack Schedule 

Datelines 

A dateline is a way to graphically highlight, in the timeline, a date and time key to your schedule. You 

can choose to hide or show datelines in the timeline, and you can format each dateline's appearance. 

Adivi'ty.i 

.A.cti;;ity 3 

. Activity 4 

Activity 5 

Deadline 

Notes: 

To format a Dateline: 

1. Go to the Format menu > Datelines.

2. Under Dateline Display, select from the options described below.

3. Click OK to apply your changes and close the dialog

Thi$0ption: 

Allows you to display the following: 

- Dateline

Dateline - Project Start Dateline

- Project Finish Dateline

- Up to 10 custom datelines

I 
Projfi:1.Fil'lish.<�tc 

Show Dateline When selected, displays the selected dateline in the Schedule View. 

Color and Size 

Auto Update Every 

Set Date/Time To 

Allows you to format the appearance of the selected dateline. 

Allows you to determine how often the Dateline should update. 

Allows you to enter a static date and time that does not change 

unless you choose another date. 

The Dateline can move in real time by Auto Updating per the options you set. Custom datelines and the Dateline can also be 

set to appear in the timeline on the static date and time which you set. The locations of the Project Start and Finish datelines 

are determined by the activity data in your schedule. 
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• Module 1: 

Two Windows Interfaces 

The Ribbon Bar 

The ribbon interface replaces menus with tabs. From each tab you can access grouped controls that 

allow you to perform all the program functions. In FastTrack Schedule the View group, from which you 

can switch between the three program views, is available on every tab. There is only one menu, the 

Application menu. 

1. Application Button - displays the

application menu which lists controls

used to perform actions on the entire

document.

2. New - opens the Getting Started dialog.

3. Open - open an existing FastTrack

Schedule file.

4. Import - import data, iCalendar files

and MindJet MindManager files.

5. Save - saves the file to its existing

location.

6. Save As - save the active file with a new

name or to a new location or as a

template.

7. Print - print the open view, open the

Print Preview window, set print and

page options.

8. Prepare - open the properties dialog

and set password restrictions for the

active file.

9. Send To - sends the active file as an

attachment or as a picture in an email.

10. Publish - publish a file to an iCalendar

server, unpublish an iCalendar file, view

the publish log.

.. Ctrl+O 

'\- t:j Import 

!ii,- Id.I Save Ctrl+S 

"1· II Save As... I ► 

7r ii Print... I► 

Iii; � Prepare 

Business Startup.ft• 

Corporate_Req,ding.fts 

Meeting • Ennt l'lanning.fts 

Multiple Homes.Its 

11. Export - export the active file as data, HTML, an mpx file, a Microsoft Project XML file, an iCalendar file, a

MindJet MindManager file or a picture.

12. Close - close the active file or close the Print Preview window.

13. Application Options - set options for FastTrack Schedule.

14. Document Options - set options for the active file.

15. Exit FastTrack Schedule - closes the program and all active FastTrack Schedule files.

16. Recent Documents - view a list of all recently opened files.

17. Quick Access Toolbar- always visible, click the icons in this toolbar to quickly save, undo, redo, open existing

schedules, open new schedules, and open the Print Preview window.
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Module 1: Introducing FastTrackSchedule 

Home tab 

1 

1. 

2. 

3. 

4. 

5. 

6. 

7. 

8. 

9. 

Views Group - switch between the Schedule, Calendar and Resource Views. This group is available on every 

tab of the Ribbon interface. 

Clipboard Group - cut, copy and paste selected items. 

Font Group - edit font name, size, color, appearance and alignment of text. 

Outline - indent, outdent, show, hide and view activity outline levels. 

Tools Group - arrow (select), draw bar, draw link, revise, % complete, text tools. 

Link Group - create and remove dependencies. 

Bar Styles Group - select and edit bar styles. 

Editing Group - find and replace text, go to Today's date or a specific bar or row, hide, show or select all. 

Timeline Range Group - determine the visible range of time in the timeline graph 

Insert tab 

1. Rows & Columns Group - insert new rows or columns into your schedule.

2. Timeline Elements Group - insert text boxes, legends, pictures, pointers and objects into your schedule. Add,

edit or remove Summary Graphs, Timescale rows and Datelines.

3. Page Group - insert Headers and Footers to the printed document and page breaks to the selected row.

Format tab 

l 

1. Display Group - open the format dialog to determine the display of: bar styles, critical path, links, datelines,

headers, footers and selected items.

COPYRIGHT'\') 2010, 
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View tab 

1. Show/Hide Group - show or hide action columns, datelines, links, critical paths and the alignment grid.

2. Resources Group - show or hide the Percent Work Usage, Work Usage and Assignments summary rows for

resources. Percent Work Usage is the only resource summary row that can display in the Schedule View. No

summary graphs can display in the Calendar View.

Project tab 

1. Details Group - open information forms to edit data regarding: the Project as a whole, activities and

resources. Open the Work Calendar for the project and establish a WBS (work breakdown structure) to

establish a hierarchy of tasks.

2. Timeline Group - quickly set the timeline range to show all bars in the schedule. Define, edit and select ranges

of time to view in the timeline. Change the units in which you view time in the schedule.

3. Layout Group - define, edit and select schedule layouts.

4. Sort & Filter Group - define, edit and select sorts and filters to view a specific subset of data in your schedule.

Restore the order of sorted data and unhide any data hidden by a filter.

Tools tab 

1. Proofing Group - correct spelling in the entire open View or specified parts of the schedule. Set the spelling

options.

2. Macro Group - create, edit and run FastSteps scripts.

3. Consolidation Group - determine the files to consolidate and define the parameters of the consolidation.

Update data in files you've consolidated.

4. Tracking Group - define and edit baseline, revised and actual activity dates and times. See how your custom

column names map to their original program-defined names.

5. Shift Group - shift items or the whole schedule backwards or forwards in time.

6. Arrange Group - arrange overlapping items, set snap to grid, and column row and selecting auto fit options.
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• Module 1: lntroducing,FastTr:a� 

1. Product Group - access helpful websites and open the program's About dialog.

2. Help Group - get help using the program with tutorials, example files and keyboard shortcuts.

3. Workspace Group - manage the look and feel of your workspace, and switch your theme from Ribbon to

Classic Menu.

4. Window Group - determine how multiple open FastTrack Schedule windows will display.

The Classic Menu Bar 
For users who like the classic menu and tool bar look, you can easily switch to it. 

In the Ribbon, go to the Application tab > Themes > Classic Menu Bar. You must relaunch the application for 

changes to be applied. 

To switch from Classic to Ribbon, go to View menu> Themes> Ribbon Bar. You must relaunch the application 

for changes to be applied. 

A
r

ial 

/25{2JJJD 

1. Standard Toolbar - open new and existing FastTrack Schedule files, save print, open Print Preview, check

spelling and format the selected item.

2. Outline Toolbar - indent, outdent, show, hide and view activity outline levels.

3. Layouts Toolbar - define, edit and select schedule layouts.

4. Filter and Sorts Toolbar - define, edit and select sorts and filters to view a specific subset of data in your

schedule. Restore the order of sorted data and unhide any data hidden by a filter.

5. Fonts Toolbar - edit font name, size, color, appearance and alignment of text.

6. Views Toolbar - switch between the Schedule, Calendar and Resource Views.

7. Tools Toolbar - arrow (select), draw bar, draw link, revise,% complete, text tools.

8. 

9. 

Link Toolbar - create and remove dependencies. 

Bar Styles Toolbar - select and edit bar styles. 

10. Timeline Range Toolbar - quickly set the timeline range to show all bars in the schedule. Define, edit and

select ranges of time to view in the timeline. Change the units in which you view time in the schedule.

1:9 
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Action Columns 

FastTrack Schedule's Action Columns simplify working with activities and resources. The Action Columns 

can be displayed to the left of the columns in the Schedule. They simplify operations performed on rows 

and outline levels. 

Activity 1 

Activit
y 

2 

Row Number/Select Row 
Clicking here selects the row for moving, deleting, copying, cutting, formatting, and hiding. 

liiill 

Page Break n 
Clicking here makes the corresponding row the last row on a printed page. It forces the next row to print 

on a new page. 

Information Form 8 
Clicking here opens the Information form in the Schedule View and the Resource Information form in 

the Resource View. The Information forms display data about the activities and resources in the row. 

ii This calendar icon will appear within the Information Form action column of an activity which has a 

Task Calendar applied, different from the standard project calendar. More information on Task 

Calendars can be found in Module 11: Work Calendars. 

This icon will appear within the Information Form action column of an activity which has data 

entered in the Notes column. 

Expand/Collapse �:t 

Clicking here collapses and expands outline levels in the Schedule View and subrows in the Resource 

View. 

1:10 
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Module 2: Top Down Planhing 

Module 2 

Top Down Planning 

Overview: This module details how to develop a structured planning stage for 

your project. 

a. Project Information Form

b. Introduction to Work Calendars

c. Entering Data - Outline

d. Creating Bars - Durations

2:1 
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• 
Project Information Form 

The Project Information form allows you to define the project's start date and time and view the finish 

date and time. The Project Finish Date is defined by the latest activity bar's finish date and time. 

The "project" is a subset of the data in your schedule determined by your definition of the Start Date. 

Thus, there can be data scheduled before the Project Start Date. 

To define the Project Start Date: 

1. Go to the Project menu > Project Information.

2. Select which Calendar the project should use as default.

3. Use the controls to set the Project Start Date and Time.

4. Click OK to close the dialog.

5. The Project Start Date dateline will now display as a vertical line in the timeline on the date and

time you have specified.

Project Calendar 

Select the work calendar that best fits the available days and time for scheduling activities for the 

project. 

Standard (Project Calendar) 

The default Project Calendar. This Standard calendar is defined as a typical Monday - Friday, 40-hour 

work week. This can be modified to fit company's own typical work week. 

24 Hours 

Used when tasks in a project can occur 24 hours in a day. 

Night Shift 

Activities are mostly conducted at night. The Night Shift calendar is defined as a late evening - morning 

shift. This can be modified to fit company's own night shift. 

2:2 
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Module 2: Top Down Planning 

Work Calendars 

Work Calendars allow you to define the available time for activities to be scheduled. You may define 

work hours for typical and non-typical work days, as well as non-work periods for your schedule. Non

work periods are times when activities cannot be scheduled, for example, holidays, weekends, and after 

hours. 

To modify predefined work calendars: 

1. Go to the Project menu > Work Calendars

Element:···. 

Calendar 

Base Calendar 

Typical Week Day 

Specific Day 

Work Shift Details 

Create Exception 

Selected calendar's name. "Project Calendar" will appear if it is the applied 

calendar in Project Information. 

If applicable, the selected calendar's base calendar appears here. Typically, a 

resource's calendar will have a base calendar of the company calendar or a 

country's calendar. When changes are made to a calendar which is being used 

as a base calendar, the changes will also be applied to the calendars using it as 

a base calendar. 

Allows you to set up a work schedule in which each day of the week might have 

different hours, for instance, a Friday might differ from other days. 

Allows you to define specific days of the year that deviate from the typical days. 

A specific day can have its own set of hours. 

Defines the Start and Finish Times for a typical or specific day. 

Allows you to define a specific day's work hours or account for holidays or 

events that occur over weekends. You may also provide a brief description for 

the exception. 

Once a Work Calendar is defined, it is used to drive when activities are scheduled. A Work 

Calendar can be applied as the calendar for the project, an activity, a resource or a link. 

Each schedule has its own Work Calendars. You can, however, copy and paste a Work Calendar 

from one file to another file if you would like to use an existing work calendar's arrangement. 
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Entering Data 

Data can be entered simply by clicking in any column and then typing. Using a top down design for data 

entry will help you be more organized. Top Down design refers to a method or procedure that starts at 

the highest level of abstraction and proceeds toward the lowest levei. The higher levels are usually 

names of phases and the lower activities are the details that make up each phase. 

Outlining activities 

In the Schedule View, outlining activities creates a hierarchy of activity levels; for instance, projects, 

phases, activities, and sub activities. By indenting and outdenting activity names, you can create as many 

outline levels as you would like. Once outlined, activity levels can be collapsed and expanded to show 

different levels of detail. 

To indent an activity underneath another activity: 

1. Click on the Activity Name cell of the row you wish to indent. The cursor must be to the left of the

text (not at the end).

2. In the Outline Tool bar, click the Indent button.

-or-

Press the Tab key on your keyboard.

To outdent an activity by moving it to the level above: 

1. Click on the Activity Name cell of the row you wish to outdent. The cursor must be to the left of

the text (not at the end).

2. In the Outline Tool bar, click the Outdent button.

-or-

Press the Backspace key on your keyboard.
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Entering Bars 

Using Duration column to draw activity bars and milestones 

Entering values in the duration column creates an activity bar in the timeline graph. The start of the bar 

will draw on the Project Start Date, which is defined in the Project Information dialog. You can also type 

in the Start Date and a Finish Date columns; however, using the duration column is recommended if you 

plan to create dependencies between tasks. 

Notes: 

To draw an activity bar by typing: 

1. Make sure the Duration column is displayed. If not, go to Insert menu > Column > locate Duration

2. If entering a new bar, select a bar style from the Bar Styles Toolbar.

3. Click in the Duration column intersecting the Activity.

4. Enter or edit the duration value.

5. Press the ENTER key to move to the next row.

To draw a milestone by typing: 

1. Select a milestone style from the Bar Styles Toolbar.

2. Click in the Duration column intersecting the Activity.

3. Enter a value of 0.

4. Press the ENTER key to move to the next row.

6.oo · ·' -31-1,-10-· ···--·-3m11if

Activity 2 

Activity 3 

Activity 4 

Activity 5 

"" "'" '""'·�--

•~••M•-•w~-� 

t-�

--1-,,·,~"·~·-

I 
I 

"�•OM 

__ ,,,,�' 

Phase A complete 

5.00 

4.00 

2.00 

5.00 

0.00 

3/1/10 

3/1/10 

3/1/10 

3/1/10 

3/1/10 

3/1/10 

3/8/10 

3/5/10 

3/5/10 

3/1/10 

The Duration is entered as the number of units you estimate the activity to last. For instance, if the schedule is displaying 

durations in units of Days, entering "4" in the Duration column draws a bar beginning on the project start date and ending four 

work days later. 
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• 
Changing the schedule duration units 

FastTrack Schedule allows you to view duration in different units of time. This allows you to view the 

length of an activity bar in calendar or work hours, days, weeks, months, quarters, or years. For 

instance, if the schedule shows durations in units of Weeks and you want to see durations in units of 

Days instead, you can go to Tools menu> Document Options to change the duration units. Your changes 

affect values in all Duration columns: (Scheduled) Duration, Revised Duration, and Actual Duration. 

I a.oo�I Hoursper day 

1 40.00�1 Hoursperweek 

I 22.00 �I Days per month 

Lag/Lead Calendar: 1 Standard (Project Calendar) 

Units 

Defaults 

Duration Units: '-I D_ays ___ i]_

D Fixed durations scheduling when creating new bars 

D Ignore resource calendars when creating new bars 

Wotic Units: .._I Hours __ �[ii_J

� .Apply elfort�en scheduling when making assignments to bars 

Calendar units are based on a 24 hours a day 7 days a week model, which allows you to schedule tasks 

anywhere within those parameters. An activity lasting one calendar day has a duration of 24 hours, 12 

AM to 12 Midnight. An activity lasting one work day has an 8 hour duration, 8 AM to 5 PM (with a one 

hour break), or the length of time you have defined for a work day in the Work Calendar. 

To view durations in a different unit of time: 

1. Go to Tools> Document Options.

2. Project tab.

3. From the Duration Units value list, select the desired unit of time.

4. Durations will be calculated in the unit chosen from the value list.

Calendar Calculations 

When entering data as one duration unit and then switching to display the values as another unit, these 

calculations will be used. 

Lag/Lead Calendar 

Define default calendar for links to calculate lag/lead time. 
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Module 3 

Linking Dependencies 

Overview: In this module you will learn about the constraint types, constraint 

dates and how to create dependencies between tasks through linking. 

a. Creating Dependencies

b. Constraint Columns

c. Link Tab within Information Form

d. Link Types

3:1 
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• 
Creating Dependencies 

Linking is a means of controlling how changes to the dates and times of one activity impact the 

scheduling of other activities in your schedule. To link is to create dependencies between activities in 

your schedule. 

For example, if you were scheduling a construction project and a key activity, such as framing, were to 

slip, then all the projects that can only occur when framing is done, such as drywall, plastering and 

painting, will all need to be rescheduled accordingly. By linking all these activities in your schedule, you 

save yourself from having to manually change each affected activity. 

Linking in FastTrack Schedule is based on the CPM (Critical Path Method) project management model 

and follows the standards therein. 

Use constraints and lag/lead time to control how activity bars and milestones react to changes in the 

originally scheduled dates and times. 

12 
1.3 

user tntertace Design 

Define Database lnput,Outptrt 
1 .4 Review Functional and Procerural 
1 5 Create Profotype · · ·· · 

' � . . . . .... . ... . 

1.6 Define Caktllation Requirements 
2 ° Documentation 

2.1 DOOJmentProcedures and References 

2 2 Capture Screens: and output Examples 
2.3 Technical Review and Edit 
2 4 Pnnt Documentation 
2 5 Create Sample Data wrth Tutorial 

10/15/10 11/25/10 

5/3110 + 5128110 
8130/10 ' 9/20/10 
9120/10 10/18/10 
10'18110 12120/10 
513/10 5/21/10 

lliililiiiiiillilllllllliiilllilllllllliiilliiliiilliliL __ .......... _ ...... . 

··'-·--· . .)··--· ·t l ·-•-···· ............... . . ·���iiiii 

When setting up task dependencies, consider that there may be scenarios where certain tasks are 

unable to start until their predecessor tasks have completed. In other cases, a task may need to start 

before its predecessor task is completed. In these descriptions, a task will need to consider its Lag or 

Lead (Lag/Lead) duration: 

Lag 

A unit of duration used as a delay between two tasks. Lag durations are entered as positive values. An 

example of this could be the predecessor task of pouring concrete prior to the successor task of building 

a house. If the concrete takes 2 days to cure and dry, the dependency link would require a lag of 2 days. 

Lead 

A unit of duration used to provide an overlap, or "head-start", between two linked tasks. Lead 

durations are entered as negative values. An example of this could be the predecessor task of 

completing the shooting of a film, with a finish to start dependency on a successor task of editing film. If 

editing film can begin 7 days prior to the end of completing the shooting of a film, then the dependency 

link would require a lead of -7 days. 
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Module 3: Linking Dependendes 

Constraint Columns 

Constraints are the parameters you can assign to activities to control the behavior of bars as your 

project changes. Constraints in FastTrack Schedule are based on the CPM (Critical Path Method) project 

management model and follow the CPM standards. 

A constraint categorized as Soft will allow activities in your schedule to begin and end within an elastic 

window of time, until the activity's start or finish comes into conflict with another dependency. 

A constraint categorized as Moderate will not allow activities in your schedule to begin or end before or 

after the date or time you have specified as a Constraint Date and Time. 

A constraint categorized as Hard will not allow activities in your schedule to begin or end on any date or 

time except those which you specified. A hard constraint effectively locks your bar's finish or start and, if 

the bar is linked, bypasses the defined dependency if that dependency conflicts with its specified start or 

finish. 

, _ ,- .·; . __ . _ _ _ ___ • . .  _ . .  · _ ----• 

cJn�tai�t'itarnJ: 

As Soon As Possible Soft 

As Late As Possible Soft 

Start On Or After Moderate 

Start On Or Before Moderate 

Finish On Or After Moderate 

Finish On Or Before Moderate 

Must Start On Hard 

Must Finish On Hard 

COPYRIGHT(,::) 2010, 

The activity is scheduled to begin at the earliest possible moment, 

taking into account other scheduled activities. There is no specified 

Constraint Date, however the Project Start Date often acts as the 

Constraint Date. This is the default constraint type when bars are 

created by entering the Duration. 

The activity is scheduled to begin at the latest possible moment, 

taking into account other scheduled activities. There is no specified 

Constraint Date. 

The activity is scheduled to begin no earlier than on the Constraint 

Date you specify. If necessary, it may begin later. This is the default 

constraint for new activities that are created by drawing bars using 

the Draw Bar tool. 

The activity is scheduled to begin no later than on the Constraint Date 

you specify. If necessary, it may begin earlier. 

The activity is scheduled to end no earlier than on the Constraint Date 

you specify. If necessary, it may end later. 

The activity is scheduled to end no later than on the Constraint Date 

you specify. If necessary, it may end earlier. 

The activity will only begin on the specified Constraint Date. 

The activity will only end on the specified Constraint Date. 
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• 
Setting bar constraints 

Constraints are the parameters you can assign to activities to control how much or how little slippage 

you will allow in their Start Dates and Times. 

To set constraints on an activity: 

1. Double-click on the activity bar or milestone.

The Information form opens to the Bars> Tracking tab.

2. From the Constraint Type value list, select the desired constraint type.

-or-

1. Insert the Constraint Type, Constraint Date and, if needed Constraint Time columns into your

schedule.

2. Enter the appropriate data into the Constraint Date and/or Constraint Time column.

3. Click in the Constraint Type column and use the value list to select the desired constraint type.

Link Tab within Information Form 

The Bars> Links tab of the Information form allows you to set and modify important link information. 

You can create links by opening the Information form for a particular bar and then entering information 

about the predecessor and successor bars to which you want to link that bar. 

Predecessor Bar -the predecessor bar is the "From" and the bar whose information you are currently 

viewing in the Information form is the "To." So if a link in the Predecessors table is classified as Type 

"Finish to Start," the link originates from the Finish point of the predecessor bar. 

Successor Bar - the successor bar is the "To" and the bar whose information you are viewing in the 

Information form is the "From." So if a link in the Successors table is classified as Finish to Start, the link 

extends to the Start point of the successor bar. 

The labels predecessor and successor have nothing to do with a bar's location in the timeline or its 
dates. The terms relate only to the From/To direction that defines a link's Type. 

1 Successors 

Row 

o 70

Bar 

328 328-Walls 

Bar Style I ww:emr

/\divity Name 

3:4 

Twe _ : �--· yni< Duration 
RnisMo-S!art {FS) 0 00 0.00 

,!l'.':'! 
Flnish1o-Start (FS) 

�/Lead 
200 

Link Duration 
2.00 i 
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Module 3: linking Dependencies 

Below is an explanation of each column in the Predecessors and Successors tables located in the Bars> 
Links tab of the Information form. You can edit directly into this form to create dependencies, define link 
type, lag/lead, etc. 

>tri this tolumri:

Row 

Bar 

Activity Name 

Type 

Lag/Lead 

Link Duration 

Link Types 

Click the icon to open the Information form for the activity bar. 

Enter or edit the row number of the predecessor or successor bar. 

Enter or edit the Bar ID of a bar you want to be linked from (predecessor) or linked 

to (successor). 

View the activity name of the predecessor or successor bar. When you have 

entered a Bar ID and/or Row number, the name of the activity is filled in. Once it 

appears in the cell, you can edit the activity name of a predecessor or successor 

bar. 

Select the origin and destination of the link. FastTrack Schedule supports Finish-to

Start, Finish-to-Finish, Start-to-Start, and Start-to-Finish links. 

Enter or edit the lag/lead time for this link. This is the required minimum number 

of duration units between the two activities, relative to the Link Type. See Page 3:2 

for definition. 

This is the number of duration units of the link. 

FastTrack Schedule supports four types of links - Finish-to-Start, Start-to-Start, Finish-to-Finish, and 

Start-to-Finish links. 

This linktype: looks like this: And work$ thisway-: 
. ·  

I ·1 I Activity 1 must finish before Activity 2 starts. This is the 
Finish-to-Start -

i
l 2 l most commonly used link type. 

1 

Start-to-Start 
l 2 I 

Activity 2 must not start until Activity 1 starts. 

! 1

Finish-to-Finish Activity 2 must not finish until Activity 1 finishes. 
r-- L I 

I l I
Activity 2 must not finish until Activity 1 starts. Start-to-Finish 

z 1 

Linking activity bars 

Bars can only be linked in the Schedule View. Linking activity bars creates a dependency from a point on 

one bar (the "predecessor") to a point on a second bar (the "successor"). This dependency illustrates the 

relationship that the dates of one task have to another. 
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Module 3: Linking Dependen�tes 

For instance, if the start of the task "Interview for Position" cannot begin until the task "Read Resumes" 

has ended, the two are dependent and should be linked with a Finish-to-Start relationship. 

To link bars: 

1. From the Toolbox, select the Draw Link tool.

2. Click the finish or start of one bar and drag to the start or finish of a second bar.

-or-

1. Using the Arrow tool, select the two (or more) bars you want to link.

To select multiple bars, you can hold down the Shift key and click on desired bars.

2. From the Edit menu, select Link.

Link is also accessible by context-clicking (right-click) on one of the two selected bars.

-or-

1. Double-dick an activity bar.

2. In the Bars> Links tab of the Information form, create a link by entering data in either the

Predecessors or Successors table.

Choosing Link from the Edit menu (or Link Bars tool) automatically draws links from the finish point to 

the start point of the selected bars. Every time this tool is used, it will draw a Finish-to-Start link. You can 

also define Finish-to-Finish, Start-to-Start, and Start-to-Finish links via the Link Information dialog or 

Information Form > Bars> Links tab. 

To apply a different Link Type, you can double-click on the link drawn on the timeline graph. The Link 

Information dialog will appear: 

Lag/Lead Calendar 

Select the work calendar to use to calculate lag/lead duration. You can even specify to calculate based 

on the predecessor or successor calendar. 

Follow Document Preference 

This preference is defined in Tools menu> Document Options. The calendar that is selected in 

Document Options is the default calendar that will be used to calculate lag. You may also apply a 

different calendar for each link as appropriate. 

Critical Path 

To view the critical path of your project, go to the View menu > select Critical Path. The links between 

activities on the critical path should display in red (or a different color selected). 
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Module 4: Customizing Columns 

Module 4 

Customizing Columns 

Overview: In this module, you will learn how to detail your schedule by 

customizing FastTrack Schedule's text, number, hyperlink and image columns. 

a. Text Columns

b. Number Columns

c. Column Summaries and Summary Bar Values

d. Hyperlink Columns

e. Image Columns

f. Column Descriptions

4:1 
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• 
Text Columns 

Inserting columns that are currently hidden allows you to see different views of your data. Although you 

may not see all of the columns when you first open the application, all of the columns are available to 

insert at any time. 

Texl2 

Text 3 

Texl4 

Texl 5 

Text6 

Text 7 

Text8 

Text9 

Texl 10 

Text 11 

Text 12 

Teod 13 

Texl 14 

Text 15 

Text 16 

Teod 17 

To show, or insert, a hidden column: 

1. Select the column heading to the left of the intended position.

2. Go to Insert menu> Column.

3. Select the name of the column you wish to show from the Column Display Name table. By

holding down the Control key, you can select multiple column names in the table.

4. Click OK to insert the selected column and close the Insert Column dialog. The column now

displays in your schedule.

Notes: 

The Column Display Name table contains all existing but hidden columns. If the column you want to insert is not listed, it is 

already shown. You may have changed its name. 
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Formatting Text Columns 

Changing the display of values in the column allows you to customize the appearance of the data it 

contains. For instance, you could add a Custom Value List that contains only the values that you want to 

allow in the column. 

To format the Value List in a column: 

1. Select the column heading of the column you want to format.

2. Go to the Format menu> Column.

3. Select the Value List tab.

4. Use the available options to format the Value List of the selected column's data.

5. Click OK to apply your changes and close the Format Column dialog.

0 No Value Ust 
@ Custom Value Ust 
0 ExpressDate Calendar 
0 Express Tme Clock 

D Restlicl column to tern in the value ust 
D Append 010ice as List 

Restrict column to item in the value list 

fmew¥6mfe¥:Ww :17+e,J lerwn&rtr Mf�ff1tttttrr1J

L'f0ww:£deete,r-vst;;J hwttHtmftm;,.,J 

ler1MnrWr:6t?PiP%1WJ brrW£ & @Ytt;J 
Value Ust 

Selecting this option will prevent users from manually typing in values in the column that do not exist in 

the defined Value List. 

Append Choice as List 

Selecting this option will append added values to existing values in the column. If this option is not 

selected, added values will replace existing values in the column. 

Build from Column 

Easily create a value list using existing values in the column by clicking on this button. 
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• 
Number Columns 

To show, or insert, a hidden column: 

1. Select the column heading to the left of the intended position.

2. Go to Insert menu > Column.

3. Select the name of the column you wish to show from the Column Display Name table. By holding down

the Control key, you can select multiple column names in the table.

4. Click OK to insert the selected column and close the Insert Column dialog. The column now displays in

your schedule.

Formatting Number Columns 

Number 1 

Number2 

Ntrnber3 

Ntrnber4 

Number5 

Number6 

Number7 

Number3 

Number9 

Ntrnber 10 

Number11 

Number 12 

Number 13 

Number14 

Number 15 

Number 16 

Number 17 

Number 18 

[i}

Changing the display of values in the column allows you to customize the appearance of the data it 

contains. For instance, you could change the display of a Number column so it displays a dollar sign, 

comma separator, and two decimal places. 

To format the display of data in a column: 

1. Double-click on the column heading of the column you want to format

2. Select the Display tab. If display options are available for that column, they will appear.

3. Use the available options to format the display of the selected column's data.

4. Click OK to apply your changes and close the Format Column dialog.

Notes: 

Each column is predefined to display certain type of data. You cannot change the type of data displayed in columns. 
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Column Summaries and Summary Bar Values 

All columns have a Summaries tab. Within this tab, there are two types of summaries: Column 

Summaries and Summary Bar Values. Both types of summaries allow you to calculate Count, Total, 

Average, Minimum, Maximum, and Standard Deviation. 

Column Summaries are displayed on the schedule at the bottom of the formatted column. They 

calculate all data displayed in the column. 

Summary Bar Values are displayed in every summary row intersecting the formatted column. The value 

is derived from the subrows or 'children' of the summary row. 

To format the Summaries of a column: 

1. Double-click on the column heading of the column you want to format.

2. Select the Summaries tab.

3. Use the available options to format the summaries of the selected column's data.

4. Click OK to apply your changes and close the Format Column dialog.

Column Summaries 

□Count 

�Total 

□ Average

Label Display

□ Minimum

□ Maximum 

□ Standard Deviation 

Do Not Show Label 

(Uses Column Justification} 

Show Label 

(Ignores Column Justification) 

Short Label 

Example: 

Q Medium Label 

®Long Label 

Total: 10.00 
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Hyperlink Columns 

Hyperlinks allow you to launch a file or URL address from within the Schedule or Resource Views of 

FastTrack Schedule. Insert a hyperlink column into a Schedule View layout to display hyperlink values. 

Entering and editing hyperlinks 
Hyperlinks are entered and edited in the Define Hyperlink dialog, accessed through the Information 

form or the hyperlink column. Hyperlinks display as blue underlined text. 

To enter a value in a hyperlink column: 

1. Insert menu > Column > select Hyperlink column.

2. Right-click (Context-click) on the empty space in the hyperlink column.

3. Select Edit Hyperlink. The Define Hyperlink dialog opens.

4. Select from the options described below.

Use this option: To do this: 

Type or paste text in the Display Name box. The text 

you enter here will display as hypertext in the column in 

Display Name lieu of the full path or address. For instance, you can 

have "AEC Homepage" display rather than 

"www.aecsoftware.com". 

File or URL 
Type or paste text in the File or URL box or use the 

Browse button to enter the exact path to a file. 

Launch URL 
Click the Launch URL button to test your links before 

entering them. 

5. Click OK to close the Define Hyperlink dialog.

Launching a file or URL address 
To open a file or URL (internet address) that is defined by the value in a hyperlink cell, click on the value 

in the hyperlink-defined column. 

Notes: 

For a successful launch, files must be entered as a complete path locally or on the network, not simply the file name. 

If you click a hyperlink with the path "c:\My Documents\letter.doc," Microsoft Word opens and then the "letter.doc" file opens 

(assuming files with the '.doc' extension are set by default to open with Microsoft Word). 
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Image Columns 

For schedules that require graphics within columns, use the available Image columns in FastTrack 

Schedule. There are ten Image columns in the Schedule View and ten Image columns in the Resource 

View. 

To insert and edit an Image column: 

1. Go to Insert> Column > select Image column

2. Once Image column is inserted into view, right-click (context-click) on the empty space in the image

column.

3. Select Browse for image

4. Locate the desired image and select Open

�rt c"i"l, Photos& /\rf,,"'rk 

Firat Draft Due Date 

image Size: 280 x 280 

When hovering over image within the column, a larger size of the image will be displayed. 
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Column Descriptions 

% Complete NUMBER 

% Used NUMBER 

Activity Name TEXT 

Activity Row ID ID/CODE 

Activity Row Number ID/CODE 

Actual Duration DURATION 

Actual Finish Date DATE 

Actual Finish Time TIME 

Actual Start Date DATE 

Actual Start Time TIME 

Attendees TEXT 

Bar ID ID/CODE 

Bar Row ID ID/CODE 

Baseline Cost 1 -10 COST 

Baseline Duration 1 -10 DURATION 

Baseline Finish Date 1 -10 DATE 

Baseline Finish Time 1 -10 TIME 

Baseline Start Date 1 -10 DATE 

Baseline Start Time 1 -10 TIME 

Baseline Work 1 -10 WORK 

Calculation 1 -100 CALCULATION 

Constraint Date DATE 

Constraint Time TIME 

Constraint Type ID/CODE 

Cost 1-10 COST 

Critical FLAG 

Date 1-10 DATE 

Duration 1 -10 DURATION 

Early Finish Date DATE 

Early Finish Time TIME 

Early Start Date DATE 

Early Start Time TIME 

Percentage of activity completed 

Percentage of a resource's time used 

Project tasks/activities 

ID to identify row 

Number to identify row 

Duration of time it actually took an activity to be completed 

Date on which an activity actually finished 

Time activity actually finished 

Date activity actually started 

Time activity actually started 

iCal/Outlook event attendees 

Unique identifier for bar 

Unique identifier for bar row 

Capture activity costs at up to 10 points in time for the lifetime 

of the project 

Capture activity durations at up to 10 points in time for the 

lifetime of the project 

Capture activity finish dates at up to 10 points in time for the 

lifetime of the project 

Capture activity finish times 

Capture activity start dates 

Capture activity start times 

Capture activity work 

Define a formula to calculate data from the schedule 

Date to be used with constraint type 

Time to be used with constraint type and date 

Parameter applied to activity to control its behavior as project 

changes 

Formatted to display monetary values 

Yes/No - Yes indicates that the activity is on the critical path 

Formatted to display dates 

Formatted to display durations 

Earliest date activity can finish 

Earliest time on Early Finish Date activity can finish 

Earliest date activity can start 

Earliest time on Early Start Date activity can start 
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Effort Driven 

Finish Date 

Finish Date 1 - 10 

Finish Float 

Finish Time 

Finish Time 1 - 10 

Fixed Cost 

Fixed Duration 

Flag 1 - 20 

Free Float 

Hyperlink 1 - 10 

Ignore Resource 

Calendars 

Image 1- 10 

Late Finish Date 

Late Finish Time 

Late Start Date 

Late Start Time 

Location 

Notes 

Number 1 - 50 

Parent Tree 

Predecessors 

Priority 

Resource Cost 

Resources Assigned 

Revised Duration 

Revised Finish Date 

Revised Finish Time 

Revised Start Date 

Revised Start Time 

Start Date 

Start Date 1 - 10 

Start Float 

Start Time 

Start Time 1 - 10 

t;;:?r•."; •. ., •c 
,;::.ri•;,.- ·; ... , 

FLAG 

DATE 

DATE 

DURATION 

TIME 

TIME 

COST 

FLAG 

FLAG 

DURATION 

HYPERLINK 

FLAG 

IMAGE 

DATE 

TIME 

DATE 

TIME 

TEXT 

TEXT 

NUMBER 

ID/CODE 

ID/CODE 

ID/CODE 

COST 

ID/CODE 

DURATION 

DATE 

TIME 

DATE 

TIME 

DATE 

DATE 

DURATION 

TIME 

TIME 

COPYRIGHTS) 

Module 4: Customizing Columns 
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Yes/No - Yes indicates that the activity's duration is driven by resource effort 

Originally estimated finish date "Scheduled" 

Formatted to display dates 

Number of days activity's finish date can slip before project finish date is 

affected 

Originally estimated finish time "Scheduled" 

Formatted to display time 

Lump sum costs for the activity, feeds into Total Cost 

Yes/No - Yes indicates that the activity's duration is fixed and not recalculated 

automatically 

Formatted to display Yes/No option 

Number of days an activity can slip before next activity is affected 

Formatted to display hyperlink items - email address, URL, file 

Yes/No - Yes indicates that the activity is to ignore the assigned resource's 

calendar 

Formatted to display images 

Latest date an activity can finish before project finish date is affected 

Latest time on Late Finish Date an activity can finish before project finish date 

is affected 

Latest date an activity can start before project finish date is affected 

Latest time on Late Start Date an activity can start before project finish date is 

affected 

iCal/Outlook event location 

When text is entered, a notes indicator appears in the Information Form 

action column 

Customizable to display numerical values 

Activity name complete with parent rows, when using outline levels 

Displays which activity row(s) an activity is dependent on, including link type 

and lag 

Number field to prioritize your tasks 

Pre-defined calculation of the assigned resource's rate x work 

Linked to Resource View; defines assigned resources to activity 

Revision to activity's scheduled duration 

Revision to activity's scheduled finish date 

Revision to activity's scheduled finish time 

Revision to activity's scheduled start date 

Revision to activity's scheduled start time 

Originally estimated start date "Scheduled" 

Formatted to display dates 

Number of days activity's start date can slip before project finish date is 

affected 

Originally estimated start time "Scheduled" 

Formatted to display time --
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Status 

Subproject Activity 

Row ID 

Subproject WBS 

Successors 

Task Calendar 

Text 1-100 

Time 1-10 

Total Cost 

Total Float 

Total Resource 

Duration 

WBS 

Work 

ID/CODE 

ID/CODE 

ID/CODE 

ID/CODE 

ID/CODE 

TEXT 

TIME 

COST 

DURATION 

DURATION 

ID/CODE 

WORK 

Automatically calculated, based on % Complete, % Used and Current Dateline 

In a consolidated file, displays the original Row ID of activities in a subproject. 

In a consolidated file, displays the original numerical hierarchy of activities in 

a subproject based on their outline levels before consolidation. 

Displays which activity rows are dependent on what other activity rows, 

including link type and lag 

Assign/Edit an activity's calendar (Standard, 24 hour, Nightshift, etc.) 

Customizable to display text data 

Formatted to display time 

Pre-defined calculation of Fixed Cost+ Resource Cost 

Number of days activity can slip before project finish date is affected 

The total duration, in hours, of resource work time allocated to an activity. 

A numerical hierarchy of activities based on outline levels. 

The amount of work hours available to be allocated to resources. 
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Module 5: Reporting (Layouts &,filters) 

Module 5 

Reporting (Layouts & Filters) 

Overview: This module will teach you two features that will aid you in reporting 

data from your schedule. You will learn how to easily access groups of columns 

with the use of layouts. You will also learn how to search for and show specific 

rows of data in your schedule based on criteria you set. 

a. Understanding Layouts

b. Creating Customized Layouts

c. Understanding Filters

d. Creating Column/Value Criteria Filters

e. Creating Date/Time Criteria Filters

f. Multi-Criteria Filters

g. Resource View Filters
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Understanding Layouts 

Using layouts, you can create different combinations of columns and switch between them 

quickly and easily. Layouts can be customized to show columns, the timeline graph, timescales, 

and summary graphs. When it comes to reporting, you may be sharing your schedule with 

different people. Depending on the person and their relation to the project, the data you want 

to report may be different. The ability to set up a Layout for each person, if necessary, will 

come in very handy. 

Creating Customized Layouts 

Defining a layout allows you to create and edit views of the Schedule. Layouts are created and 

edited in the Layouts and Define Layout dialogs. 

To open the Define Layout dialog: 

1. Go to Project menu > Layouts> Define.

The Layouts dialog opens.

2. Click the New button to design a new layout.

-or-

Click the Edit button to edit the existing layout you select from the Layouts table.

The Define Layout dialog opens.
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In the Columns tab of the Define Layout dialog: 

1. In the Layout Name box, enter or edit the layout name.

2. From the Available Columns table, select a column name.

Module 5: R,po rtinJ(layoi.ts& 

3. Click the Show button to send the column to the Shown Columns table.

4. Repeat this process until all the columns you want to include in the layout are in the Shown

Columns table.

-or-

Click the Hide button to remove a column from the Shown Columns table.

5. If you wish, click and drag on column names in the Shown Columns table to change the order of

columns in the layout.

You can place columns on either side of the timeline graph.

6. If you wish, click in the Lock column to lock or unlock the column.

Locking a column prevents it from scrolling out of the window. It can be used for setting the left

and right scroll boundaries of the schedule.

7. Select Column Headings & Timescale (Top) to display column headings and the top timescale area.

8. Select Column Summaries & Timescale (Bottom) to display column summaries and a bottom

timescale area.

9. Select Mirror Timescale from Top to display a bottom timescale that mirrors the top timescale.

Column Headings and Timescale (Top) must be selected if you want to mirror the top timescale.

layout Name: �IM_ain_l.ayout�--------------------� 

Headinsl•: Summaries. and Tunescales Shown 

� Column Headings and Tmescale {Top) 
� Column Summartes and Trnescale {Bottom) 

0 Mirror T,mescale from Top 

Columns Shown 

•4 Used
.Adivity Row ID
.Adivity Row Number
Actual Duration
Actual Flllish Date
ktual Finish T,me
ktual Start Date
Actual Start T ,me
!lttendees
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• 
Locking Columns 

You can lock columns to the left and right of the timeline. If you do so, then only the area 

between the columns will scroll. This allows you to keep the timeline and locked columns in 

view. 

To lock a column: 

1. Select the column you want to lock by clicking in that column's heading.

2. Right-click and select Lock.

To unlock a column: 

1. Select the column you want to unlock by clicking in that column's heading.

2. Right-click and select Unlock.

. 
. . 
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Notes: 

You can lock one column to the left of the timeline and one column to the right. If you do so, then only the area between the 

locked columns will scroll. 

You can also lock and unlock columns within the Columns tab of the Define Layout dialog, accessed through the Schedule 

menu. 

Locked columns can also be used to define which columns will repeat on every page when you print. This is defined in File> 

Page Options dialog. 
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Understanding Filters 

As projects get larger, it can be more difficult to find specific information. Filtering uses search criteria 

that you define to identify information in rows. It then allows you to hide or select activities that match 

the criteria. Filters can be based on specific values in columns, like a particular department in a 

Department column, or they can be based on specific time constraints. For example, you may only want 

to see activities that are happening in May 2010. 

Restoring hidden rows 

As soon as you run a filter, the rows that do not match the search criteria disappear. Once rows have 

been hidden, through the menu or with a filter, you can show them again by restoring rows. This shows 

all hidden rows and rearranges them so that they resume their original, Master Sort order. 

Warning: 

To restore hidden rows: 

1. From the Project menu >Filters> select Restore All.

-or-

Click the Restore All button in the bottom-left corner of the schedule.

To define Restore All options: 

1. Go to Tools> Document Options> General tab.

When you are viewing your schedule in a filtered state {red arrow appears on the bottom-left corner), DO NOT modify row 

order. This means do not insert, move, or delete rows while data is being filtered. Filtering your schedule is for reporting and 

viewing purposes, not modification. 

Because rows are hidden while in a filtered state, modifying row order can be confusing to FastTrack Schedule. For example, it 

would not know where you would like to move a row in relation to hidden rows, if you were to do so. 
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Filter Options 

In the Options tab of the Define Filter dialog, you organize every aspect of a filter. In this tab, 

you determine which type of criteria to apply, what constitutes a filter-matching activity, and 

which outline levels and bars will display when the filter is applied. 

oc..um,v.._,.0t ... 

0°"6/TmeOteria 

0 Coum/\/aue uieria AND Del:e!Tme Oteria 

0 Column/Value Ctleria OR Date-/Tme- Ol:erta 

r;;)E,pondHP,.,,toRllemg 

r;;)Re,t..,,._1oR11"""9 

Ea....,,,,.a... __ _ 

Filer A Row When 

© Mt lla,in Iha! Row Matches 

O Fn ea,"' .... Row Mald,os 

0HBa,s;,th,tRowMalch 

Ba,Oim,s, 

@HBarstnl:heRow 

0 Malctw,g e... a,;,, 

--

0 Malctw,g Rows 0o1y 
® Malcmg Rows AND, 

Filter A Row When Options: 

Any Bar in that Row 

Matches 

First Bar in that Row 

Matches 

All Bars in that Row 

Match 

In rows with multiple bars, if any of 

a row's bars meets the filter 

criteria, that row will be shown or 

selected. 

In rows with multiple bars, only 

those rows whose first bar meets 

the filter criteria will be shown or 

selected. 

In rows with multiple bars, a row 

will be shown or selected only if 

every bar in that row meets the 

filter criteria. 

To use the Options tab of the Define Filter dialog: 

Column/Value Criteria 

Date/Time Criteria 

Column/Value Criteria 

AND Date/Time Criteria 

Column/Value Criteria 

OR Date/Time Criteria 

In order to be shown or selected by this filter, an activity must meet only the 

criteria defined in the Column/Value Criteria tab. 

In order to be shown or selected by this filter, an activity must meet only the 

criteria defined in the Date/Time Criteria tab. 

You are applying the filter criteria you laid out in both the Date/Time and 

Column/Value Criteria tabs. In order to be shown or selected by this filter an 

activity must meet the criteria defined in both of those tabs. 

You are applying the filter criteria you laid out in both the Date/Time Criteria 

and Column/Value Criteria tabs. In order to be shown or selected by this filter 

an activity need only meet the criteria defined in either one of those tabs. 
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Matching Rows Display Options: 

Bar Options: 

All Bars in the Row 

Matching Bars Only 

Row Options: 

Matching Rows Only 

Matching Rows AND 

Parents 

... AND Children 

... AND Parents and 

Children 

... AND Families 

Prior to/ After Filtering: 

This option: 

Expand All Prior to 

Filtering 

Restore All Prior to 

Filtering 

Apply All Bars Range 

After Filtering 

In rows with multiple bars, every bar in the row will display if any 

bar in the activity meets the filter criteria. 

In rows with multiple bars, only those bars that meet the filter 

criteria will display. 

The filter will show or select only those activities that meet the filter 

criteria, on any visible outline level. 

The filter will show or select the activities that meet the filter 

criteria and the activities one or more level up in the same outline. 

The filter will show or select the activities that meet the filter 

criteria and any subactivities one or more outline level below. 

The filter will show or select the activities that meet the filter 

criteria; the activities one or more level up in the same outline; and 

any subactivities one or more outline level below. 

The filter will show or select every activity on every level of the 

outline for those activities that meet the filter criteria. 

Means: 

When applying a filter, only visible rows are searched. Before the 

filter is performed, all subactivities will be displayed. 

When applying a filter, only visible rows are searched. For example, 

the state of your rows may already have a filter applied. To avoid 

applying a filter to filtered results, select this option. All rows are 

restored before the filter is performed. 

Restoring does not necessarily return your View to the same 

appearance it had before you hid rows. If you have made changes 

that affect the order of activities, these changes cannot be restored. 

Changes that affect the order of rows include: moving, inserting, 

deleting, cutting, and pasting rows. 
--·----

After the filter is applied, your timeline range will begin on the 

earliest activity Start Date/Time and end on the Finish Date/Time of 

the latest scheduled activity. 
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• 
Creating Column/Value Criteria Filters 

You set the criteria for a Column/Value filter in the Column/Value Criteria tab of the Define Filter dialog. 

Criteria you set in this tab can then be used as part of or the entire filter that you define in the Options 

tab. 

To use the Column/Value Criteria tab of the Define Filter dialog: 

1. Go to Project > Filters > Define. The Filters dialog opens.

2. Click the New button to create a new filter.

3. In the Filter Name box, enter a name for your filter.

4. Click the Column/Value Criteria tab.

5. From the Column value list, click to select a column in which to search for the Value, for instance,

Resources Assigned.

6. Click the Test cell in the table.

7. From the Test value list, select the appropriate comparer for the column value, for instance,

Contains.

8. Click the Value cell in the table.

9. Enter a value to look for in the specified column, for instance, a Resource Name.

-or-

From the Insert Function/Column into Value value list, select a column or function.

A function is a value that represents a variable. The filter is saved for future use.

Lil 

Column 
Resources Assigned 
Select Column 

Dpflons:. 

Test Value ··········-··········�/Or i L,.�_,J 
· John 

! l.,w,iill'aDi:iiifAJ 

j L wWiii!!i,.vJ 

I 

Notes: 

If you have defined a value list for a column, that value list will appear in the Value cell when the column is selected in the 

Column cell. 
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Creating Date/Time Criteria Filters 

You set the criteria for a Date/Time filter in the Date/Time Criteria tab of the Define Filter dialog. Criteria 

you set in this tab can then be used as part of or the entire filter that you define in the Options tab. 

To create a date/time filter: 

1. Go to Project> Filters> Define. The Filters dialog opens.

2. Click the New button to create a new filter. The Define Filter dialog opens.

The Define Filter dialog has three tabs.

3. Use the Date/Time Criteria Tab in the Define Filter dialog to create a filter using the options

described below.

4. Click OK to save your changes and close the Define Filter dialog.

5. Click OK to apply the selected filter and close the Filters dialog.

-or-

Click Close if you do not want to apply the filter at that time. The filter is saved for future use.

Bars: 

Date/Time Range 
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Notes: 

To use the Date/Time Criteria tab of the Define Filter dialog: 

Bars (component) 

Starts In 

Ends In 

Is Contained In 

Spans 

Current "X" 

Custom Defined 

Range 

Sets the date/time filter to look only at the Scheduled, Revised, 

or Actual component of activity bars in the schedule. 

Asks the filter to search bars whose selected component starts 

in the specified date/time range. 

Asks the filter to search bars whose selected component ends in 

the specified date/time range. 

Asks the filter to search bars whose selected component is 

contained within the specified date/time range. 

Asks the filter to search bars whose selected component 

contains, within its dates and times, the specified date/time 

range. 

Allows you to select from a pop-up list a dynamic date/time 

range, based on the current date. Select from Current Hour, 

Day, Week, Month, Quarter, or Year. 

From the value list, select Custom Defined Range. This allows 

you to define, using the numerous options provided, a range of 

dates and/or times that will act as the filter's specified 

date/time range. You can set a Start Date/Time and a Finish 

Date/Time or use a calculation to be the basis of your custom 

range. Then, you can choose to have the range start or finish a 

select number of units before or after the custom range. For 

example, this could allow you to filter for the month of October 

plus an additional 14 days. 

The default setting in the Options tab of the Define Filter dialog is to restore and expand all rows prior to filtering. If these 

options are changed and a row, activity bar is not displayed because it is hidden or collapsed, that data is not searched. 

Any changes you make to the order of rows while rows are hidden may not be restored. Changes that affect the order of 

activities include: moving rows, inserting rows, deleting rows, cutting rows, and pasting rows. 
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Notes: 

Module 5: Reporting(layouts& Filters) 

Multi-Criteria Filters 

Multiple criteria can be applied in a single filter by entering additional lines in the column/value table. 
Multiple lines must be separated with "And" or "Or" in the And/Or column on the right of the table. Click 
under the column to select one. 

"And" narrows the search as the activity must meet both criteria. 

"Or" expands the search as the activity can meet either criteria. To group multiple criteria together to 
change their meaning, click the parentheses cells ( ). 

A multi-criteria filter can also include Date/Time criteria. After creating a filter for a specific 
column/value, add a date/time criteria to narrow down the found results. 

Resource View Filters 

In the Resource View, Column/Value criteria filters can also be defined in the same way as in the 

Schedule View. Since the Resource View's focus is on resource allocation and assignments, Assignment 

Criteria filters can also be defined. For example, maybe when it comes time to assign resources for the 

next month, you may want to see which resources are assigned comfortably so that they can be 

assigned to more activities. 

To define an Assignment Criteria filter: 

1. In the Resource View, go to Project> Filters

> Define.

2. Select the Assignment Criteria tab.

3. Select the desired Assignment percentage

and if appropriate, a specified Date/Time

Range.

4. Select OK to save the filter.

5. Select OK to apply the filter.

If you want to create another filter similar to one you have already created, you can duplicate a filter in the Filters dialog. 
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Module 6 

Baselines & Progress Tracking 

Overview: After completing this module, you will know how to track the progress 

of your schedule using baseline, revised date, and actual date columns. You will 

also learn how to interpret the% Used and Status columns. 

a. Understanding Baselines

b. Progress Tracking

c. Tracking with Dependencies

d. Revised Dates

e. Percent Complete and Actual Dates

f. % Used and Status Columns
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• 
Understanding Baselines 

Baselines are derived from key schedule information columns that have been saved as a snapshot 

of the schedule at that point in time. These snapshots of information contain Cost, Work, Duration, 

Start Date, Start Time, Finish Date, and Finish Time. The data captured is taken from Total Cost, Work, 

Revised Duration, Revised Start Date, Revised Finish Date and Revised Finish Time columns. Each project 

can have up to 10 baselines. Captured information stored in baseline columns are not tracked on the 

timeline graph. 

To save a baseline: 

1. Go to Tools> Progress Tracking> Save Baseline.

The Select Baseline dialog box appears.

2. Select Baseline 1, or if you have already saved a baseline, select the next available baseline.

3. Click OK to save the baseline

4. Baseline Information can be viewed by inserting corresponding baseline columns.

Baseline Layouts 

Newly created files have pre-defined layouts for each set of baseline columns. To access these layouts, 

go to the Project menu > Layouts> Define> navigate to Baseline 1 Layout, Baseline 2 Layout, etc. 
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Module 6: Baselines & ProgressTratking: 

Progress Tracking 

The activities in an on-going project are always in the flux and scheduling changes are inevitable. 

Progress Tracking allows you to track and view changes to the Start, Finish and Duration of activities 

throughout the life of your project. 

At all times, FastTrack Schedule automatically tracks the progress of activities as three sets of dates: 

• Scheduled - Dates that reflect when your schedule was originally planned, also called the

"baseline" or "promised" dates.
■ Revised - Dates as they are currently projected, accounting for adjustments since the project

began.
• Actual - Dates as they actually happened, also tracked as a percentage complete, or "work-in

place".

When you draw a bar with the Draw Bar tool or enter data in Start, Finish, or Duration columns, you are 

entering the Scheduled dates. The label "Scheduled" is omitted from the columns to facilitate scheduling 

by users who do not wish to employ progress tracking. 

Tracking with Dependencies 

Linking activities throughout the schedule creates dependencies and allows you to see how changing 

one bar will affect the final outcome of the schedule. If you revise a bar that has a dependency, the 

dependency may also be revised. 

Revising linked bars may move the selected bar and all bars which are dependent upon it. A dependent 

bar will not move, however, if moving would conflict with that dependent bar's Constraint Type 

parameters, or if the activity represented by the dependent bar has actually started. 

When you drag a revised bar, moving that bar beyond its Constraint Type's parameters will cause the 

Constraint Type to change to "Start On Or After". 

To revise a linked activity by dragging: 

1. Select the Revise Bar Tool on the Toolbox tool bar

2. Click either the linked point or the middle of the bar and drag to the left or right.

In order for the Progress Tracking feature to work to its fullest potential, activities' dependencies must 

be defined. 

Notes: 
While dragging a linked bar, only the selected bar moves. Dependent bars, if their constraints allow the move, move only once 

you stop dragging the selected bar and release the mouse. 
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Revised Dates 

Defining an activity's Revised dates and times updates the currently projected start, finish, and/or
duration of the activity.

For instance, if changes to earlier activities force an activity to slip, thus starting and ending later, this 
new start, finish and duration data can be entered as Revised data. This leaves the Scheduled data as it
was originally planned, allowing you to see the difference between the original schedule and the
currently projected schedule.

You can define a task's Revised dates in the Schedule and Calendar Views. If a task has been assigned to
a resource, you can also revise its dates in the Resource View.

Notes: 

To define Revised dates by dragging: r.;J 
1. In the Toolbox, select the Revise Bar tool. •
2. Clicking and holding the left mouse button down, drag the activity bar to the right or left and

release your mouse.

To define Revised dates by typing: 
1. If not already displayed, show the Revised date, time and/or duration columns by switching

layouts (Project> Layouts> Tracking) or by going to the Insert menu> Column.
2. Enter values in the activity's Revised Start Date, Revised Start Time, Revised Finish Date, Revised

Finish Time, or Revised Duration columns.
-or-
Click in the Information Form action column, select the Bars tab> Tracking tab, and enter values
in the Revised Date/Time and Duration boxes.

�
H<lden . �-Bar=-=�-:--;1�-;;;;;;;;�-1 

. racking ifoke le.!,..,.....! 

J I Start Date Start TIITle Finish Date Finish Tme Duration 

i : Scheduled 
Revised I 

03/01/2010 (i) I &OOAMiril 03/0&/2010iLil I 500 PM'(i] i 600[ii!':::::====::;� 
03/01/2010:il I 800AMl!mi 03/0&/2010ii) I 500 PM f.ml I GOO!i!I 

Actual -' ____ lil '--------'ril �----'1fiJ '--------il :=1,_=_=_=���!i!=·:, 

Conslrainls 

t Complete r · o O!)o/. ill 

Constraint Date L-,··-·, .,, ~··,,, '"" -
Conslrainl T ,me 

PriO!iy (Days) 
Calendar 

D Ignore Resource Calendars 

The display of the Revised data on the bar is defined by the format of the bar style. The Revised dates appear as another bar or 
extending points and can be shown all of the time or just when they differ from the Scheduled dates. These options can be 
formatted by formatting the bar style. 
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Module 6: Baselines & ProgressTracking 

Percent Complete and Actual Dates 

Percent Complete and Actual data indicates how much work has been done on a task. You can always 

define a task's Actual dates from the Schedule and Calendar Views and, if a task has been assigned to a 

resource, you can also edit its Actual dates from the Resource View. 

To define% Complete by drawing: 

1. In the Toolbox, select the Bar Percent Complete tool.

2. Click a position in the bar that represents the percentage of the task that has been completed

thus far.

To define% Complete by typing: 

1. Insert> Column > % Complete

2. Enter a number in the% Complete column.

To define Actual dates by drawing: 

1. In the Toolbox, select the Bar Percent Complete tool.

2. Click anywhere to the right of the start point of the bar to enter the Actual Start Date and Time.

Click the end of the bar to enter the Actual Finish Date and Time and Actual Duration

To define Actual dates by typing: 

1. If not already displayed, Insert> Column> Actual Start Date/ Actual Finish Date/ Actual Duration

2. Enter values in the corresponding columns.

-or-

Click in the Information Form action column, select the Bars tab> Tracking tab, and enter values

in the Actual Date/Time and Duration boxes.

% Used and Status Columns 

The% Used and Status columns are columns to help report the progress of each activity, relative to the 

current date and the manually entered% Complete. At a glance, you can see which activities are on 

schedule or behind schedule. To insert these columns, go to Insert> Columns> select% Used or Status. 
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Module 7: Styles (Bars, Rows, Outlines}/ 

Module 7 

Styles (Bars, Rows, Outlines) 

Overview: This module will show you how to define and apply formatting styles, 

which will help enhance the presentation quality of your schedules. 

a. Outline Level Styles

b. Modifying Bar Styles

C. New Bar Styles

d. Dynamic Labels

e. Timeline Graph
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Module7: 

Outline Level Styles 
Formatting rows allows you to set the height, background color and pattern, and bottom line color and 

pattern of rows. 

To format rows in the Schedule View: 

1. Select the row or rows by clicking on the row number column

2. Go to Format> select Row.

-or-
Double-click the Row Number column. Format row dialog will appear:

Use Outline Styles 
Allows you to format the appearance of a row in relation to its outline 

level. 

Define Outline Styles 

Once clicked, opens the Outline Level Styles dialog in which you can set 

the background and bottom line colors and patterns for each outline 

level. 

Background 

Color Sets a background color to display in the row. 

Pattern Sets a background pattern to display in the row. 

Display Location 
Allows the color and pattern you have selected to display on: columns 

only, the timeline only, the columns and timeline, or not at all. 

Bottom Line 

Color Sets a bottom line color to display in the row. 

Pattern Sets a bottom line pattern to display in the row. 

Size 
Sets a line size for the bottom line pattern you are opting to display in 

the row. 

Display Location 

Allows the color pattern and line size to display on: columns only, the 

timeline graph only, the columns and timeline, or not at all. 

Formatting Rows by Outline Level 

The row background and bottom lines can also be set by outline level. For instance, you could apply a 

different background color to rows in outline level 1 and 2. 

To change the formatting of rows by outline level: 

1. In the Schedule View, double-click in the row number column of any row

Format Row dialog should appear.

2. In the Display tab, select the Use Outline Styles checkbox.

3. Select the Define Outline Styles button.

4. From the Outline Level table (left side), select the outline level you wish to format.

5. Select from the options described in the Format Row dialog above.
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Module 7: Styles (Bars, Rows, Outlines) 

Modifying Bar Styles 

Editing an existing bar style changes the appearance of the bar style, and every instance of that bar style 

in the schedule. 

To edit the appearance of a bar style: 

1. From the Format menu > select Bar Styles.

The Format Bar Style dialog opens.

2. Select the bar style you want to format from the list of bar styles

3. From the Part to Edit list, select the bar element you want to edit.

-Or-

in the picture of the bar at the top of the dialog, click on the bar element you want to edit.

4. Based on the choice you have made, use the options described below.

To change this: Dothis: : . 
.. 

From the Shape list, select an existing point style 

and size. Click the New button to create a new 

Point/Milestone Shape point style or the Edit button to edit an existing 

point style. You can even insert an image as a point 

shape. 

Bar/Milestone Pattern/Fill 
From the Bar/Milestone Pattern/Fill area, select a 

color, pattern, and size. 

Bar/Milestone Border· From the Border area, select a color and size. 

Part Position Relative to From the Offsets area, select the horizontal and 

Bar Style vertical alignment. 
-

5. Click OK to apply your changes and close the Format Bar Style dialog.
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• 
New Bar Styles 

New Bar Styles can be defined in the Format Bar Style dialog. 

While you can select options in any order, to design a basic bar, we recommend you do the following. 

To create a new bar style: 

1. Go to Format menu > Bar Styles. The Format Bar Style dialog opens.

2. Click New

3. From the Type value list, choose Bar (to track start, finish, and duration) or Milestone (to track a

single date like a deadline).

4. From the Component list, select Scheduled, Revised, or Actual.

5. Click the Parts tab.

6. From the Part to Edit list, choose the part of the bar style you wish to format.

7. If you choose to edit a part of the Actual or Revised component, you will receive the following

choices in the component options section:

Show Revised as a Bar 

Show Revised as Points 

Always Show Revised 

Show Revised Only if 

Different than Scheduled 

Show Actual as a Bar 

Show Actual as a Fill 

Displays the Revised component as a bar positioned 

relative to the Scheduled bar. 

Displays the Revised component as points extending off 

of the Scheduled points. 

Shows the Revised component all of the time. 

Shows the Revised component only when the bar's 

Revised dates differ from the Scheduled dates. 

Displays the Actual component as a bar positioned 

relative to the Scheduled bar. 

Displays the Actual component as a pattern and color 

filling the Scheduled or Revised bar. 

8. If you receive these options, based on your selections above, choose attributes in the Shape,

Color, Pattern, Size, Border, and Offsets areas.

9. If you want to format other components of the bar or milestone, select them from the

Component pop-up list and select their formatting options. • 
10. Click OK to accept the new bar style and add it to the Bars Styles Toolbar.

Notes: 

You can even create milestones from an image. With a new milestone created, in the Format Bar Styles dialog, go to the Parts 

tab> Shape> New ... > Insert ... > locate desired image. 
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Module 7: Styles (Bars, Rows, Outlines) 

Dynamic Labels 

To emphasize certain data, you can attach text to a bar style. You can add date, time, duration,% 

complete, and other row or bar information as the label. Labels can be attached to a bar or milestone. 

You can have as many labels on an item as you wish. 

In the Format Bar Style dialog you can create separate Schedule labels and Resource labels. You can also 

apply Schedule labels to bars in the Resource View. Bar labels created in the Format Bar Style dialog do 

not display in the Calendar View. Use the Format Calendar View dialog to create bar labels in the 

Calendar View. 

7:5 

COPYRIGHT© 2010, AEC Software, and its liccn,ors. /I.LL RIGHTS RESERVED 



• 
To show data on a bar: 

1. Go to Format menu> Bar Styles and select the bar style you want to apply labels to.

2. Click the Schedule View Labels or Resource View Labels tab.

3. If you wish to apply the same labels that are set in the Schedule View Labels tab to bars in the

Resource View, click the Use Schedule View Labels checkbox.

4. From the Show Label on Part pop-up list, select on which part of the bar you would like to display

data.

5. From the Available Columns table, select the column which contains the data you would like

displayed on the bar.

6. Click the Show button to send the data to the Shown Columns table.

7. In the Offsets boxes, enter the Horizontal and Vertical distance from the selected element.

8. If desired, click the Format Label button to open the Format Bar Label dialog and access the

options described below:

Font 

Borders 

Display 

Controls the font, size, style and color of the text in your 

labels. You can choose to apply these font attributes to a 

selected cell only (e.g. Activity Name) or to all bar labels 

(every label on every element of that bar style). 

Allows you to: place a border and a shadow around a bar 

label, set the border and shadow line widths, set the 

corner radius of the border, and select background and 

line colors. You can also choose to apply the border 

attributes to all bar labels (every label on every element 

of that bar style) or to a selected cell only (e.g. Activity 

Name). 

Determines the appearance of any numbers, dates, 

times, and duration data in the Shown Columns table. 

9. If you have chosen to format the bar label, click OK to apply your changes and close the Format

Bar Label dialog.

10. Click OK to apply your changes and close the Format Bar Style dialog.
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Module 7: Styles (Bars, Rows, Outlines) 

Timeline Graph 

Formatting grid lines defines the display of grid lines in columns and the timeline graph. 

To format gridlines in a timeline: 
1. From the Format menu, select Grid lines.
2. Select from the options described below.
3. Click OK to apply your changes and close the dialog.

Define Gridlines 

Optimize 

Custom Setting 

Show Gridlines 

Column Horizontal 

Column Vertical 

Timeline Horizontal 

Timeline Vertical 

Gridline Divisions Per 

Timeline Unit 

Automatically defines separate gridlines for display 

and printing. When displayed on screen, gridlines are 

gray or dotted. When printed to a dot matrix printer, 

grid lines are dotted. When printed to a high

resolution printer (300 dpi or greater), gridlines are 

solid hairlines. 

Allows you to design your own grid lines. Define the 

size, style, and color of the grid lines. 

Displays horizontal gridlines in columns. 

Displays vertical gridlines in columns. 

Displays horizontal grid lines in the timeline graph. 

Displays vertical grid lines in the time line graph. 

Allows you to subdivide a timeline unit with the 

number of gridlines you specify. Enter the number of 

columns you want shown within each timeline unit. 
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Module 8 

Printing & Visual Enhancing 

Overview: In this module, you will learn how to visually enhance your schedule, 
print out your schedule, and export your schedules in other formats. 

a. Timeline Range Toolbar
b. Print Preview
c. Page Options
d. Print Setup
e. Headers & Footers
f. Legends
g. Text Boxes
h. Pictures
i. Exporting as picture

j. Export iCal/Outlook, 3 rd party applications
k. Formatting the Calendar View
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Module' 8: Printing&.VisuatEnba��ihg.c;: 
� ','' � , , 

Timeline Range Toolbar 

The Schedule View can show a different span, or range, of dates. The Timeline Range Toolbar gives you 

immediate access to the begin date and end date of the time line graph. 

The dates you set in the Timeline Range Tool bar affect only the View at which you are looking. If you 

want to apply a date range to all views as the Master Range, go to Format> View> Range tab, define 

the Start and Finish dates/Duration and select "Save Range as the Master Range". 

All Bars Range 
Applying the All Bars Range automatically adjusts the timeline to begin on the Start Date/Time of the 

earliest task and end on the Finish Date/Time of the latest task, immediately giving you a view of every 

bar and milestone in your schedule. 

Timeline Units 
When viewing schedules that are longer than a couple months it is difficult to see the entire project if 

the timeline is viewed in days. Go to the Project Menu> Timeline Units to change units to hours, days, 

weeks, months, quarters, or years. 

Notes: 

Dates entered in the QuickRange Toolbar are temporary and are not saved in the Ranges Toolbar. If you want to define a range 

for future use in the file, go to the Project menu> Timeline Ranges> Define> select New. 

Trainer's Tip: 

For easy navigation in the timeline graph, you can use the Go To Bar command to take you to the first bar in a selected row. Go 
to Edit menu> Go to> Bar (or use the shortcut Ctrl + D). 
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Module 8: Printing & Visual Enhancing 

Print Preview 

Print Preview allows you to see how each page of a specified View will print before you send it to a 

printer. Headers, footers, and pictures added to the Print Preview window will appear when you print 

the page. Pictures, legends and text stamps are not supported in the Print Preview window of the 

Calendar View. 

To open Print Preview: 

1. From the File menu, select Print Preview.

To view a different page in the Print Preview window: 

1. On the Toolbar, click "Next Page"

To see the printable area of the page (to make sure items are not clipped): 

1. On the Tool bar, select "Printable Area"

To zoom in and out of the view: 

1. On the Tool bar, select the Zoom In or Zoom Out tool

2. Once you have zoomed in or out, use your mouse (which is now a hand cursor) to pan around the

view
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Module 8: Printing & Visual Enhan#in� 

Page Options 

Changing the Page Options will allow you to fine-tune the format, margins, and display of your printed 

schedule. There are three options available to modify a printed schedule: 

Standard Format - This is the default setting, which will print the schedule on as many pages as

necessary, repeating columns as appropriate. 

Wall Chart (Tiled} - This option will print the schedule without repeating columns. This is useful if you

will be printing to several pages across and taping them together to a poster-board or wall. 

Fit to Pages (Width) - This option will adjust the timeline unit width, so your schedule is printed to a

specific number of pages horizontally. You can change how many pages (horizontally) you would like to 

print to by changing Number of Pages Across. 

Page Options can be accessed from all views, including the Print Preview, by going to the File menu > 

Page Options. 
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Module 8: Printing & Visual Enhancing 

Print Setup 

By going to the Print Setup, the printer can be selected and properties for that printer may be modified. 

This dialog also allows the user to select from a list of paper sizes supported by that printer, and choose 

to print in portrait or landscape orientation. 

To access Print Setup, go to the File menu> Print Setup. 

Notes: 

• FastTrack Schedule looks best in Landscape orientation with Tabloid size paper (11" x 17"). These settings are

recommended but not required.
• If a PDF writing software is installed on Windows, FastTrack Schedule can be printed as a PDF
• If no printer is available, FastTrack Schedule Print Setup cannot be modified because these settings are incorporated from

the printer driver
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• 
Headers and Footers 

Headers and footers are available when you are ready to print your schedule. This allows you to include 

information such as the file name, date, and page number on printed pages. It is best to set this up while 

in Print Preview. 

="Page"+(Page�}•" ... 

To add headers and footers: 

1. Go to the View menu > select Header & Footer.

The Header and Footer dialog opens.

2. From the Format pop-up list, select Header or Footer.

3. Select a cell in the left, center, or right table into which you want to enter information.

4. From the Insert into Cell pop-up list, select one of the pre-defined pieces of data.

-or-

Enter custom information into the left, center, or right table.

5. From the Display Options pop-up list, select which pages the data will appear on.

6. If you wish, click the Font button to format the textual appearance of data in the cell.

7. Click OK to apply your font styles and close the Font dialog.

8. Click OK to apply your changes and close the Header and Footer dialog.

Adding page#, date, time, and file name stamps 

Adding autotext stamps allows you to include a dynamic page number, date, time, and file name and 

path in the Print Preview window. This information will appear when the document is printed. You can 

also use headers and footers to include this data on the printed document. The following tools can be 

found in the Print Preview toolbar: 

Filename 
&Path 

Bring to Format
Picture Front Selected Item

I 

Stamps appear in the middle of the Print Preview window. Use the Arrow tool to drag the stamp to a 

different location. 
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Module 8: Printing & Visual Enhancing 

Legends 

Inserting Legends 

Inserting a legend creates a key to the bar styles used in the schedule. It lists the chosen bar style and 

allows you to assign a name, or a label, to each bar style. You can create multiple legends in the 

Schedule View and the Print Preview windows. 

To insert a legend: 

l. From the Insert menu > select Legend.

The Format Legend dialog opens.

2. Format the legend (as described in the next section).

3. Click OK to save the legend and close the Format Legend dialog.

Formatting legends 

Formatting a legend defines the title, bar styles, labels, font attributes, border, background, and options 

for the selected legend. 

To open the Format Legend dialog: 

1. Using the Arrow tool, click the legend to

select it.

2. From the Format menu > select Legend.

The Format Legend dialog opens.

To format a legend: 

l. Click the Display tab of the Format Legend dialog.

2. Enter a name in the Title box and select the Show checkbox if you want it displayed at the top of the

legend.

3. Select a cell in the Bar Style column of the table and, from the Bar Style pop-up list, select a bar style.

It appears in the selected cell.

4. Select a cell in the Label column of the table and name the bar style appropriately.

5. To change the font attributes of the text or title, use the options in the Font tab.

6. To change the border or background, use the options in the Border tab.

7. Click the Options tab.

8. For Schedule View legends, in the Clipping area, select None or Containing Row.

None will display the whole legend and Containing Row will hide the parts of the legend that are outside

the row that contains the legends top-left corner.

-or-

For Print Preview legends, in the Show On area, select the printed pages on which you wish to display the

legend.

9. Click OK to apply your legend changes and close the Format Legend dialog.
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Text Boxes 

Inserting Text Boxes 

Adding text boxes to the timeline allows you to enter notes, reminders, and labels that customize the 

appearance of your schedule. 

To add a text box: 

1. In the Toolbar, select the Text Box tool

2. Double-click on the text box.

3. Enter the content for the text box.

Editing Text Boxes 

Editing a text box allows you to enter new text that replaces or adds to the old content. 

To edit a text box: 

1. Double-click on the text box.

2. Enter or edit text in the text box.

Pictures 

Inserting pictures into the Schedule View time line or Print Preview window allows you to customize your 

schedule with clipart, company logos, and other images. 

To paste a picture: 

1. Copy the picture to the Clipboard in the picture format.

2. From the Edit menu > select Paste.

To add a picture: 

1. From the Insert menu > select Picture.

The Insert Picture dialog opens.

2. Select the picture from the Clipboard.

-or-

Select the File option and click the Browse button to navigate to a file.

3. Click OK to apply your changes and close the Insert Picture dialog.

Enhancing Text Boxes and Pictures 

Format text boxes and pictures by adding a border, shadow, or rounding the corners. 

Notes: 

To format a text box or picture: 
1. Select the text box or picture by clicking on it

2. Go to Format> Format Selected

As you enter text, the text box wraps the text to fit within to the width you have defined. 

To add labels to individual bar elements, use the Labels tab of the Format Bar Style dialog. You can also add text boxes while in 

the Print Preview window. Text boxes created in the Print Preview window appear only in Print Preview and the printed 

schedule. 
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Exporting data as a picture 

You can export a picture of the Schedule, Resource, and Calendar Views and/or their items to the 

Clipboard or a file on disk. From the Print Preview window, define what is exported: the portion of the 

View on the page, the View plus graphic items, or the View, its items, and an image of the piece of 

paper. When performed outside of the Print Preview window, an image of the entire View is exported. 

In Print Preview, to export a page of the file as a picture: 

1. In any View, from the File menu> select Print Preview.

2. Make sure that the page appears as you want and that nothing is selected.

3. From the File menu > select Export> choose Picture.

The Export as Picture dialog opens.

4. Select from the options described below.

Destination 

File 

Browse 

Clipboard 

Options 

Export Document 

Only 

Export Document and 

Paper 

Export Document and 

Page Items 

Saves the exported picture to a file on disk. 

Opens a dialog where you can select a destination and file 

name for the export. 

Saves the exported picture to the Clipboard. 

Copies the area of the file that appears on the current 

page. 

Copies the area of the file which appears on the current 

page, all text boxes and stamps in the Print Preview 

window on this page, and an image of the paper on which 

it is positioned. This also includes headers, footers, and 

pictures. 

Copies the area of the file which appears on the current 

page plus all text boxes and stamps in the Print Preview 

window on this page. This also includes headers, footers, 

and pictures. 

5. Click OK to create the export and close the Export as Picture dialog.

In the Schedule, Resource, or Calendar Views, to export the entire View as a picture: 

1. Make sure nothing is selected.

Click once in the blank timeline area or outside of the calendar to assure this.

2. From the File menu > select Export > choose Picture.
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• 
Exporting data as an iCalendar file 

You can export your open schedule as an iCalendar (.ics) file. Only activities that are currently displayed 

will be exported. If the schedule has a filter applied, only those activities will be exported to the .ics file. 

To export an iCalendar file 

1. From the File menu > select Export > iCalendar.

The Export iCalendar dialog opens.

2. Click Export.

The Save As dialog opens.

3. Choose the name and location in which to save the exported .ics file.

4. Click Save to close the Save As dialog and export your open schedule data to an iCalendar file.

Column data which are exported: Activity Name, Notes, Location, Attendees, Duration, Start Date, Start 

Time, Finish Date and Finish Time. These columns are combined in a predefined layout - iCalendar 

Layout. 

Exporting data as MPX/XML 

To see FastTrack Schedule data in other project management applications, you can select the options of 

exporting as MPX or XML file formats. MPX and XML are file format standards for project management 

applications. Data that is stored include the project outline, progress tracking, custom columns and 

resource assignments. Formatting of fonts and bar styles are not converted, since the other applications 

may not support FastTrack Schedule's formatting abilities. 

To export an MPX or XML file 

1. From the File menu > select Export> MPX or XML

2. Click Export. The Save As dialog opens.

3. Choose the name and location in which to save the exported .mpx/.xml file.

4. Click Save to close the Save As dialog and export your schedule.

Additional Save Options 

Automate an export of your schedule in XML, MPX or ICS formats upon every save of your FastTrack 

Schedule file. Go to Tools> Application Options to apply this setting. 

0 Save all open documeri,: every: 

Document Properties 

D Prompt for document propertieO on fir.at save 

Mditional Save Options 

0 Always save an add!iooal fie o
f 

the following type: 

[Micto��XML(,.,;.) . .[;] 
0 ftlways save an additional fie of same type as o!iginal opened 

ONone 

8:10 

COPYRIGHT© 2010, AEC Software, Inc. and its licensors. ALL RIGHTS RESERVED 



Modules: 

Formatting the Calendar View 

The Calendar View displays information from the Schedule View in the traditional look of a wall 

calendar. This allows you to view time vertically rather than horizontally. You can view and print 

completely customizable calendars that can be filtered to display only those activities you want to see. 

In the Calendar View, you can draw bars; move bars; hide bars; filter activities - to view only those bars 

you want to see; edit Scheduled, Revised and Actual dates and times; apply Ranges and FastSteps; and 

print the calendar in current, monthly, and custom configurations. 

Each display element of the calendar can be customized in the Format Calendar View dialog. 

To format the display of the Calendar View: 

1. In the Calendar View, from the Format menu > select View.

2. Click the Display, Range, Font, Bars, Bar Labels or Gridlines tab to format the appearance of that element

of the calendar.

3. Click OK to apply your changes and close the Format Calendar View dialog.

Calendar Tll:le Format: '-i February_---'--20_10 ______ --"'l■_J

Cell Header 

Shading 

Location, '-:Cel!_• ________ ______,.� .... .;:I
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Module 9: Advanced Features Introduction 

Module 9 

Advanced Features Introduction 

Overview: This module reviews the Essentials of FastTrack Schedule and 

introduces advanced ways of beginning a new schedule. 

a. Recap of FastTrack Schedule

b. Schedule View Information Form

9:1 
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Module 9: Advanced Features lntroduc:tion 

Application Overview 

FastTrack Schedule is a project management application for tracking all your projects, activities, tasks, 

resources, to-do lists, and deadlines. 

FastTrack Schedule helps you organize, track, and manage your projects by graphically representing start 

and finish dates as bars along a timeline graph. Within project management, this type of schedule is 

known as a Gantt chart named after its creator, Henry Gantt. 

FastTrack Schedule automates the Gantt chart, making it a dynamic timeline. In addition to extensive 

graphic capabilities and customizable features, it is also a powerful database. As you draw, resize, and 

move bars along the timeline graph, it automatically updates start and finish dates, durations, 

dependencies, percent complete values, and costs. 

To enter an activity you can draw a bar directly on the timeline graph and have FastTrack Schedule enter 

the duration and dates for you, or you can enter the duration or the dates in columns and have 

FastTrack Schedule draw the bar for you. 

In fact, everything you can do to an activity bar, can be done with your mouse and the tools in FastTrack 

Schedule's Toolbars or by editing values in columns. This flexibility allows you to concentrate on the 

activities you are scheduling, instead of the act of scheduling those activities. 

COPYRIGHT© 2010, A.EC 
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Module 9: Advanced Features Introduction 

Schedule View Information Form 

Row tab 

Two sub tabs are available in the Row tab, Notes and Columns. In the Row tab> Columns tab you have 

access to data for all of the columns, relating to a particular activity, which store data per row rather 

than per bar. In the Row tab > Notes tab you have a place to store notes relating to each Activity. 

To enter data in the Row tab: 

1. Click in a row's Information Form action column.

The Information form opens in the Row tab.

2. Enter or edit data using the options described below.

This Qptiori: 
. 

0oesthis: 
·. . .

Displays the name of the activity whose data is 

Activity Name window currently being shown in the form. Enter and edit the 

activity name from this window. 

Show Allows you to select which custom columns will display. 

Column Name 
Displays the names of any columns whose data is stored 

per row. 

Displays the values of any columns whose data is stored 

Column Value 
per row. If you have defined a value list for a column, 

that value list will appear when you click in the Value 

cell. 

3. Click OK to apply your changes and close the Information form.
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Module 

Bars tab 

In the Bars tab of the Information form, you can view and edit the following data: 

Bar ID 

Bar X ofX 

Bar window 

Bar Style 

Hidden 

Displays the Bar ID of the bar whose information form you are 

viewing. 

When there is more than one activity bar or milestone in a 

row, the number of that bar in relation to all the bars in that 

row is displayed (e.g. Bar: 1 of 7). You can use the arrow keys 

beside the Bar display window to navigate to other bars in the 

row. 

Displays the bar whose data is currently being shown in the 

Bars tab. 

Allows you to change the current bar's bar style by selecting a 

new one from the list. 

Manually hides the bar on the timeline graph and its data in 

the columns. 

The Bars tab of the Information form has four additional tabs - Tracking, Columns, Links, and 

Assignments. 

Bars > Tracking tab 

In the Bars tab > Tracking tab you have access to data that pertains to the movement of a bar, within a 

particular activity. 

'.-�·-�1
llarlO 113 

□-

Con3tran:Oate 

ConstraintTrne 

111 

-·

0F-.d-

s.ooPM!ll)
Sll()PMJlil 

· · wi9hn1o'lil · soorlil� �--=:.� 

l'riori!y 

!None

l,u,hwim,) 
□ � Reso<m;e Calendar., 

To enter data in the Bars > Tracking tab of the Information form: 

1. Double-click on an activity bar (on the timeline graph).

The Information form for that bar opens in the Bars> Tracking tab.

2. Enter or edit data using the options described in the next page.
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Module 9: Advanced Features Introduction 

' ·.· .,, .. · 
... 

,.\ .• / .. .Thi� ,ipt,oci� 

Scheduled Boxes 

Revised Boxes 

Actual Boxes 

% Complete 

Priority 

% Complete 

Constraints & Calendar 

Constraint Date 

Constraint Time 

Constraint Type 

Calendar 

Ignore Resource Calendars 

p6f$thisf•.·••/ t< 
,, ',', ,,," , ,,,,, ,. · .. ... · •· . Yf\ > .. ·., ..... >�• . 

Shows Date, Time, and/or Duration data forthe bar's 

scheduled element. 

Shows Date, Time, and/or Duration data for the bar's 

revised element. 

Shows Date, Time, and/or Duration data for the bar's 

actual element. Actual data reflects the% complete. 

Shows how much of the task represented by the 

particular bar has been completed. The% complete 

affects the Actual Dates and Times. 

Indicates the bar's assigned priority. 

Shows how much of the task represented by the 

particular bar has been completed. The% complete 

affects the Actual Dates and Times. 

Enter or edit the date for all Moderate and Hard 

Constraint Types. 

Enter or edit the time for all Moderate and Hard 

Constraint Types. 

Choose the Constraint that best suits the behavior you 

would like the activity bar to exhibit. 

Choose the calendar which the task should be 

scheduled on. Anything different from the project 

calendar will be indicated in the Information Form 

action column. 

When resources are assigned to an activity, you can 

choose to ignore resource calendars which could shift 

when tasks are scheduled to occur. 
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Bars > Columns tab 

In the Bars tab > Columns tab you have access to data for all of the columns, relating to a particular 

activity, which store data per bar rather than per row. 

si- t'-)ljj------�•-1

Z Used 1 O"l. 
!'dual Duration 6.0 

!'dual finish Date 11/1/10 

Actual finish T,me 5:00PM 

Actual Slart Date 10/25/10 

Paua1 Slart r .... 8:00/Jl,J, 

Pilendees � 
BarlD 322 

- Co!t 1 

To enter data in the Bars > Columns tab of the Information form: 

Notes: 

1. Double-click on an activity bar (on the timeline graph).

2. Click on the Columns tab.

3. Enter or edit data using the options described below.

Show 

Name 

Value 

Allows you to choose which type of columns to display in 

the table, e.g. All columns, Calculation columns only, 

Date columns only. 

Displays the names of any columns you have created 

whose data is stored per bar. 

Displays the values of any columns you have created 

whose data is stored per bar. If you have defined a value 

list for a column, that value list will appear when you click 

in the Value cell. 

4. Click OK to apply your changes and close the Information form.

Remember that the activity name and row number is displayed in the dialog's title bar reflecting only the activities 

currently displayed in the schedule. Any collapsed or hidden activities will have to be restored before you can view their 

Information form. 

9:6 

COPYRIGHT© 2010, AEC Software, Inc. and its licensors. ALL RIGHTS RESERVED 



Module 9: Advanced Features Introduction 

Bars > Links tab 

In the Bars tab> Links tab, you have access to all the information about an activity bar's links 

(dependencies). You view the information in terms of links to predecessor and successor bars. 

To enter data in the Bars tab > 

Links tab of the Information form: 

1. Double-click on an activity

bar.

2. Click the Bars> Links tab.

3. Enter or edit the link data in

the Predecessors and Successors

tables.

4. Click OK to apply your

changes and close the

Information form.

Bars > Assignments tab 

In the Bars> Assignments tab you have access to all the information about an activity bar's assigned 

resources. 

To enter data in the Bars> 

Assignments tab of the 

Information form: 

1. Double-click on an activity

bar.

2. Click the Bars>

Assignments tab.

3. Enter or edit the resources

assigned to the activity.

4. Click OK to apply your

changes and close the

Information form.

2010, AEC Softw2re, 
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Module 10: Resources 

Module 10 

Resources 

Overview: This module will teach you how to create, assign, and manage 

resources using the Resource and Schedule Views. 

a. Understanding the Resource View

b. Creating Resources

C. Resource Information Form

d. Effort Driven and Fixed Duration

e. Assigning Resources

f. Managing Resources

g. Resource Allocation

h. Resource Work Usage Graph

i. Resource View Filters

j. Tracking Resource Costs
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Module 10: Resource:S 

Understanding the Resource View 

The Resource View is similar to the Schedule View because it has columns, rows, a timeline graph, 

reporting functions, and an information form. It is different, however, because instead of tracking and 

managing activities, this view is for tracking and managing resources. 

Tracking who or what is responsible for completing the tasks you are scheduling is one of the most 

important parts of managing a project. Resources are any material, equipment, or human resources that 

help you accomplish the tasks in your schedule. 

Every resource has a finite amount of time it can be used and effort it can exert. Every resource can also 

have a cost attached to it whether it is a flat fee, a standard rate, an overtime rate, or any combination 

thereof. Each of these elements can be automatically charted and controlled in the Resource View of 

FastTrack Schedule. 

There are 3 steps in successful resource management: 1) Create, 2) Assign, and 3) Manage. 

Creating Resources 

First Step 

A resource can be created in either the Schedule View or the Resource View. While in the Schedule 

View, typing in the Resources Assigned column will automatically create resources in the Resource View. 

Although this can be done, it is recommended that you create each resource in the Resource View so 

that a work calendar and rates can be established at the time of creation. 

In the Resource View, a resource can be created by typing a name in the Resource Name column. The 

Resource View provides a unique work calendar for each resource, allowing you to setup the hours of 

the day for typical and specific days. The resource work calendar is defined in the Resource Information 

form. 

Resources can be created using the Resource Information form. 

To setup a new resource: 

1. Begin by typing the name of your resource in the Resource Name column.

2. Click in the Information Action column intersecting the resource name to setup.

3. You can then enter, Type, Per Use Cost, Standard Rate, and Overtime Rate, etc.

4. Click the Work Calendar tab to define the work days and hours of this resource.

5. Click OK to apply your changes and close the Resource Information form.
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Module 10: Resources 

Resource Information Form 

Information Tab 

Use the Resource Information form to enter and edit resource information. Though you can enter data 

directly into the columns of the Resource View, you may not want to display every column. The 

Resource Information form gives you immediate access to every resource column, hidden or shown. 

· . . · 

In this box: Do this: 

Enter a name for the resource. It is a good idea to be as specific as possible, 

Resource Name because no two resources can have the same name. For example, typing "Mike" 

instead of "Mike Stuart" could lead to trouble if another Mike works on the project. 

Enter a descriptive word to categorize the resource. For example, you might just 

enter "Human," if it is a person, or you may want to be more specific and enter 

Type something like "Software Developer." This value is for your reference only and does 

not affect the data in any way. Think about how you would like to use Type 

information in filters and sorts. 

Enter a dollar amount that is charged every time this resource is assigned to a task. 

Per Use Cost 
Think of this as a flat fee paid to use this resource. If this resource is assigned to 

several tasks in the project, the dollar amount you enter here will be factored into 

the Total Cost of each task. 

Standard Rate 
Enter a dollar amount that is calculated per hour, day, week, month, quarter, or 

year in relation to the task's duration. The default rate is per hour. 

Enter a dollar amount that is calculated per hour, day, week, month, quarter, or 

Overtime Rate 
year when the resource works overtime. Entering a "O" means the resource will 

receive NO overtime pay; leaving this blank means the resource's Overtime Rate is 

equal to the Standard Rate. 
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• 
Work Calendar Tab 

Defining the work calendar allows you to setup the hours of the day for typical and specific days. The 

resource work calendar can be defined in the Resource Information form. 

Deline Specific Days I November laJ' 21110!1 
Exa,ptions 

jTuu iWed T"" fri is.t Date i 
3 4 5 • 11/22/10 Vacation 

11/23/10 Vacation 
• 10 11 12 '13 11/24/10 

,. 17 ,. '19 29 

To create or edit a resource work calendar: 

1. In the resource information form, select the Work Calendar tab.

2. Define the Work Calendar with the options described below.

3. Click OK to apply your changes and close the Resource Information form.

Base Calendar 

Base Calendar defaults to the calendar that the project is using (defined in Project Information). Other 

defined calendars can be used as base calendars as well. When changes are made to the calendar that is 

being used as a base calendar, all resource calendars using it as a base calendar are updated with the 

changes. Exemptions to resource calendars are applied only to the resource. 

To set the work hours for the Typical day of the week (such as Mondays, if different from the base 

calendar): 

1. In the Define Typical Week Days area, click on the day of the week for which you want to define

typical hours.

2. Under the Work Shift Details table, deselect "Use typical work day shifts on base calendar"

3. In the Work Shift Details table, select the Start and Finish times for desired work shifts.

The total number of work hours appears under that day in the Define Typical Days area.

4. Repeat this procedure for every day you wish to set.

Notes: 

The Copy Day button copies the work shift details for a typical or specific day to the Clipboard. The Paste Day button pastes 

work shift details from the Clipboard to a typical or specific day. The Copy Calendar button copies the contents of the work 

calendar to the Clipboard. The Paste Calendar button pastes a work calendar from the Clipboard to a new schedule. 
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Module 10: Resources 

To set the work hours for a Specific day (different from the base calendar's}: 

1. In the Define Specific Days area, select a month and year to display from the pop-up lists.

The month appears in the calendar below.

2. Select a day from the calendar.

3. Under the Work Shift Details table, deselect "Use typical work day shifts on base calendar".

4. In the Work Shift Details table, select the Start and Finish times for desired work shifts. The total

number of work hours appears on the day.

5. You may enter in a Description of the exception under Exceptions.

To set a Specific day as a Non-Work Day: 

1. In the Define Specific Days area, select a month and year to display from the pop-up lists.

The month appears in the calendar below.

2. Select a day from the calendar.

3. Select the Clear Day button to remove all work hours from the day. The total work hours for that

specific day appear in the calendar.

4. You may enter in a Description of the exception under Exceptions.

Effort-Driven & Fixed-Duration 

Before assigning resources to activities, first determine if the activity is an effort-driven or a fixed

duration activity. Defining this information about the activities helps the application allocate the 

appropriate amount of work and time needed for an activity's completion as resources are assigned. 

Effort-Driven 

An effort-driven activity's amount of work (man hours) needed to complete the activity remains 

constant. The elapsed time (duration) will adjust accordingly. 

For example, the activity to set up a booth is an effort-driven activity. If booth setup requires 8 man 

hours, it would take one resource 8 hours to complete. Based on effort-driven scheduling, adding 

another resource doubles the amount of effort to setup the booth, which would then cut down the 

duration of the activity by half while keeping the amount of work the same. 

Going the other direction, if one resource exerts half as much effort to set up the booth, it would take 

them an elapsed time of 16 hours to complete the activity. 

Fixed-Duration 

A fixed-duration activity's elapsed time to complete the activity remains constant. Changing the 

resource effort will not adjust the activity's duration. 

For example, the activity to run the booth at a tradeshow is a fixed-duration activity. Say the tradeshow 

is scheduled for three days. No matter how many resources are assigned to man the booth, the 

tradeshow's elapsed time will remain the same. 

Du.ration 

iDay(t 
£ft0rtOrive-n 

r'es 

Fc,;_ed 

Ouration 

Activities can be defined as Effort-Driven or Fixed-Duration by inserting the corresponding columns or by 

opening the Activity Information Form> Assignments tab. 

AEC 
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Assigning Resources 

Second Step 

Module 10: R�sottr�es · .. 

Go to the Schedule View to Assign Resources to specific activities. Assignments link a resource and all its 

data to a task or tasks in the schedule. The Schedule and Resource Views draw from two different pools 

of information. Assignments act to bridge those two pools of information. 

You can create a schedule full of tasks and you can create numerous resources complete with work 

calendars and cost data, but until you actually assign a resource to a task, the Schedule and Resource 

Views cannot interact. 

Resources Assigned Column 

If the name of the resource is the only detail that needs to be tracked for each assignment, type the 

Resource Name directly into the Resources Assigned column to create the assignment. 

To assign a resource to a bar: 

1. In the Schedule View, click in the specified activity's Resource Assigned column.

2. Type the Resource name or select from a pop-up list if one has been created.

Schedule View Information Form > Assignments tab 

If details of each resource need to be modified, it is recommended that the assignments be made 

through the Information form. 

To assign a resource to a bar: 

1. In the Schedule View, click in a row's Information Form action column.

-Or-

in the Schedule View, double-click on the bar or milestone that represents the task to which you want

to assign a resource.

The Information form opens in the Tracking tab.

2. Select the Assignments tab.

3. Select the Select Resource pop-up list in the Resource Name column of the Assignments table.
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Module lO;·Resources 

From the list, you can choose Create Resource to open the Resource Information dialog and create a 

new resource or you can select from a list of already created resources. 

Each cell in the Assignments table is described below: 

In this box: Do. this: 
.· 

Click the icon to open the Resource Information form for the resource 

selected in the Resource Name pop-up list. You can scroll through the 

various resources assigned for each task. 

Resource Name Select a resource from a pop-up list containing every defined resource 

that is not already assigned to this task. Or select Create Resource to 

define a new resource you want to assign to the bar. 

Work Amount of work required to complete the activity. 

% Effort Enter or edit the percentage of the resource's time you want devoted to 

the specific task. 

Contour Select the applicable effort distribution for the activity. 

Per Use Cost Enter or edit the dollar amount that will be charged every time this 

resource is assigned to this particular task. This is a flat fee paid to use 

this resource. If this resource is assigned to several tasks in the project, it 

can have different Per Use Costs in every assignment. 

Standard Rate Enter or edit a dollar amount that will be calculated per hour, day, week, 

month, quarter, or year in relation to the task's duration. The default rate 

is per hour. Enter "$150.00/d" for the Rate Per Day, "$150.00/w" for the 

Rate Per Week, etc. 

Overtime Rate Enter or edit a dollar amount that will be calculated per hour, day, week, 

month, quarter, or year when the resource works overtime. A "O" in this 

cell means the resource will receive NO overtime pay. This cell blank 

means the resource's Overtime Rate is equal to its Standard Rate. The 

default time period is Rate Per Hour. 

Cost View the assignment Cost, where Cost= (Per Use Cost)+ (Standard Rate * 

Work)+ (Overtime Rate * Overtime Work) 

When resources are assigned to activities, the activities take into account the resource's work calendar. 

The resource's work calendar (availability) takes precedence over the project calendar. If a resource is 

not available (custom non-work days defined), FastTrack Schedule 10 will shift the activity to when they 

are available. You have the ability to ignore resource work calendars. 

To ignore resource work calendars when assigning resources: 

1. Double-click on the activity bar (on the timeline graph)

2. In the Information Form's Tracking tab, select 'Ignore Resource Calendars'
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Document Options 

There are some document options that have to do with defaults regarding whether activities should be 

effort-driven, fixed-duration, or if resource calendars should be ignored upon creation of new bars. You 

can access these options by going to Tools> Document Options> Project tab. 

O�il Hotn per day 

1 40.oo_il Houm per week 

� Oayspermcrih 

Lag/lead Calendar: 1 Standad (Project Calendar) 

Units 

Defaults 

Duration Units: l�Oays __ �il-

0 Axed dtr.mons scheduling when aeating new bars 

Work Units: ._I fhn __ -111[i_l

0 Ignore resoure calendars when aeating new bars 

[]}wt/effort-driven scheduling when making assignments lo bars 

By default, new schedules will create activities that are effort-driven as well as taking into account 

resource calendars as resources are assigned. 

You can also apply universal settings to existing activities by going to Document Options> General tab. 

Change.Settings .on /Ill .. Bars ..
0 Leave settings on all bars unchanged 
0 01ange settings on all bars (Changes can not be undone) 

Fixed Duration: ,lk>ch-anged----------,-ld'l-,

Bfort Driven Scheduling: Change all bars to Hxed Duration 
Ignore Resource Calendars: Ch� all bars to Not Fixed Duration 

Changing Resource Calendars can cause an immediate schedule change. 

Restore /Ill 

0 Leave Range unchanged after Restore /Ill 
(£\.A,,piy Range after Restore /IJI 

@ }wt/ last range prior to filtering 
0 /!pply All Bars Range 
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Managing Resources 

Third Step 

The third step to remember, and probably the most important to the success of a project, is managing 

your resources. Managing Resources should be done on a continuous basis while creating and assigning 

resources to avoid over allocation and other conflicts. 

What do you do when a Resource is over allocated? 

Here are some questions to ask yourself when you find you have over allocated a resource. 

1. Can these tasks be completed as scheduled?

If the tasks can be completed as scheduled then no changes need to be made in the Resource

View. If they cannot be completed as scheduled then continue on with the next question. 

2. Do the tasks have to happen on these days?

If the tasks do not need to happen on the scheduled days, the scheduled bars can be adjusted

to even the load of the responsible resource by dragging the bar to the left or the right. Any 

changes made in the resource view will be reflected in the Schedule View. Bars that are linked 

in the schedule view will affect dependencies. If the tasks have to happen on the scheduled 

day, move to the next question. 

3. Are the durations per day correct?

If the activity durations are not correct, each task can either be spot allocated or the percent

effort of a task can be decreased. If the activity durations for each day are correct then move 

to the next question. 

4. Is the resource assigned the only viable resource?

If an alternate resource can be assigned to take the load off of the over allocated resource,

this can be done by reassigning the resources. If an alternate resource cannot be substituted, 

you may want to seek additional resources. 
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Resource Allocation 

Contours 

There are pre-defined contours within the Information Form > Assignments tab. They can be applied to 

distribute the amount of effort the assigned resource exerts over the duration of the activity. 

fl_()() fl ()0 8.00 11.00 !l.00 o.ar u,1 :mo 4.oo s.ee s.33 n1s ?.99 2.66 

Loaded 

e .. oo a.oo 1.00 6.oo 4.33 J.66 • n \ .oo 0.2, 
2.00 4.00 ll.0-0 4.QO 2.00 2.00 4.00 8.00 4.00 2.00 

200 4.00 !\.00 ll.00 ,I.OD 4.00 4.00 2.00 \.20 G·.80 

0.80 1.20 :2.00 4.00 ,too 6.00 5.00 S.00 4 .OD 2.00 

0.29 o.eo , .ea ::;_20 '3AO e .. oo e.oo '3.40 3.20 1 .oo �-.au 

Custom Contour/ Spot Allocation 

Spot allocation is the act of editing a portion of an assigned resource's total work (i.e. Hourly, Daily, etc.) 

in the Assignments subrow of the Resource View. Spot allocation is based on the Resource View timeline 

units as you have currently defined them (i.e. Work Hours, Work Days, etc.). 

Percent Effort 

When you use Percent Effort values, anything over 100% effort is overtime. You enter and edit the 

Percent Effort a resource will expend on a particular task in the Bars > Assignments tab of the 

Information form. When the percent effort is modified, the value is applied to the entire duration of the 

task. 
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Module 10: Resources 

Resource Work Usage Graph 
While in the Schedule View, you can also get a peek of resource utilization by viewing the Percent Work 

Usage graph. It aids in assigning of resources as well as reporting of resource availability. To display, go 

to View> Percent Work Usage. 

By default, the graph will show 

resources assigned to the selected 

activity along with all of their 

other assignments. 

To change the Percent Work Usage 

graph to display only the selected 

activity's resource allocation: 

1. Right-click in the blank area to

the left of the resource name (see

right image)

2. Deselect 'Show All Assignments'

Another way of viewing the Percent Work Usage graph is to select the desired resource and have all of 

their allocations displayed. Using the graph in this way will allow the user to easily see their desired 

resource's current assignments. 

To change the Percent Work Usage 

graph to display only the selected 

resource's allocation: 

1. Right-click in the blank area

to the left of the resource name

(see above right image)

2. Deselect 'Show Resources by

Selection'

3. Click in the Resource Name

area and select desired resource

from value list.

COPYf\!GHT© 

10:11 

and ncensors, /\LL RIGHTS RESERVED 



Resource View Filters 

In the Resource View, Column/Value criteria filters can also be defined in the same way as in the 

Schedule View. Since the Resource View's focus is on resource allocation and assignments, Assignment 

Criteria filters can also be defined. For example, maybe when it comes time to assign resources for the 

next month, you may want to see which resources are assigned comfortably so that they can be 

assigned to more activities. 

O-..., Not Assigned 
® Resouroe Assigned eon.-(0-99%) 

0 Retouoe Asoioned It lul Nom,a! Capadty (100%) 

0 RetouoeO-Assigned (> 100%) 

Tracking Resource Costs 

To define an Assignment Criteria filter: 

1. In the Resource View, go to Project > Filters

> Define.

2. Select the Assignment Criteria tab.

3. Select the desired Assignment percentage

and if appropriate, a specified Date/Time

Range.

4. Select OK to save the filter.

Select OK to apply the filter.

Resource costs can be tracked in both the Resource View and the Schedule View using columns, 

calculations, and summary graphs. 

Schedule View 

In the Schedule View, go to the Cost Layout. Here you will find a Fixed Cost column, a Resource Cost 

column, and a Total Cost column. The values in the Resource Cost column are derived from the Standard 

Rate, Overtime Rate, and Fixed Costs that were defined for each resource when it was created and 

assigned. The Resource Cost per Month summary graph is a per month calculation derived from the 

Resource Cost column. 

Resource View 

In the Resource View go the Total Resource Cost Layout. Here you will find the Total Resource Cost 

column and the Total Assigned Units column. The Total Assigned Units column is the sum of all the 

hours of work to which the resource has been assigned. Total Resource Cost is the sum of all the costs 

for each assignment. 
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Module 11 

Work Calendars 

Module 11: Work Calendars 

Overview: This module will teach you how to create the different types of work 

calendars and their use. 

a. Defining Calendars

b. Using Calendars
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• 
Defining Calendars 

An unlimited number of work calendars can be created. Work Calendars can be applied as the project 

calendar, resource calendar, base calendar, task calendar and link calendar. All calendars can be 

modified by going to Project menu > Work Calendars. 

The project calendar is discussed in Module 2: Top Down Planning. 

The resource and base calendars are discussed in Module 10: Resources. 

Using Calendars 

Task calendars can be applied per activity. On occasion, a task may be on a calendar different from the 

project calendar, not assigned to a resource, or simply goes by a different schedule. When an activity 

has a task calendar applied, different from the project calendar, a calendar icon II will appear in the

activity's Information Form. Task Calendars take priority over resource calendars. 

To Apply a Task Calendar: 

1. Double-click on the activity bar (on the timeline graph)

2. In the Information Form, select an available calendar from the Calendar list or click 'New' to create a

new one
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Module 11: Work Calendars 

Link calendars can be applied in the Link Information dialog. Link calendars are actually applied to 

calculate lag time within the link. It's possible that the predecessor and successor activities have 

different task calendars applied, on top of a different project calendar. Being able to define which 

calendar lag should be based on gives you all of these options. 

To apply a Link Calendar to an individual link: 

1. Double-click on a defined link (on the timeline graph)

2. In the Link Information dialog, select the desired Lag Calendar using the available work calendars.

"Follow Document Preference" can be found in Tools menu> Document Options> Lag Calendar. This is 

where the default lag calendar is defined. 
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Module 12 

Calculations 

Module 12: Calculations 

Overview: This module will teach you how to create and use customizable 

calculation columns. 

a. Calculation Columns

b. Calculation Elements

c. Defining a Calculation

12:1 
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Calculation Columns 

A calculation can consist of any viable combination of column references, text strings, numbers, 

functions, and operators. For example, the following calculation could be used to return a value for a 

calculation column you name "Variance" if you assume you want to know the variance of your budget 

and cost. 

[Budget] - [Total Cost] 

In this example, the Total Cost and Budget columns are numeric. Each time values are assigned to the 

Total Cost column, FastTrack Schedule subtracts that value from the Budget column and displays the 

result in a calculation column you have named "Variance". 

The result of a calculation is referred to as the return value. All of the values required as input to the 

calculation must be present to evaluate the calculation. If one of the values required for the calculation 

does not exist when the calculation is evaluated, FastTrack Schedule does not assign a value to the 

calculation. The value of the calculation column is empty {null) until the missing value is supplied. 

Calculation Elements 

A calculation can contain the following elements: 

Jype.ofvelernent: 
.\ 

-�le:
.

·. 

Column reference [Total Cost] 

Text String "Over Budget" 

Number 100 

Functions lf(Cond, Resultl, Result2) 

Combination of elements lf([Budget) - [Total Cost] < 0, "Over Budget!", "") 

These elements can be combined using Operators to produce an expression. FastTrack Schedule 

includes over 60 functions capable of complex calculations. FastTrack Schedule's functions operate just 

like those of other popular spreadsheet applications. 

Notes: 
• Text strings are placed in quotations
• The NullNum() function can be used to return a blank result when calculating numbers or dates
• An open quotation followed by a closed quotation without spacing can represent 'Null Text'
• Use the Function Reference button at the bottom of the Format Calculation dialog box to view function

descriptions, syntax, examples, and more
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Module 12:Calculations 

Defining a Calculation 

Defining a calculation column allows you to create a column that uses column references, text strings, 

numbers, functions, and operators to determine its value. For instance, you could create a column that 

displays text to display if an activity is has a cost greater than its given budget. This calculation may look 

like: 

lf([Budget] - [Total Cost]< 0, "Over Budget!", "") 

To define a calculation column: 

1. From the Insert menu, select Column.

The Insert Column dialog opens.

2. From the Show pull down list, select Calculation to show every available column of the type

"Calculation".

3. In the Column Display Name table, click to select the name of the next available calculation

column.

4. Click OK to insert the new column and close the Insert Column dialog.

The Format Calculation dialog opens.

5. In the Format Calculation dialog, use the Columns, Operators, and Functions tables below to enter

a calculation.

6. Click OK to apply your changes and close the Format Calculation dialog.

The calculation column now appears in the schedule.

Entering a calculation 

Entering a calculation defines the expression that is being evaluated to return a value for the calculation 

column. 

COPYRIGHT@ 2010, AEC Software, 
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Notes: 

To enter a calculation in the Format Calculation dialog: 

1. Insert menu > Column > Calculation.
2. In the Format Calculation dialog, enter the calculation as described below.

Enter a column 
reference 

Enter an operator 

Enter a function 

View specific functions 

Enter a literal text 
string 

Enter a number 

See a description of an 
element 

In the field at the top of the dialog, click where you want to 
insert the column reference and then double-click the 
desired column name in the Columns table. 

In the field at the top of the dialog, click where you want to 
insert the operator and then double-click the desired symbol 
in the Operators table. 

In the field at the top of the dialog, click where you want to 
insert the function and then double-click the desired function 
in the Functions table. 

Click the pop-up list above the Functions table and select to 
sort the functions by name or category, or select to search 
the table for functions of a specific category. 

In the field at the top of the dialog, click where you want to 
insert the text string, enter quotes, and enter the text 
between the quotes. Values in quotations are interpreted 
literally by FastTrack Schedule. The characters enclosed in 
quotation marks appear in the return value exactly as they 
appear in the calculation. 

In the field at the top of the dialog, click where you want to 
insert the number and then enter the number. 

Single-click an element from the Columns, Operators, or 
Functions table and read the description below the Functions 
table. Click the Function Reference button to open the help 
system to a detailed description of every function. 

3. Click the Check Calculation button to evaluate the calculation and verify it is correct.
4. Click OK to apply your changes and close the Format Calculation dialog.

■ Column names must be contained in square brackets [ J and must be spelled exactly as they appear in the
Columns table.

• Only columns that store values per bar or resource can be used in a calculation (this is displayed or determined in
the Options tab of the Format Column dialog).

• Functions cannot have a space between the function name and the opening parenthesis and must be spelled
exactly as they appear in the Functions table.

• You may enter carriage returns in your calculation between elements.
• A calculation can provide a value only for the column for which it is defined.

Trainer's Tip: 
· • Use calculation columns in our example files for help. 
• Use calculation columns to create Earned Value Analysis.
■ Tie caJculat.ions with FilterSor Summary Graphs to produce high-end reports.
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Module 13 

Summary Graphs 

Overview: Summary graphs summarize the values currently displayed in columns 

over a specified period of time. In this module, you will learn how to create and 

edit summary graphs and set them to display in layouts. 

a. Understanding and Inserting Summary Graphs

b. Formatting Summary Graphs

c. Summary Graphs in Layouts
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Module 13: Summary G,��h� 

Understanding and Inserting Summary Graphs 

Summary graphs summarize the values currently displayed vertically in columns, horizontally over a 

period of time. 

A summary graph appears as a row under the timeline graph, making it easy to match the summarized 

data to the corresponding time period. Six types of summary graphs can be created: Total, Average, 

Standard Deviation, Minimum, Maximum, and Count (including cumulative totals). There are three types 

of graphs: numeric, line graph, and histogram. These can be displayed in hundreds of different styles. 

You can include more than one summary graph row in your schedule. 

You can also choose to have more than one set of summarized data display in the same way or in 

different ways, within a single summary graph row. For instance, you can have a line graph displaying 

the Total and a histogram displaying the Count in the same row. Though you can summarize more than 

one set of data in a given summary graph row, summarizing too much data in one row can be confusing, 

so organize your display accordingly. 

Summary graphs are displayed in some pre-defined layouts. You can edit a pre-defined layout if it does 

not display summary graphs and you would like them to. You can also define new layouts that display 

them. 
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Module 13: Summary Graphs 

Showing and hiding summary graph rows 

Showing summary graphs adds an area below the timeline graph that displays the total, average, 

standard deviation, minimum, maximum, and/or count of the values currently displayed in columns for 

a particular period of time. For instance, you could show a summary graph row that displays the total 

cost of all activities per week. 

To show and hide summary graphs: 

1. Go to the Project menu > Layouts> Define.

The Layouts dialog opens with the current layout selected.

2. Select the name of the layout you wish to change.

3. Click the Edit button.

4. In the Define Layout dialog, click the Summary Graphs tab.

Any summary graphs you have created appear in the Available Rows table.

5. From the Available Rows or Shown Rows table, select the summary graph you wish to hide or

show.

6. Click the Hide or Show button to select if the summary graph should be displayed.

7. Click OK to save the layout and close the Define Layout dialog.

8. Click OK to apply your changes and close the Layouts dialog.

Inserting new summary graphs 

If you want to create a new summary graph based on data in columns you have recently entered, you 

can create them using the Insert menu. 

Notes: 

To insert summary graphs: 

1. From the Insert menu, select Summary Graph.

The Format Summary Graph dialog opens.

2. Select the Summary Units you would like to calculate.

3. Type the name of the summary graph in the Left Label field.

4. Follow the instructions below to format the rest of the Summary Graph.

When you show a summary graph row, it defaults to displaying the total Scheduled Duration per week. You can change the 

information in summary graph rows by formatting them. The Format Summary Graphs dialog opens when you double-click 

inside of a summary graph row. 
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• 
Formatting Summary Graphs 

Opening the Format Summary Graph dialog allows you to select the units, the data summarized, the 

type of summary operation, and the display of information for the selected summary graph row. 

To open the Format Summary Graphs dialog 

1. Click the summary graph row you want to format to select it.

2. Go to Format menu > Summary Graph.

-or-

Double-click the summary graph row.

Choosing units for summary graph rows 

Choosing units for a summary graph row allows you to determine the unit of time (days, weeks, months, 

etc.) upon which the summary graph row bases its summaries. 

Notes: 

To change the units of the summary graph row 

1. Double-click the summary graph row you want to format to select it.

The Format Summary Graphs dialog opens.

2. Use the Summary Units value list to select a unit of time.

3. Click OK to apply your changes and close the Format Summary Graphs dialog.

Always confirm that the summary operation is what you want. At times, you may inadvertently change this in the 

beginning and not realize it until after you have printed a schedule. 
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Module 13: Summary Grtlphs 

Choosing data to summarize in summary graph rows 

Choosing the data to summarize in a summary graph defines what information is summarized per unit of 

time. For example, you could choose to summarize the Duration column, the Start Date column, or both 

columns. 

To select data to summarize in the summary graph row: 

1. Double-click the summary graph row you want to format to select it.

The Format Summary Graphs dialog opens.

2. From the Data to Summarize column in the table, select the column to summarize.

3. Select whether or not to summarize All Bar Styles.

4. If you choose not to summarize all bar styles, from the Bar Style to Summarize value list, select

one particular bar style in which to summarize data.

5. Choose whether you wish to distribute the custom column data by Schedule, Revised, or Actual

Duration.

6. Click OK to close the Format Summary Graphs dialog.

Choosing summary operations for summary graph rows 

Choosing a summary operation for a summary graph row defines which of the following operations the 

row displays: the total, average, standard deviation, minimum, maximum, or count of activity bar values. 

A cumulative summary is calculated in the same manner as a non-cumulative summary; however, the 

result of each time period is added to previous values. Thus, the values accumulate from time period to 

time period. 

Notes: 

To select a summary operation for a summary graph row: 

1. Double-click the summary graph row you want to format to select it.

The Format Summary Graphs dialog opens.

2. From the Summary Operation value list, select an operation.

3. If the operation will or can be tallied cumulatively, use the Cumulative checkbox to establish

whether values before the start of the timeline will be included in the calculation of cumulative

summaries.

4. If the operation will or can be tallied cumulatively, select to include or to ignore values for

activities that occur before the schedule start in your summary.

5. Click OK to close the Format Summary Graphs dialog.

Only columns which store values per bar can be summarized in a summary graph row. 
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• 
Summary Graphs in Layouts 

Defining a layout allows you to create and edit what columns and summary graphs you view in the 

Schedule and Resource Views. Layouts are created and edited in the Layouts and Define Layout dialogs. 

To open the Define Layout dialog: 

1. Go to Project menu > Layouts > Define.
The Layouts dialog opens.

2. Click the Edit button to edit the existing layout you select from the Layouts table.
The Define Layout dialog opens.

Fixed Cost pa-Month 

ReSOlBCe Cost pa-Week 

Revised Eslinate pa-CMirter 

Original Estimate pa-Quarter 

ReSOlBCe Cost pa-Month 

Total Cost pa-Week 

T otai Cost pa- Monlh 

Variance ct Original vs Revised 

wmmulalive Total Cost pa- Week 

Cummulative Total Cost pa- Monlh 

To display summary graphs 

em : 1 
( wrcttb nl 

1. Click the Summary Graphs tab of the Define Layout dialog.
Any summary graph you have created appears in the Available Rows table.

2. Click Show to send the selected summary graph to the Shown Rows table.
3. If you wish, click and drag on summary graph row names in the Shown Rows table to change the

order of rows in the layout.
-or-

2. Click the Create New Summary Graph Row button to create a new summary graph and open the
Format Summary Graph dialog.
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Module 14 

FastSteps 

Overview: FastSteps are macros with saved repetitive steps. In this module, you 

will learn how to create FastSteps and save time when building client reports, 

setting up status meeting printouts, and auto-exporting updated graphics. 

a. Review of Ranges, Layouts & Filters

b. FastSteps Overview

c. Creating FastSteps

d. Working with FastSteps
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• 
Review of Ranges, Layouts & Filters 

Ranges 

Ranges are a saved span of dates. They can be changed at any time to determine what days you see in 

the schedule timeline and the calendar. You can access them easily from either the Ranges Tool bar or 

the Ranges submenu of the Project menu. Ranges can be applied to each View or all Views at once. 

The Master Range is designed to give you a quick way to return your file to a user-defined default range. 

Each file has a unique Master Range. When you apply the Master Range it is applied to every View in the 

current file. It can be changed at any time, in any View, to change the data shown in the schedule 

timeline or calendar. 

Layouts 

Layouts are different groupings of columns. They are convenient because you can change between them 

quickly and easily. Layouts are available in the Schedule and Resource Views. Layouts show, hide, and 

move columns, the timeline graph, Action Columns, timescale areas, and summary graphs. 

Filters 

Filtering uses search criteria that you define to identify information in rows, activity bars and resource 

rows. It then allows you to apply filters to the Schedule, Resource, and Calendar Views to hide or select 

activities or resources that match the criteria. Because the Calendar View uses the same data as the 

Schedule View, filters created in the Calendar View are applicable in the Schedule View or vice versa. 

Filters created in the Schedule View or Calendar View, however, are not applicable to the Resource View 

or vice versa. 

Tip: 

Layouts and Filters are discussed in detail in Module 5 - Reporting (Layouts & Filters) 
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• Module 14: FastSteps 

FastSteps Overview 

FastSteps is a scripting ability, built into FastTrack Schedule. FastSteps allow you to automate repetitive 

scheduling tasks by grouping a series of commands into a single sequence that you can then initiate with 

one menu choice. FastSteps are available in the Schedule, Resource, and Calendar Views and their Print 

Preview windows. 

Let's say, for instance, that every time you update a particular file, you want a report of the activities 

that remain unfinished. Using FastSteps, you can create a sequence that applies a filter for incomplete 

activities, prints the filtered schedule, restores those activities hidden by the filter, saves the application, 

and then closes that schedule. The graphic below illustrates the FastSteps command sequence detailed 

above. It is named "Activities to be Completed". 

New 
Open 

Open Template 
Save 
SaveAs 

FastStep 

Switch Views !Schedule View! 
Schedule .f\pply Riter [Unfinished Activities! 

{,=.,i.......;;.:.�! Print 

Every time you finish editing the schedule, you simply select "Activities to be Completed" from the 

FastSteps Tool bar and all of the commands listed above will be completed automatically. 

Each member of a project team can have a FastSteps sequence to suit his or her needs. You could also 

create different sequences for every version of the schedule you would like to print, thus creating 

reports. There is no limit to the number of uses you can find for this powerful tool. 
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• 
Creating FastSteps 

FastSteps allow you to string a collection of commands together into one FastSteps script that can be 

run with one menu choice. 

Notes: 

To create a new FastSteps sequence: 

1. Go to the Project menu > FastSteps > Define.

The FastSteps dialog opens.

2. Click the New button.

The Define FastSteps dialog opens.

Switch 1/iews [Schedule 'Mwl 

Spell Oiecker (Check Current \iew] 

Print Preview IShowJ 

3. In the FastStep Name box, enter a name for the FastStep.

4. Select desired command in the Commands table.

5. Click the Add button to send the command to the FastStep table.

6. Continue inserting commands into the FastStep table until you have the sequence of commands

you desire.

7. Drag commands up and down in the FastStep table to change the order in which the commands

occur.

8. Click OK to apply your change and close the Define FastSteps dialog.

9. Click OK to apply the FastStep and close the FastSteps dialog.

-or-

Click Close to exit FastSteps without running a FastSteps sequence.

Your newly created FastStep is saved; you simply select the sequence name from the FastSteps

submenu or FastSteps Toolbar when you are ready to run it.

By selecting the Pause command, you can add a pause to your script. This will pause the FastStep and bring up a dialog 

displaying a message you define. Then, in the Pause dialog, you can click the Resume button to start the FastSteps script 

where it left off, or you can click the Stop button to abort the sequence. 
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Module 14: FastSteps 

Working with FastSteps 

Editing an existing FastSteps sequence 

An existing FastSteps sequence can easily be altered to suit your changing needs. 

To edit an existing FastSteps sequence: 

1. Go to Project menu > FastSteps > Define.

The FastSteps dialog opens.

2. From the table, select the FastSteps sequence you would like to edit.

3. Click the Edit button.

The Define FastSteps dialog opens.

4. If necessary, click in the FastStep Name box to edit the title of the FastSteps sequence.

5. Click the Add and Remove buttons to alter the commands in the FastStep table.

6. Drag commands up and down in the FastStep table to change the order in which the commands

occur.

7. Click OK to apply your changes and close the Define FastSteps dialog.

8. Click OK to apply the FastStep and close the FastSteps dialog.

-or-

Click Close to exit FastSteps without running a FastSteps sequence.

Your changes to the FastStep are saved; you simply select the sequence name from the FastSteps

submenu or FastSteps Tool bar when you are ready to run it.

Running an existing FastSteps sequence 

Once you have created a FastSteps script you can run it at any time you are working on a schedule. Keep 

in mind, however, that changes to filters, sorts, layouts, and ranges will affect any FastSteps that include 

them. 

To run an existing FastSteps sequence: 

1. Go to Project> FastSteps > select the FastStep you wish to run.

Notes: 

If a FastSteps script is unable to run, the Define FastSteps dialog opens with the command that does not work highlighted. 

Most likely, the FastStep contains a filter, sort, layout, or range that has been deleted or renamed. 

14:5 





MODULE 15 

Templates 





Module 15 

Templates 

Module 15: Templates 

Overview: In this module, you will learn how to save your schedule as a template 

to quickly create future, similar schedules. 

a. Using Templates

b. Template Options
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Module 15: Templ�t� 

Using Templates 

Once you have completely customized your file, you can save it as a template so that it can be used in 

the future for new projects. 

To save a file as a template: 

1. Go to the File menu > Save As Template

2. Type a name for the template and click OK

To create a new schedule using your template: 

1. Open FastTrack Schedule

2. Go to the File menu > New (Getting Started

screen appears)

3. Select 'New Schedule from Template'

4. In the Templates tab, choose the template

and click OK

You will be presented with Open Template Options. 

Template Options 

Keep Everything will create an untitled schedule file 

identical to the template file you chose. Use this 

option if your projects are very similar and only a few 

changes need to be made to transform it into a 

schedule for a new project. 
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Keep the Following Data will present you with all 

parts of the template. You can then select which 

parts of the template you want to keep. For 

example, if your project activities are different 

from one another but you want to keep your 

Header/Footer settings the same across projects, 

deselect 'All Activity Data'. When a new schedule 

is created, no activities will be present but other 

items that you have kept selected will remain. 

Aclivities 

0 /JI Activily Data 

0 Column Data 

0 Gra,phic ttema 

Barn and Oates 

0 Header/Footer 

@ Print Preview Gra,phic lama 

0 Summill)'Graphs 

---~----~ ---�·- ---·-·-----··-···· 
@H BarOata 

Remove All Data will remove all data from the template but keep formatting within the schedule. 

Formatting includes fonts that are applied in the columns and outline styles that have been defined. 

15:3 
COPYRIGHT© 2010, AEC Software, Inc. and its licensors. ALL RIGHTS RESERVED 





MODU 16 

Cons lid ting S hedules 





Module 16: Consolidating Schedules 

Module 16 

Consolidating Schedules 

Overview: In this module, you will learn how to easily consolidate your FastTrack 

Schedule files into one master file to analyze a big picture view of all of your data. 

a. What is Consolidation?

b. How to Consolidate

c. Schedule View

d. Resource View
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• 
What is Consolidation? 

You can easily consolidate your FastTrack Schedule files into one master file to analyze a big picture view 

of your data. Whether you want to see all the separate components of one larger project, or see every 

project your company is currently working on, Consolidation allows you to do so. Consolidation works 

across platforms so consolidated files can originate from either a Mac or Windows operating system. 

Master file - the file you create by consolidating existing files is called a master file. A master file can 

never be inserted into another file or into itself. 

Subordinate file - a file that is inserted into a master file is called a subordinate file. 

Subordinate files must be accessible, either on the hard drive or by network, and openable. The master 

file's user must have read access to a file to insert it. 

Important: 

Consolidated subordinate files are not live. There are no automatic updates. When data changes in a subordinate 

file, the changes do not appear in the master file until changes are saved in the subordinate file and you choose to 

refresh the data from that subordinate file in the master file. Changes you make to data in the master file must be 

manually applied to the appropriate subordinate files. 

When subordinate files with different project calendars are consolidated, FastTrack Schedule will produce a report 

with the differences across all the project calendars. 

Changes to data in the master file are for analysis only and do not affect the subordinate file. If you 

decide that you want to apply changes you have made in a master file, you must open the appropriate 

subordinate files and manually make the changes there. 

Consolidation is data driven, not visual. Formatting related information will not be consolidated. 

Formatting is originally determined by the master file's preference settings. You can edit Filter, Sort, 

Layout, Range, FastSteps and format settings in the master file, but the changes will not be applied to 

the subordinate file unless you manually apply them. 

irr�!net's.Tip: .. ·.. . .. . . . . ·•··. ·· .... ·· .. ·.• . . ........ · .·•· . . . . ... . .. . . . . .. · ..
ionsolidated ma.ster files are great for t�am 111eetirgs and i'what if" scenarios. 
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How to Consolidate 

You can create a master file by inserting any accessible FastTrack Schedule file into an open FastTrack 

Schedule file. 

To insert one project into the master 

file: 

Miller Aooring Project .fts 

1. Go to File > Consolidate > Define.

The Define Consolidation dialog

opens.

2. Use the options described below

to consolidate files.

Add 

Remove 

Locate 

"Files are subproject ... " 

option 

"Files are project ... " 

option 

Update 

Update All 

Close 

Allows you to navigate to a file you want to insert into the 

master file. 

Removes a file from the table. That file will no longer be 

inserted into the master file or updated. The Removed file 

will then be removed from the master file though it had been 

inserted previously. 

Opens a navigation window showing the path of the selected 

subordinate file. If you have copies of the same file in 

different locations, Locate allows you to be sure you are 

consolidating the correct copy. 

Every subordinate file in the master file will share the same 

Project Finish Date and Time, those of the master file. 

Every subordinate file in the master file will maintain its own 

Project Finish Date and Time. 

Inserts the most recent saved version of the selected file. 

Selects and updates every file in the dialog and closes the 

dialog. 

Closes the dialog. 
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• 
Schedule View 

Projects that have been consolidated will display a file icon 6'.J in the Schedule View information action

column. To get information on the consolidated project double click on the file icon. 

The following data is consolidated: 
• All columns - except calculation columns
• Bars and bar styles
• Pictures, textboxes and legends
• Links

■ Assignments
• Pointers

Any conflict in data between a subordinate and the master file results in that data being excluded from 

consolidation. 

If a column in a subordinate file is formatted to save data Per Bar and the same column in the master file 

is formatted to save data Per Row, that column will not be included in the consolidation. 

Resource View 

Resources are consolidated in the master file. In the Resource View of the master file, you can see if the 

consolidated resources are over allocated. 

Resources do not get deleted from the master file even if future updates of the subordinate file in which 

the resource originated no longer include that resource. 

You can consolidate subordinate files that have different Resource Work Calendars defined for the same 

resource. 

The following data is consolidated: 

■ All columns - except calculation columns
• Bars and bar styles
• Assignments

Any conflict in data between a subordinate and the master file results in that data being excluded from 

consolidation. 
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